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SAFETY INSTRUCTIONS

This chapter contains important safety
instructions that you must follow during
operation and storage. Read the following before
any operation to ensure your safety and to keep
the instrument in the best possible condition.

Safety Symbols

These safety symbols may appear in this manual or on the
instrument.

& Warning: Identifies conditions or practices that
WARNING  oy1d result in injury or loss of life.

& Caution: Identifies conditions or practices that
CAUTION  could result in damage to the instrument or to

other properties.

DANGER High Voltage
Attention Refer to the Manual

Earth (ground) Terminal
Frame or Chassis Terminal

Do not dispose electronic equipment as unsorted
municipal waste. Please use a separate collection
facility or contact the supplier from which this
instrument was purchased.

I ¥ 0 = B
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Safety Guidelines

General
Guideline

& CAUTION

*Do not place any heavy object on the instrument.

*Avoid severe impact or rough handling that leads
to damaging the instrument.

*Do not discharge static electricity to the
instrument.

+*Use only mating connectors, not bare wires, for
the terminals.

*Ensure signals to the RF input do not exceed
+30dBm.

+Ensure reverse power to the TG output terminal
does not exceed +30dBm.

*Do not supply any input signals to the TG output.

*Do not block the cooling fan opening.

*Do not disassemble the instrument unless you are
qualified.

(Measurement categories) EN 61010-1:2010 specifies the
measurement categories and their requirements as follows. The
instrument falls under category II.

*Measurement category IV is for measurement performed at the
source of low-voltage installation.

*Measurement category Il is for measurement performed in the
building installation.

*Measurement category |l is for measurement performed on the
circuits directly connected to the low voltage installation.

*Measurement category | is for measurements performed on
circuits not directly connected to Mains.

Power Supply

A\X/ARNING

*AC Input voltage range: 100V~240V
*Frequency: 50/60Hz

*To avoid electrical shock connect the protective
grounding conductor of the AC power cord to an
earth ground.
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Battery *Rating: 11.1V, 6 cell Li-ion battery

& *Turn off the power and remove the power cord
CAUTION  pefore installing or removing the battery.

Cleaning *Disconnect the power cord before cleaning.

+Use a soft cloth dampened in a solution of mild
detergent and water. Do not spray any liquid.

*Do not use chemicals containing harsh material
such as benzene, toluene, xylene, and acetone.

Operation *Location: Indoor, no direct sunlight, dust free,
Environment almost non-conductive pollution (Note below)

*Temperature: 5°C to 45°C
+*Humidity: <90%

(Pollution Degree) EN 61010-1:2010 specifies the pollution degrees
and their requirements as follows. The instrument falls under
degree 2.

Pollution refers to “addition of foreign matter, solid, liquid, or
gaseous (ionized gases), that may produce a reduction of dielectric
strength or surface resistivity”.

*Pollution degree 1: No pollution or only dry, non-conductive
pollution occurs. The pollution has no influence.

*Pollution degree 2: Normally only non-conductive pollution occurs.
Occasionally, however, a temporary conductivity caused by
condensation must be expected.

*Pollution degree 3: Conductive pollution occurs, or dry, non-
conductive pollution occurs which becomes conductive due to
condensation which is expected. In such conditions, equipment is
normally protected against exposure to direct sunlight,
precipitation, and full wind pressure, but neither temperature nor
humidity is controlled.

Storage +Location: Indoor
environment *Temperature: -20°C to 70°C

+*Humidity: <90%

5
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Disposal Do not dispose this instrument as unsorted
municipal waste. Please use a separate collection

ﬁ facility or contact the supplier from which this

— instrument was purchased. Please make sure

discarded electrical waste is properly recycled to
reduce environmental impact.
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Power cord for the United Kingdom

When using the instrument in the United Kingdom, make sure the
power cord meets the following safety instructions.

NOTE: This lead/appliance must only be wired by competent persons

&WARNING: THIS APPLIANCE MUST BE EARTHED
IMPORTANT: The wires in this lead are coloured in accordance with the
following code:

Green/ Yellow: Earth (25
Blue: Neutral .,_/5’
Brown: Live (Phase)

As the colours of the wires in main leads may not correspond with
the coloured marking identified in your plug/appliance, proceed
as follows:

The wire which is coloured Green & Yellow must be connected to
the Earth terminal marked with either the letter E, the earth symbol
=) or coloured Green/Green & Yellow.

The wire which is coloured Blue must be connected to the terminal
which is marked with the letter N or coloured Blue or Black.

The wire which is coloured Brown must be connected to the
terminal marked with the letter L or P or coloured Brown or Red.

If in doubt, consult the instructions provided with the equipment
or contact the supplier.

This cable/appliance should be protected by a suitably rated and
approved HBC mains fuse: refer to the rating information on the
equipment and/or user instructions for details. As a guide, a cable
of 0.75mm? should be protected by a 3A or 5A fuse. Larger
conductors would normally require 13A types, depending on the
connection method used.

Any exposed wiring from a cable, plug or connection that is
engaged in a live socket is extremely hazardous. If a cable or plug is
deemed hazardous, turn off the mains power and remove the cable,
any fuses and fuse assemblies. All hazardous wiring must be
immediately destroyed and replaced in accordance to the above
standard.

7
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G ETTING STARTED

This chapter provides a brief overview of the
GSP-9300B, the package contents, instructions for
first time use and an introduction to the front
panel, rear panel and GUIL

GWINSTEK css.saco:

GSP-9300B INtroduction ...ccceuieieinieiiinieiinenieienenieeeneneenenens 9
IMAIN FOAULES ottt ettt st et sae st e s e s st sat et e saesntesesasensensens 9
f N lel-T 3o ] - 12
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GSP-9300B Introduction

The GSP-9300B builds on the strong feature set of the GSP-9330 and
significantly increases performance in almost every aspect; making
this the most comprehensive and feature-rich spectrum analyzer
GW Instek has released.

Like the GSP-9330, the GSP-9300B features a split window display
to view data in spectrum, topographic or spectrographic views.
There are also a number of additional test functions such as P1DB.
Lastly, the GSP-9300B significantly reduces the sweep time and
RBW filter step resolution and complexity.

Main Features

Performance *9kHz~3GHz bandwidth
+*]1Hz resolution

*Nominal RBW accuracy of #5% <1MHz,
+8% =1MHz

*Video bandwidth 1THz~1MHz (1-3-10 steps)

+*Amplitude measurement range: DANL~30dBm
(frequency dependent)

«Input attenuation: 0 ~ 50dB, 1dB steps
*Phase noise: < -88dBc/Hz@1GHz, 10kHz, typical

Features ¥1-3-10 step increments for RBW bandwidth

*Three display modes: Spectrum, Topographic and
Spectrographic

«Split window display
*Built-in EMI filter
+*Auto Wake-up
+Built-in preamplifier
+Gate sweep

*Marker Frequency counter

9
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*Two operating modes: Spectrum and Power
Meter mode

+*SEM measurement

*ACPR measurement

*OCBW measurement

*Phase jitter measurement
*Harmonics measurement
#*P1dB measurement

*Channel power measurement
*Demodulation analyzer

+Diverse marker functions and features with Peak
Table

*Sequence function to automatically perform pre-
programmed sequential operations

*Optional battery operation

10
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Interface 8.4 color LCD (800x600)
*On-screen menu icons
*DVI-1 video output
*RS-232 with RTS/CTS hardware flow control
*USB 2.0 with support for USB TMC
*LAN TCP/IP with LXI support
*Optional GPIB/IEEE488 interface
+*Optional 3G USB adapter for WLAN
*Optional power meter adapter
+[F output @ 886MHz
+*Headphone output
*REF (reference clock) input/output BNC ports
+*Alarm/Open collector output BNC port
*Trigger/Gate input BNC ports
*RF N-type input port
*Tracking generator output
+*DC +7V/500mA output SMB port

1
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Accessories

Standard
Accessories

Options

Optional
Accessories

12

Part number

Region dependant
N/A

N/A

N/A

Option number
Optl.

Opt2.

Opt3.

Part number
ADB-002
ADB-006
ADB-008

GSC-009
GRA-415

839145

Description

Power cord

User manual CD:
Includes: User manual,
Programming manual,
SpectrumShot quick start
guide, SpectrumShot
software, IVI driver

Quick start guide
Certificate of calibration
Description

Tracking generator

Battery (11.1V/5200mAH
Li-ion battery)

GPIB interface (IEEE 488
bus)

Description

DC BLOCK BNC 50R
10MHz-2.2GHz

DC BLOCK N TYPE 50R
10MHz-6GHz

DC BLOCK SMA 50R
0.1TMHz-8GHz

Soft Carrying Case
6U Rack mount kit

010-62176775

www . hyxyyq..com
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Software Downloads

PC Software for Windows System (SpectrumShot quick
start guide, SpectrumShot software)

IVI Driver Supports LabView & LabWindows/CVI
Programming

13
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Appearance

GSP-9300B Front Panel

LCD Function ~Main  Control  File keys

dlsplay keys sz keys * / Power key

GUINgTEK cem-ssoom - ™ Marker keys
—\ A\
Preset/Local ‘ Z -
and Quick \j — Auxiliary keys
Save keys 70 )4— Scroll wheel
-0
-0
10 Arrow keys
= = L RFinput
terminal
/ /
USB A, Tracking Numeric, DC power
Micro SD generator Enter and supply

port output BK SP keys

LCD display 800x600 color LCD display. The display shows the
soft keys for the current function, frequency,
amplitude and marker information.

Function keys @ N The F1 to F7 function keys directly
correspond to the soft keys on the
right-hand side of display.

Main keys Sets the center frequency, start

frequency, stop frequency, center
frequency step and frequency
offset values.

14
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Span Sets the span, with options for full
span, zero span and last span.
Sets the amplitude reference level,
attenuation, pre-amplifier
controls, scale and other options
for attenuation and scale.

Amplitude

Automatically searches the peak
signal with maximum amplitude
and displays it with appropriate
horizontal and vertical scales.

Autoset

Sets the resolution bandwidth,
video bandwidth, average type
and turns the EMI filter on/ off.

Control keys BWI/Avg

Sweep Sets the sweep time and gate time.

Sweep Toggles the Sweep Control
Hodd between Fast and Normal mode.

Accesses measurement options
such as ACPR, OCBW,
demodulation measurements,
SEM, TOJ, phase jitter and other
advanced measurements.

Measure

Sets traces and trace related
functions.

Trace

Limit Sets and tests Pass/Fail limit lines.
Line

The Display key configures the
windowing mode and basic
display properties.

Display

15
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Sets the triggering modes.

File File utilities options

Sav.e the trace, state etc., and save
options.

Recall thg trace, state etc., and
recall options.

Marker Turns the Markers on/ off and
configures the markers.

The Marker B key positions the
markers on the trace.

Finds each maximum and

Search minimum peak. Used with the
Marker function.
Auxiliary Access, set and edit program
sequences.

The Option Control key allows you

Control to setup optional accessories such
as the Tracking Generator, Power
Meter or Demo Kit.

The System key shows system
information, settings and other
system related functions.

16
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Preset / Local key The Preset key will restore the
spectrum analyzer to the Factory

or User Preset settings.

Preset

LOCAL

The Preset key will also return the
instrument back to local control
after it has been in remote control
mode.

The Quick Save utility allows you
save to save either the state, trace,
display screen, limit line,
correction or sequence with only a
single press.

Power key Turns the instrument on/off. On =
yellow, off = blue.

Scroll wheel Edit values, select listed items.

Arrow keys Increment/decrement values (in

steps), select listed items.

RF input terminal RF input port. Accepts RF inputs.

*Maximum input: +30dBm

RF INPUT 500 1 .
«Input impedance: 50Q
+30dBm MAX.

*Maximum DC voltage: £50V
*N-type: female

17
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DC power supply

10

500mA MAX.

DC 7V —
OUTPUT

SMB port supplies power for
optional accessories.

*DC +7V

+*500mA Max.

Numeric keypad

7

OJOXORO

=

OOOO
OO

&

—/

o

The numeric
keypad is used to
enter values and
parameters. It is
often used in
conjunction with
the arrow keys and
scroll wheel.

TG output port

DC +50V - MAX.
REV PWR +30dBm|

The Tracking Generator (TG)

output source.

*N-type: female

*Input impedance: 50Q

*Output power: -50dBm to 0dBm

*Maximum reversed power:
+30dBm

USB A, Micro SD

18

o=

L2 USB A port, Micro SD port for
€=> saving/recalling settings/files.
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Rear Panel

IF OUT DVI-I USB-B, Fan Power

port LAN port / socket

RS232 port <4

TRIG IN/GATE
IN port i

ALARM OUT/
OPEN 7

COLLECTOR
/

REF OUT REF IN GPIB port Battery cover/

(optional) Optional
battery pack

RS232 Aoze RS232 9 pin DSUB port.

IF OUT o SMA IF Out port.

DVI v DVI video out port. Supports SVGA
@ o) (800X600) @ 60Hz.

Fan

Power Socket:
100~240V, 50/ 60Hz.

Power Socket

19
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Battery pack Voltage: 11.1V
Capacity: 5200mAH

REF IN BNC female reference input.

REF OUT BNC female reference output:
10MHz, 50Q impedance

Security Lock ]

ALARM OUT AAM AT BNC female open collector Alarm
output.

OPEN
COLLECTOR

TRIG IN/GATE IN TRG BNC female 3.3V CMOS trigger

input/gated sweep input.

GATE IN

Phone P 3.5mm stereo headphone jack
() (wired for mono operation)

USB B o USB B Device port. USB1.1/2.0

LAN HAN RJ-45 10Base-T/100Base-Tx

20
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Display
Attenuation Date Marker Function
level and time information Xl icon menu
Scale and Sweep
Reference settings
level
" Trace/
Detection
Traces and settings
waveforms
Unassigned
settin
Sweep . &
icons
progress TR e S
bar o Som ™ v e 50 e I Sweep,
/ | Trigger,
Entry / Frequency/Bandwidth Status icons Pre-amp
Message settings and USB
area settings
Scale

Reference level

Attenuation

Date/Time

Marker
information

Displays the vertical scale of the vertical grid. For
details, see page 49.

Displays the reference level. For details, see page
48.

Displays the vertical scale (attenuation) of the
input signal. For details, see page 49.

Displays the date and time. See page 119 for
details.

Displays marker information. For details see page
93.

21
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LXl icon

Function menu

Sweep Mode

Sweep settings

Trace and
detection settings

Blank

Trigger settings

Pre-amp settings

USB settings

Status Icons

22
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This icon indicates the status of the LXI connection.
For details, see page 224.

Soft menu keys associated with the F1 to F7
function keys to the right of the display.

This icon displays the sweep mode,
as set by the Sweep Mode key. See
page 78.

Sweep icon that shows the sweep
status. See page 71 for details.

Trace icon that shows the trace type
and the detection mode used for
each trace. See from page 80 for
details.

Unassigned setting icons.

Trigger icon that shows the trigger
status. See page 88 details.

Pre-amplifier icon that shows the
Pre-amplifier status. See from page
61 for details.

Displays the status of the USB A
port.

Displays the interface status, power source status
and alarm status, etc. See the Status Icon Overview
on page 24 for a list of the status icons.

839145 010-62176775
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Frequency/
Bandwidth
settings

Entry/Message
area

Trace and
waveforms

Sweep progress
bar

Displays the Start, Center and Stop frequencies,
RBW, VBW, Span and Sweep settings.

This area is used to show system messages, errors
and input values/parameters.

Main display showing the input signals, traces
(page 80), limit lines (184) and marker positions
(93).

The sweep progress bar shows the progress of
slow sweeps (greater than 2 seconds).

23
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3G Adapter

Demo Kit H
PreAmp
N

& 'y
AC Charge E

Alarm Off

Alarm On

Amplitude Offset

Battery indicator BAT I BAT
g =B
Bandwidth w
Indicator

24

Indicates that the 3G adapter is
installed and turned on.

Indicates that the demo kit is
installed and turned on.

Indicates that the pre amplifier is
on.

Shown when running on AC
power.

Shown when the AC power is
charging the battery.

Alarm buzzer output is currently
off.

Alarm buzzer output is currently
on.

Indicates that the amplitude-shift is

active. This icon appears when
amplitude-related functions are
used:

Reference level offset

Amplitude Correction

Input Z = 75Q and Input Z cal >0

Indicates the battery charge.

Indicates that the RBW or VBW
settings are in manual mode.

839145 010-62176775

www . hyxyyq..com



GYINSTEK

GETTING STARTED

Average

External Lock

External Trigger

Math

Sequence
Indicator

Sweep Indicator
Tracking
generator

TG Normalization

Wake-up clock

USB

Micro SD

839145

Indicates that the Average function
is active.

Indicates that the system is now
locked and refers to the external
reference input signal

External trigger signal is being
used.

Trace math is being used.

Shown when a sequence is running.

Indicates that the sweep time is
manually set.

Indicates that the tracking generator
is turned on.

Indicates that the tracking generator
has been normalized.

Indicates that the wake-up clock is
turned on.

Indicates that a USB flash drive is
inserted into the front panel and is
recognized.

Indicates that a micro SD card is
inserted into the front panel and is
recognized.

25
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First Use Instructions

Use the procedures below when first using the GSP-9300B to tilt the
stand, insert the battery pack, power up the instrument, set the
internal clock, set the wake-up clock, update the firmware and to
restore the default settings. Lastly, the Conventions sections will
introduce you to the basic operating conventions used throughout
the user manual.

Tilting the Stand

Description The GSP-9300B has two adjustable rubber feet
that can used to position the instrument into
two preset orientations.

Upright Position Tuck the feet under
the bottom of the
instrument to stand
the instrument
upright.

Leaning Position Pull the feet back to
have the instrument
leaning back.

26
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Inserting the Battery Pack

Description The GSP-9300B has an optional battery pack.
The battery should be inserted before power is
connected to the AC power socket and before
the unit is turned on.

Steps 1. Ensure the power is off and the AC power is
disconnected.

2. Remove the battery cover.

3. Insert the battery as shown in the diagram
below.

4. Replace the battery cover.

Display Icon EEAN  The battery icon is displayed when GSP-
93008 is running on battery power.

Insertion Diagram

27
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Steps

A Note

28

. Insert the AC power cord into the power

socket.

. The power button exterior will be lit blue to

indicate that the GSP-9300B is in standby
mode.

@@

. Press the power button for a few seconds to

turn the GSP-9300B on.

. The power button will turn orange and the

GSP-9300B will start to boot up.

, N

It takes a little less than 1 minute for the GSP-
93008 to fully startup.

839145 010-62176775
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Power Down

Description The GSP-9300B has two methods to power
down: Normal and Forced Power Down.

The normal power down method will save the
system state and end any running processes.
The state is saved for the next time the
instrument is turned back on.

The forced power down method only does a
minimum state save.

Normal Power Press the power button. The system will
Down automatically handle the power down
procedure in the following order:
*The system state is saved.

*Outstanding processes are closed in
sequence.

*The LCD backlight is turned off.

*The system enters standby mode (the
power key changes from orange to

blue).
& The process takes ~10 seconds.
Note
Forced Power Press and hold the power button for ~4
Down seconds until the system turns off and the

power button turns blue.

& The forced power down mode might cause the
Note GSP-9300B to perform a longer system check
the next time it is powered up.

29
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Setting the Date, Time and Wake-Up Clock

Description The GSP-9300B can be setup to power-up
automatically using the Wakeup Clock
function. This feature is useful to wake-up the
instrument early and eliminate settling time.

System Date Example: Set the System Date to July 1, 2016

1. Press >Dute/Time[F4]>Set
Date[F1]>Year[F1].

2. Press 2016>Enter[F1].
3. Press Month[F2]>7>Enter[F1].
4. Press Day[F3]>1>Enter[F1].

5. Press Return[F7].

A The System Date will be shown at the top of the
Note display.
System Time Example: Set the System Time to 9:00 AM

1. Press >D11te/I’ime[F4]>Set
Time[F2]>Hour[F1].

2. Press 9>Enter[F1].
3. Press Minute[F2]>0>Enter[F1].
4. Press Second[F3]>0>Enter[F1].

5. Press Return[F7].

30
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& The System Time will be shown at the top of the
Note display.

System Wake-Up Example: Set the GSP-9300B to wake up at 9:00
Clock AM

1. Press (9%n)>Date/Time[F4]>Wake-Up
Clock[F3]>Select Clock[F1].

2. Press Clock 1[F1] ~ Clock 7[F7] to choose a clock
1~7).

3. Press State[F2] to turn the wake up clock
on/ off.

4. Press Hour[F3]>9>Enter[F1].

5. Press Minute[F4]>0>Enter[F1].

6. Press [F5] and choose Rept. (Repeat) or Single.
7. Press Select Date[F6] and select a day.

8. Press Return[F7] to save the Wake-Up Clock
settings.

& The system time is kept with the CR2032 clock

Note battery. If the system time/ wake up clock can no
longer be set, please replace the clock battery. See
page 238.

31
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Firmware Update

Description

The GSP-9300B allows the firmware to be
updated by end-users. Before using the GSP-
9300B, please check the GW Instek website or
ask your local distributor for the latest
firmware.

System version

32

Before updating the firmware, please check the
firmware version.

Press >System Information[F1].

The firmware will be listed on the display.

Press any other main/control/file/ marker
/auxiliary key to exit out of the System
Information screen.

To upgrade the firmware, insert the new
firmware onto a USB flash drive or Micro SD
card and put the drive/card into the
appropriate front panel port. The firmware
files should be located in a directory named
“gsp932”.
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5. Press >More 1/2[F7]>Upgrade[F2].

6. The spectrum analyzer will automatically find
the firmware on the USB flash drive and start
to update the firmware. When finished, the
message “Upgrade is finished” will be shown
at the bottom of the screen followed by
“Rebooting”.

Rebooting "

7. The system will automatically restart after the
rebooting message.

& The upgrade process may take a few minutes.
Note

Restoring Default Settings

Description The factory default settings or user presets can
be easily restored using the Preset key on the
front panel. By default, the factory default
settings are restored with the Preset key.

For details on how to configure the preset
settings, please see page 122.

Steps 1. Press .

2. The spectrum analyzer will load the preset
settings.

33
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Conventions

The following conventions are used throughout the user manual.
Read the conventions below for a basic grasp of how to operate the
GSP-9300B menu system and front panel keys.

Soft Menu keys The F1 to F7 function keys on the right side of
the display correspond directly to the soft-
menu keys on their left.

F1 ~ F7 function keys

Soft-menu keys

(=) (5]

(e[« [e2)([e=)((e=]
9@@@@
==lslslsls)
)

o)

o)

0

00 0 4 550 0

QOOOOOON_J

Input Parameter
Values

Selecting this type of menu key will allow you
to enter a new value with the numeric keypad
or increment/decrement the value using the
scroll wheel.

Toggle State

Pressing this menu key will toggle the state.

34
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Toggle State &
Input Parameter

Pressing this menu key will allow you to toggle
the state of the function between Auto and
Man(ual) state. When in the Man state, the
parameter value can be manually edited. Use
the numeric keypad to enter the new value or
use the scroll wheel to increment/decrement
the current value.

Sub Menu

Date/Time>

Pressing this menu key will enter a submenu.

Sub Menu to
select parameter

Pressing this menu key will enter a submenu to
select a parameter.

Active Function

Pressing this type of menu key will activate
that function. The menu key will be
highlighted to show it is the active function.

35
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Parameter input

Using the numeric
keypad

Back Space

36

Numerical keypad

Scroll wheel

(
(

OJOJO
OO0

7N
O

Directional arrow keys

Backspace, Enter keys

Parameter values can be entered using the
numeric keypad, the scroll wheel and
occasionally with the arrow keys.

When prompted to enter a parameter, use the
number keys (0~9), the decimal key (.) and the
sign key (+/-) to enter a value. After a value
has been entered, the soft-menu keys can be
used to select the units.

The value of the parameter is shown at the
bottom of the screen as it is edited. Values can
include decimal points for non-integer values
or for entering dot-decimal notation for IP
addresses.

tart 20 000MHz
v 30K

Contor 26|
BW 30kHz 1

Span 10

Edited parameter

Use the backspace key to delete the last
character or number entered.
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Using the scroll Use the scroll wheel to alter the current value.
wheel Clockwise increases the value, anti-clockwise
decreases the value.

Directional arrows Use the directional arrows to select discrete
parameters or to alter values by a coarser
resolution than the scroll wheel. Left decreases
the value, right increases the value.

37
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BASIC OPERATION

Frequency Settings......cccoovviiiiiiiiiiiiiiininn
Center Frequency .................
Start and Stop Frequency....
Center Frequency SEP ...
Frequency OffSet. ..

Span Settings ....coooviiiiiiiiiii 45
SPAI et e
Full Span..............

Zero Span
LSt SPAN ..ttt

Amplitude Settings ......ccoouiiiiiiiiiiiiiiii e, 48
Reference Level
Attenuation.............
Scale/Div............
Auto Scale...........
SCALE TYPE oottt
VIEW SCALE ..vvieiretiiereteeeteteet ettt es et se s se s ebess s ebeas s esensne
Vertical Scale Units
Reference LLevel OffSElu. ittt saeeens
AMPlitude COLECHOMN .uuvuiiieiiiiiiiiicici e sses
Create a Correction Set
Amplitude Cotrection On/Off
Delete Correction Set...uiievereeevernne.
Save Correction Set to MemOLY. ...
Recall Correction Set From Memory
Input Impedance
Input Impedance Calibration.............
Using the Built-in Pre-Amplifier

AULOSEE .. 63
USING AULOSEL wevviviiiiiiiiriiiiiiii st 63
38

839145 010-62176775

www . hyxyyq..com



GUWINSTEK BASIC OPERATION

Limiting the Autoset Vertical Search Range ..o,
Limiting the Autoset Horizontal Search Range

Bandwidth/Average Settings.........ccccceeeiiiiiiiiiiiiiiiicanennnnn. 65
Resolution Bandwidth Setting (RBW) ......cccoviiiiiiiiiiiiiiicccccccin, 65
Video Bandwidth Settings (VBW) ..., 66
VBW/RBW Ratio
AVELAGE TTACE ..o
AVELAZE TYPE vttt
EMI FHIEEE ..ottt ettt

YT PP

SWEEP TIMIC oot
Single Sweep
CONtINUOUS SWEEP ..ovvveiuiiiiiiiiiiii s
Gated SWeePp OVEIVIEW....c..ciiiiiiiciii s
Using the Gated Sweep Mode
Sweep Control / Sweep Mode

TrACE covvniiiiiei e
SeleCting @ TTACE ...cuviuiieiciii s
TTACE MALh oot e
Trace Detection MOE ...ttt seaes
JLLEE =4 (=] PPN
Selecting a TTIGEEr TYPE...c.cviiriiiiiiiciiiii s
Free Run Mode......ciiiiiiiciciic e
Activate Video Trigger
Activate External THEZer ... oo 90
Selecting the Trigger MOdE ... 91
Set the Trigger Delay Time ..o 92
MaArKET...oeeiiiiiiiiiiieieeee
Activating @ Marker. ...
Activate a Normal Marker
Move Marker Manually ...
Move Market to Preset LoCations ......cvecvvecereceneerneeineeineciseensesensesenene 95
Activate Delta Market ....c.ocoeuveerrccrnccrncncnnee e 96
Move Delta Marker(s)Manually .... ettt es 97
Marketr FUNctions ......eeceeeevvevececveenenececrennenes ettt 98
MALKET INOISE wevvvrireeeeieirieseieieineeeie ettt ettt beseeen 98
Frequency COUNLET ... 99
VSR .ottt 100
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MOVE MATKEL t0 THACE .cvivireetetieeeretieeeteeeeeeeee et eseses s sssesess s esese s erenens
Show Markers in Table....
Peak SEATCH...uiieiitiietceceeee et bt erenens
Move Marker t0 Peak ....ovcuiieieiiiieiiieeeeteeeeeecreeer e ssnenes
Move Marker and Peak to Center
Search fOr PEAKS .ovvveeiieeceieeetceeeeeceeet ettt enenns
Peak Configuration ........cccucucuncureeriereeeencseeseeseeeeee e ese s
PEaK TADLE vttt ettt ae et nens

DiSPlay cucuuviiiiiiiiiiiiiii e
Adjusting the LCD Brightness ...
Turning the LCD Backlight Off
Setting a Display Line (Reference Level Line) ..., 110
Using the Video Out POTt. ...
Setting the Display Mode.........ccccovuviuvirininnnes

Spectrogram and Topographic Markers
SPlit SPectrum VIEW ...cuvuiiiiciciiiiieie it

System Settings .....covvvviiiiiiiiiiiii

System INfOrmation ..o
BATOr MESSAZES .vvvviiiiiiiiii s
Set the System Language
Set the Date and Time.....
Display the Date and Time on the Screen
Using the Wake-Up ClocK ..o
AJALM OULPUL .ot

Using the Preset Key ... 122
Save the User Preset SEttings ......cceviviiiiinivnieiciicsiie s 122
Preset TyPe SEttiNgs ... 123
Power on Preset SEttings ... 123
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Frequency Settings

Center Frequency

Description The center frequency function sets the center
frequency and centers the display to the center
frequency.

Operation 1. Press >Center[F1] and enter the

frequency and unit.
Range: 0kHz~3GHz

Resolution: 1Hz
Default: 1.5GHz

Display Center frequency

p 15 000MHz

Set Center Frequency

41
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Start and Stop Frequency

Description The start/stop frequency function will set the
start and stop frequency of the span.

Operation 1. To set the start frequency, press > Start
Freq[F2] and enter the frequency and unit.

2. To set the stop frequency, press > Stop
Freq[F3] and enter the frequency and unit.

Range: O0kHz~3GHz
Resolution: 1Hz

Default Start frequency: 0Hz

Default Stop frequency: 3GHz

Display Start Frequency Stop Frequency

04:46:00 201407

r10.000MHz
pan. 10.000MHz

Start Frequency Stop Frequency

& The start and stop frequency can change when the
Note span settings are used.

The stop frequency must be set higher than the
start frequency (for spans # 0), otherwise the span
will be automatically set to T00Hz.
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Center Frequency Step

Description The CF Step function sets the step size of the
center frequency when using the arrow keys or
scroll wheel.

When the scroll wheel or arrow keys or are
used to alter the center frequency, each
turn/press will move the center frequency by
the step size specified by the CF Step function.

In auto mode, the center frequency step size is
equal to 10% (1 division) of the span.

Operation 1. Press > CF Step[F4] and set the CF Step to
Auto or Man.

2. If Man was selected, set the frequency and unit
of the center frequency step size.

Manual Range: OHz~3GHz
Auto range: 1/10 of span frequency

12:43  2014-07-01

Display

CF Step size
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Frequency Offset

Description

The Freq Offset function allows you to add an
offset to the Center, Start and Stop frequencies
as well as the marker frequencies. The offset
value does not affect displaying the trace on the
display.

Operation 1.

Display

Press >Freq Offset[F5] and set the offset

value.

The Center, Start, Stop and Marker frequencies
are updated accordingly.

Offset Range: 0Hz~100GHz

Frequency
Offset
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Span Settings

Span

Description The Span function will set the frequency range
of the sweep. The sweep will be centered
around the center frequency.

Setting the span will alter the start and stop
frequencies.

Operation 1. Press (s )> Span[F1] and enter the span
frequency range and unit.

Range: 0kHz~3GHz

Resolution: 1Hz
Default Span: 3GHz

Display Span

15.04:39  2011-09-08
Mk1 3.0900 GHz - 10.83 d8Bm
At 20 008 AMK1 -B00MHz 100 dB

tart 3.000GHz 3.050GHz p 3.100GHz
W 420kHz W:300kHz  Span 100.000MHz woep 42 Tms

Span 100.000000 MHz

Set Span
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Description

The Full Span function will set the span to the
full frequency range.

This function will set the start and stop
frequencies to 0Hz and 3GHz respectively.

Operation

Zero Span

. Press > Full Span[F2].

Description

The Zero Span function will set the frequency
range of the sweep to O0Hz and fixes the start
and stop frequencies to the center frequency.
The Zero Span function measures the time
domain characteristics of the input signal at the
center frequency. The horizontal axis is
displayed in the time domain.

Operation

. Press > Zero Span[F3].

The span changes accordingly.
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Display Time domain

Stop 10.000MHz
S 9ms

OHz Span
Example: Amplitude modulation

& The measurement functions such as TOI, SEM,

Note CNR, CTB, CSO, ACPR, OCBW, phase, Jitter,
Harmonics, NdB, P1dB and other measurement
functions are not available with the zero span
setting:

Last Span

Description The last span function returns the spectrum
analyzer to the previous span settings.

Operation 1. Press > Last Span[F4].

47
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Amplitude Settings

The vertical display scale is defined by the reference level
amplitude, attenuation, scale and external gain/loss.

Reference Level

Description The reference level defines the absolute level of
the amplitude on the top graticule in voltage or
power.

Operation 1. Press > Ref Level[F1] and enter the
reference level amplitude and unit.

Range: -120dBm ~ 30dBm
Units: dBm, -dBm, W, V, dBV
Resolution: 1dBm

Display Ref Level reading Reference Level

49.55  2014-07-01

11 5.000MHz e
3V 1. 0kHz BW 1.0kHz

10.000MHz
10.000MHz

top 15.000MHz
woop 1.80s

Ref17.00dBm
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Attenuation

Description The attenuation of the input signal level can be
set to automatic (Auto) or manual (Man). When
the attenuation is set to Man, the input
attenuator can be changed manually in 1dB
steps.

Operation 1. Press > Attenuation[F2] and select Auto
or Man.

2. If Man was selected, enter the attenuation level

and unit.

Range: 0dBm ~ 50dBm
Units: dBm
Resolution: 1dB

Display Attenuation level

WY Ampiitude

Scale/Div

Description Sets the logarithmic units for the vertical
divisions when the scale is set to Log.

Operation 1. Press > Scale/Div[F3] repeatedly to select

the vertical division units.

Unit Range: 10,5,2,1

49
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A Note

The Scale/Div function is only selectable when the
scale is set to Log (logarithmic).

Auto Scale

Description The Auto Scale function will automatically set
the Scale/Div, Reference level and Attenuation
(if set to Auto) to best display the spectrum.

Operation . Press > Auto Scale[F4] to turn the Auto
Scale function on.

A This function is applicable to both the linear and

Note logarithmic scales.

Scale Type

Description Sets the vertical scale in linear or logarithmic
units.
By default the linear scale is set to volts and the
logarithmic scale is set to dBm.

Operation . Press > More[F7] > Scale Type[F2] and set
the vertical scale to Log or Lin.

50
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& If the unit scale is changed (i.e. dBm — volts), the
Note displayed vertical scale type will remain in the set
linear or logarithmic setting.

View Scale

Description The Scale function turns the vertical scale
on/ off. The value of each graticule division is
displayed with the same units that are used for
the Ref Level settings.

Operation 1. Press > Scale[F5] to toggle the Scale on or
off.

2. Press Scale Pos.[F6] to toggle the position of the
scale when on.

Scale position: Left, Center, Right

Display

Scale
Left

The vertical scale is displayed on the left-hand side
by default.
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Vertical Scale Units

Description Change the vertical units for both linear or
logarithmic scales.
Operation . Press (wmwwee)> More[F7]>Y Axis[F1] and then

choose the desired units.

. The units are changed accordingly.

Units: dBm, dBmV, dBuV,
Watts, Volts

Reference Level Offset

Description

The Reference Level Offset function sets an
offset value to the reference level to compensate
for any loss or gain from an external network or
device.

The offset value does not affect the input
attenuation or the on-screen trace.

This setting will change the reference level
readout, the scale readout and the marker
readout.

Operation

Display Icon

52

. Press > More[F7]>RefLvlOffset[F4] and set

the offset level and unit.

. To remove the offset level, set the reference

offset to 0 dB.

Range: 0dB ~ 50dB

The AMP icon is displayed at the bottom
of the screen.
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Example: Ref: 0dBm

Before reference level offset(offset: 0d B)

Reference level
Ref: 10dBm offset: 10dB

2014-07-01

After reference level offset (offset: 10dB)

Amplitude Correction

Description Amplitude correction adjusts the frequency
response of the spectrum analyzer by altering
the amplitudes at specified frequencies. This
allows the spectrum analyzer to compensate for
loss or gain from an external network or device
at certain frequencies.

Range Correction Sets: 5 sets of 30 points
Amplitude: -40dB to +40dB
Amplitude Resolution: 0.1dB
Frequency: 9kHz to 3GHz

Frequency Resolution: 1Hz

53
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Display Correction points

{lee(madmadsaaimal

Corrected
output

Original waveform

Example: The diagram above shows how amplitude
correction is used to compensate for any losses or
gains at specific frequencies.

Create a Correction Set

Description The GSP-9300B can create and edit up to 5 sets
of correction points. The correction points and
associated values are all tabulated for ease of
use.

Operation 1. Press > More[F7]>Correction[F3]> Select
Correction[F1] and choose a correction set to
edit/create.

Correction set: 1~5
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2. Press Edit[F3].

The GSP-9300B will split into two screens. The
top screen will show the waveform and the
bottom screen will provide an overview of the
correction points.

Frequency of

Spectrum display selected point

Tail 5 000MHzZ enter 10 00OMHzZ T
3 0kHz AW 3.0kHz pan 10, 000MHz

Frag 15000000 MHz

Correction points

3. Press Point Num[F1] and choose a point number
to edit. Point numbers can only be created in
order. For example Point Num 2 can only be
selected after Point Num 1 is created, and point
Num 3 can only be selected after Point Num 2
is created and so on.

Point Num: 1~20

4. Press Frequency[F2] and choose the frequency of
the selected point.

5. Press Gain Offset[F3] and choose the amplitude
of the selected point. The units will be the same
as those used for the vertical scale.
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The frequency of the point values are displayed
in the correction table on the bottom display.
Correction Table

6. Repeat steps 3 to 5 for any other correction

points.

. To delete the selected point, press Delete

Point[F6].

. Press Return[F7]>Save Correction[F5] to save the

correction set.

A Note

Note that the correction points are automatically
sorted by frequency (low — high).

The correction set must be saved before it can be
turned on.

The frequency values disp/ayed in the correction
table are rounded down for display purposes only.
The actual frequency for each point can be seen in
the Frequency soft-key.

Amplitude Correction On/Off

Description Any one of the 5 correction sets can be turned
on.
Activate . Press > More[F7]>Correction[F3]>
Correction Correction Set[F1] and choose a correction set.
Correction Set: 1~5
56
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2. Press Correction[F2] and toggle correction on.

Deactivate 1. Press > More[F7]>Correction[F3]>
Correction Correction[F2] to turn correction back off.

Delete Correction Set

Operation 1. Press > More[F7]>Correction[F3]>
Correction Set[F1] and choose the correction set
to delete.

Correction Set: 1~5

2. Press Delete Correction[F6].
The selected correction set will be deleted.

Save Correction Set to Memory

Operation 1. Press > Save To[F1] and choose the save
location.
Location: Register, Local, USB, SD

2. Press Type[F2]> Correction[F5].
3. Press Data Source[F3] and choose a correction.
Correction Set: Correction 1~5

4. To name the file, press Name[F5].
Name the selected file using the
F1~F7 keys, as shown below or use
the numeric keypad to enter
numbers.
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Limitations:
*No spaces
*Only 1~9, A~Z, a~z characters allowed

N

Oaa
~
3

E

Lowercase

(=3
A A A

Return

———

[ Name>

Return

i

J

. The filename appears on the bottom of the

screen as it is created.

£ 15.000MHz
Swasp:442ms

Filename

Press to confirm the filename.

A Note

58

If the file name is not user-defined, a file name will
be automatically created in the following format:

File name: type_data source_file number.file
extension

Example: Correction1_0.cor

The file number parameter is incremented each
time the same file type is created.
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6. Press Save Now[F7].
7. The correction set will be saved to the selected

location. For more information on Save and
Recall, please see page 215.

Recall Correction Set From Memory

Operation 1. Press > Recall[F1] and choose the recall
location:
Location: Register, Local, USB, SD

2. Press Type[F2]> Correction[F5].

3. Use the scroll wheel to select a previously saved
correction set from the file directory.

4. Press Destination[F3] and choose a correction
set.

Correction Set: Correction 1~5
5. Press Recall Now[F4].
6. The current correction set will be recalled from

the selected location. For more information on
Save and Recall, please see page 215.
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Input Impedance

Description Sets the input impedance to 75Q or 50Q).
Operation 1. Press > More[F7]> More[F7] > Input Z[F1]

to toggle the input impedance.

Range: 75Q, 50Q

Input Impedance Calibration

Description When an external impedance converter module
(optional accessory ADP-101) is used to convert
the impedance of a device from 50Q to 75Q,
some external loss can be induced. The Input Z
Cal function can be used to compensate for
these losses with an offset value.

A The Input Z Cal function is only functional when
Note the input impedance is set to 75Q.
Operation 1. Press > More[F7]>More[F7]>Input Z
Cal[F2] and set the impedance offset.
Range: 0dB to +10dB
Resolution: 1dB
Display Icon @  The AMP icon is displayed at the bottom
of the screen when Input Z Cal#0dB and
Input Z is = 75Q.
60
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Using the Built-in Pre-Amplifier

Description The built-in pre-amplifier boosts weak input
signals, such as EMI testing signals, to levels
that are easy to handle, over the entire
frequency range. The built-in pre-amplifier on
the GSP-9300B has a nominal gain of 20dB.

In the Auto setting, the pre-amplifier will be
automatically turned on when the reference
level is less than -30dBm. When the reference
level is greater than -30dBm, the pre-amplifier
is turned off. The bypass setting turns the pre-
amplifier off.

Operation 1. Press (Awue)> More[F 7]>Preamp[F5] to toggle
the Preamp state.
Range: Auto, Bypass
Display Icon The Pr-amp icon indicates that the pre
amplifier is on.
Example: B 2T T 00w 2206 o

At00a8 2L

tart 5 000MHz o 10.000MHz top 15.000MHz
W 3 0kHz BW 3.0kHz an 10, 000MHz woep-442ms

Pr-amp icon
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A When the pre-amplifier is on, the attenuator
Note becomes fixed at 0dB (i.e. Attenuation = 0dB).

62
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Autoset

The Autoset function searches the peak signals in two stages (full
span & OHz - 100MHz limited span), picks the signal peak with the
maximum amplitude, and then shows it in the display.

Using Autoset

Operation 1. Press > Autoset[F1].

Autoset Range Amplitude: -80dBm ~ +20dBm
Span: 0Hz ~ 3GHz

. 22:33.08  2014-07-01 &Y Frequency
Example: woae :

0.00dBm At 10.0d8 |:]
‘ - StartFrag
L

1t OHz r 1,500GHz p 3.000GHz
W AMHz 1MHz Span:3,000GHz woep: 348m:

FactoryPreset mode

Before Autoset, preset state

22:33:51  2014.07-01
108/ (3] 10.000 MHz 8.10  dBm
of 10.000Bm _ Att 20.00d8 1

14l !
:‘-‘E./“Wu‘v'*\,w.‘Lq;.@muh

tart 8.500MHz r10.000MHz p11.500MHz
REW 30kHz 30KkHz pan:3.000 weep:25.2ms

After Autoset
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A RBW, VBW and sweep settings are reset to Auto
Note when the Autoset function is used.

Limiting the Autoset Vertical Search Range

Description You can set the amplitude floor so that the
signals lower than the setting will be ignored
by the Autoset search.

Operation 1. Press (uese)> Amp.Floor[F2] and switch the

range from Auto to Man.

2. Enter the amplitude limit and unit for the
Autoset search.

Range: —60 to +20dBm

A See page 50 for setting the amplitude units.
Note

Limiting the Autoset Horizontal Search Range

Description You can change the frequency span limit in the
display to get a better view of the Autoset
result. By default, the frequency span after
Autoset is set at SMHz.

Operation 1. Press > Span[F3] and switch the range
from Auto to Man.

2. Enter the span frequency for the Autoset
search.

Manual Range:  100Hz to 3GHz
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Bandwidth/Average Settings

BW/AVG key sets the resolution bandwidth (RBW), video
bandwidth (VBW) and averaging functions. The resolution, sweep
time, and averaging are in a trade-off relationship, so configuration
should be done with care.

Resolution Bandwidth Setting (RBW)

Description RBW (Resolution Bandwidth) defines the width
of the IF (intermediate frequency) filter that is
used to separate signal peaks from one another.
The narrower the RBW, the greater the
capability to separate signals at close
frequencies. But it also makes the sweep time
longer under specific frequency spans (the
display is updated less frequently).

SPAN-RBW Auto When the RBW is set to Auto, the RBW is
relationship determined by the frequency span. This is
shown in the table below.

SPAN-RBW Span (Hz) < RBW (Hz) Span (Hz) <RBW (Hz)
relationship in 200 1 650k 3000
Auto mode.

650 3 2M 10000

2k 10 6.5M 30000

6.5k 30 20M 100000

20k 100 65M 300000

200k 1000 200M 1000000

65
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Operation

. Press > RBWI[F1] and set the RBW to

Auto or Man.

. Set the resolution bandwidth and unit for Man

mode.

Mode: Auto, Man

Frequency Range(3dB): 1Hz~1MHz (1-3-10
step)

Frequency Range(6dB): 200Hz, 9kHz,
120kHz, 1IMHz

& Note

If the setting is in Auto mode, using the scroll
wheel or arrow keys will automatically set the RBW
to manual mode.

Display Icon

The BW icon is displayed at the bottom of
- the screen when the RBW is in Man mode.

A Note

If the RBW settings have an asterisk (¥), it
indicates that the -6dB filters are used.

Video Bandwidth Settings (VBW)

Description

VBW (Video Bandwidth) defines the
smoothness of the trace on the display.
Combined with RBW, VBW defines the ability
to sort out the target signal from surrounding
noise or adjacent peaks.

Operation

66

. Press > VBWI[F2] and set the VBW to

Auto or Man.

. Set the video bandwidth and unit for Man

mode.
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Display Icon

VBW/RBW Ratio

Mode: Auto, Man
Frequency Range(3dB): 1THz~1MHz (1-3-10 step)

The BW icon is displayed at the bottom of
- the screen when the VBW is in Man mode.

Description

The VBW/RBW function is used to view the
ratio between the video bandwidth and the
resolution bandwidth.

The VBW/RBW ratio is altered by setting the
RBW and or VBW settings, see page 65 & 66
respectively.

View VBW/RBW 1,
ratio

2.

Display

Press .

The ratio is displayed on the VBIA/RBW[F3] soft
key.

VBW/RBW
Ratio

Tip

Signals that are masked by the noise floor level
should have a ratio of less than 1 to smooth the
noise out.

Signals with strong frequency components should
use a ratio equal to or greater than 1.
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Average Trace

Description The Average function averages the trace for a
user-defined number of times before it is
displayed. This feature smoothes the noise
level, but has the drawback of slowing down
the display update rate.

Operation 1. Press > Average[F4] and toggle Average
on or off.

2. Set the number of averages.

Range: 4 ~200
Default: 20
Display Icon The AVG icon is displayed at the bottom of
the screen when the Average function is
on.
68
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23:16:23  2014.07-01

EXampIe: 1048/ UMk 10,000 MHz 8.24
1

10.00dBm _ Att 20.00d8

r10,000MHz p11.500MHz
3.000MHz weep:25.2ms

Average:Off

Number of traces that
have been averaged

2609  2014.07-01 'lm BW/Avg

10.000 MHz 8.24  dBm /,—‘
L VEW)

10.000MHz P 11.500MHz
W:30kHz  Span:3.000MHz weep:25.2ms

h

Average: On (20x)
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Average Type

Description The Average Type function determines how the
GSP-9300B determines the average value.

LOG Average: Averages the trace points on a
logarithmic scale.

Volt Average: Averages the amplitudes of the
trace points on a linear voltage scale.

Power Average: Averages the trace points on a
logarithmic scale in watts.

Operation 1. Press > Average Type[F5] and choose the
average type.

Range: LOG Power, Volt

Average, Power Average
Default: LOG Power

EMI Filter

Description The built-in EMI filter is used for specific
measurement situations such as EMI average
detection, where a higher level of sensitivity is
required compared to the standard
configuration. When turned on, the RBW is set
to -6dB, indicated by an asterisk (*).

When any measurement functions are turned
on (see page 124 for details), the EMI filter is
automatically disabled. Conversely if the EMI
filter is turned on, any measurement functions
are turned off.
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Operation 1. Press (a9 )> EMI Filter[F6] and toggle EMI
filter on or off.
& See the specifications for details on the EMI filter,
Note page 277.
1
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Sweep

The GSP-9300B has a number of sweep options including setting
the sweep time, the sweep run mode (continuous, single) and
sweep mode (fast, slow). The GSP-9300B also has gated sweep

modes.

Sweep Time

Description

Operation

Display Icon

72

Sweep time defines the length of time the
system takes to "sweep” the current frequency
span. Note, however, that sweep time and
RBW/VBW are in a trade-off. Faster sweep
times update the display more frequently but
make RBW and VBW wider, reducing the
capability to separate signals at close
frequencies.

. Press > Sweep Time[F1] and toggle the

Sweep time to Auto or Man.

. Set the sweep time for the Man mode.

Mode: Auto, Man
Range: 1.14ms ~ 1000s (span=100Hz,
RBW=3kHz)
Resolution: 46.6us ~ 1000s (span=0Hz,
RBW= 1MHz)
Sl The SWT icon will be displayed at the
bottom of the screen when the sweep is in
manual mode.
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Single Sweep

Description The single sweep function is used to perform a
single sweep. When Sweep Single is pressed the
GSP-9300B will perform a single sweep and
then stop.

Operation 1. Press > Sweep Single[F2] to put the
spectrum analyzer into single sweep mode.

2. Press Sweep Single[F2] again to perform a single
sweep.

+*When a single sweep has been performed, you
can still perform frequency, span, amplitude and
other functions on the “frozen” trace.

Display lcon Blees The Sweep Single icon is displayed on the
right-hand side of the screen when the
sweep is in single mode.

& You must wait for the single sweep to finish before
Note pressing the Single Sweep key again.

If a setting is changed whilst the spectrum analyzer

is still sweeping, the single sweep will immediately
start over.

Continuous Sweep

Description The GSP-9300B has two main sweeping run
modes: single and continuous. Use the
continuous mode to have the sweep constantly
updated.
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Operation

Display Icon

1. Press > Sweep Cont[F3] to put the

spectrum analyzer into continuous sweep
mode.

right-hand side of the screen when the
sweep is in continuous mode.

A Note

The GSP-9300B will now continuously sweep
unless the mode is changed to single sweep mode
or if the system is waiting for a trigger condition.

Gated Sweep Overview

Description

The Gated Sweep mode allows a trigger signal
to dictate when the spectrum analyzer can
sweep. This mode is useful for characterizing
signals that are pulsed on and off, such as RF
burst transmissions or for measuring spurious
noise levels between transmission bursts.

Overview

74

. The trigger signal must be synchronized to the

period of the input signal (shown as RF burst
below).

. The start of the gate time is produced from the

positive or negative edge of the trigger signal +
the delay time.

. The end of the gate time is determined by the

set gate length.

. The gated sweep should not be positioned at

either end of the transmission.
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period

Trigger |_|

Gate |_| |_|

— ;&Delay % ;&Length

Example: The diagram above demonstrates the
relationship between the input trigger, the input
signal and the position of the gated sweep relative
to the input signal.

& Note

Please take into consideration RBW settling time.
Setting the delay time too short may not leave
enough time for the RBW filter to resolve.

Using the Gated Sweep Mode

Connection

1. Connect a trigger signal (3.3v CMOS) to the

GATE IN port on the rear panel.
TRIG IN

Trigger_u_u_ — @

GATE IN

& Note

RBW must be equal to or greater than 10kHz for
the gated sweep mode function to be available.
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Operation

Display Icon

76

1. Press > GateDelay[F5] and set the gate

delay time.

. Press > Gated Length[F6] and set the gate

time length.

. Press > Gated Sweep[F4] and turn the

mode on.
Gate Delay: 0s ~ 1000s
Gate Length: 58us ~ 1000s

@4 The Sweep Gated icon is displayed when
sl Gated Sweep is turned on.

o lEd
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Example: The example below shows the spectrum of an FSK
modulated signal when gated sweep mode is off.

2014-06-17

The example below shows the same signal with the
gated sweep timed to sweep when only the desired
frequency is output.

09:39:12  2014-06-17
o 1048/
1 0.00dBm At 10.0d8

Gated sweep icon

tart 1.500GHz top 1.501GHz
iz ¢

onter 1.500GHz
BW 30kHz pan 1.000MHz woop 10.0ms

& Gate Delay and Gate Length must first be set
Note before Gated Sweep is turned on.
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839145 010-62176775 www . hyxyyq..com



GYINSTEK

GSP-9300B User Manual

Sweep Control / Sweep Mode

Description

The Sweep Control function and the Sweep

Mode key toggles the Sweep Mode from
Normal to Fast.

The Fast setting speeds up the signal processing
and the display update rate to increase the
overall sweep time. This mode is especially
useful when the span is greater than 1IMHz.

When set to Normal, signal processing and
update rate is set to normal levels.

Operation

Display Icon

. Press > Sweep Control [F7] to toggle the

Sweep Mode between Norm. and Fast.

OR

. Press and toggle the Sweep Mode

between Norm. and Fast.

Sweep Times

78

Center Frequency = 1.5GHz  Sweep Mode

Span(Hz) RBW (Hz) AUTO Norm.  Fast

3G ™ 169ms  84.8ms
2G ™ 104ms  52.2ms
1G ™ 52ms 31.1ms
500M ™ 31ms 16.8ms
200M ™ 13.4ms 6.72ms
100M ™ 6.7ms 3.36ms
50M 300k 10.7ms  716us
20M 100k 23.4ms 573us
10M 100k 11.7ms  286us
839145 010-62176775
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5M 30k 28.9ms  655us

2M 10k 101Tms  1.96ms
™ 10k 50.9ms 1.31ms
500k 3k 6.88ms  6.88ms
200k 1k 22.9ms 22.9ms
100k 1k 9.83ms 9.83ms
50k 300 76.4ms  76.4ms
20k 100 219ms  219ms
10k 100 109ms  109ms
5k 30 710ms  710ms
2k 10 1.98s 1.98s

1k 10 994ms  994ms
500 3 2.65s 2.65s

200 1 2.65s 2.65s

100 1 2.65s 2.65s
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Trace

The GSP-9300B is able to set the parameters of up to 4 different
traces on the display at once. Each trace is represented by a
different color and is updated with each sweep.

Selecting a Trace

Description Each trace (1, 2, 3, 4) is represented by a
different color. When activated, an icon for each
trace color and function is shown to the left of
the display. When a trace is selected,
parameters can be set/edited from the trace

menu.
Trace Color: 1: Yellow
2: Pink
3: Blue
4: Orange
Trace Type The type of trace used determines how the trace

data is stored or manipulated before being
displayed. The analyzer updates each trace
according to the type of trace used.

Clear and The GSP-9300B continuously
Write updates the display with each
sweep.
80
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Hold Max/ The maximum or minimum

Hold Min points are maintained for the
selected trace. The trace points
are updated each sweep if new
maximum or minimum points
are found. The Hold Max
setting also has a threshold
setting. This setting will ensure
only those values above the
threshold are kept.

View View will hold the selected
trace and stop updating the
trace data for the selected trace.
Pressing View[F5] will display
the trace data that was cleared
using the Blank[F6] key.

Blank Clears the selected trace from
the display and stores trace
data. The trace can be restored
by pressing View[F5].

Display Icon —
Example = View
Trace 1 .
e Hold Max
Trace 2 - .
!; View
Trace 3
% Blank
Trace 4
[
Operation 1. Press (7 )> Trace[F1] and choose the trace
number.
Trace: 1,2,3,4
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. Select the trace type:

Clear & Write[F2]
Max Hold|F3]
Min Hold[F4]
View/F5]
Blank{F6]

. If Max Hold[F3] was selected, set the threshold

level.

A Note

Trace Math

Traces, 2, 3 and 4 are set to Blank by default.

Description

Performs trace math from two traces (TR1, TR2)
and stores the result in the currently selected
trace. It also performs trace shift.

Math functions

82

Power Diff Subtracts the TR1 amplitude
data from the TR2 amplitude
data. The TR1 data TR2 data
are converted to watts. The
result is converted back to
dBm.

Log Diff Subtracts the TR1 amplitude
data from the TR2 amplitude
data and then adds a
logarithmic reference. Both the
TR1 and TR2 data is in dBm.
The resultant trace of the
subtraction is in dB. When the
result is added to a logarithmic
reference the resulting data is
in dBm.
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LOG Offset Adds a reference to the TR1
trace

Operation 1. Press (= )> More[F1]>Trace Math[F1].
2. Press TR1[F1] and select the first trace source:
TR1: Trace 1,2, 3, 4*

3. Press TR2[F2] and select the second trace

source:
TR2: Trace 1, 2, 3, 4*
& *You cannot select the current trace as the TR1 or
Note

TR2 trace sources. The current trace is designated

by pressing > Select Trace>[FI].

4. Select the trace math function:

PowerDifiJF3]
LogDifflF4]
LogOffsetfF5]

5. If LogDiff was selected, set the reference level
and unit.
LogDiff ref range: -120dBm ~ 30dBm
LogDiff ref units: dBm, W

6. If LogOffset was selected, set the offset level
and unit.
LogOffset range: -50dB~+50dB

7. To turn trace math off, press the OFF[F6].

83
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Display Icon

Trace Detection Mode

The Math icon is displayed when trace
matbh is turned on.

Description

Each time the spectrum analyzer samples data
for each point on the trace, a number of samples
are usually taken for each point, known as a
sample bucket. The actual value of each point is
determined by the detector from the samples in

each bucket.

Each selected trace, (1, 2, 3, 4), can use a
different detection mode.

Detection modes

84

Auto

Normal

Peak+

Automatically chooses an
appropriate mode based on the
values of all the samples.

While the signal level is
constantly increasing or
decreasing, the positive peaks
are detected. Otherwise, the
detection mode switches
between positive peak and
negative peaks. Useful for
picking up burst phenomenon
while avoiding excessive noise.

Detects positive peak signals
by selecting the maximum peak
value for each point from each
bucket. This mode is useful for
sinusoidal signals.
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Peak- Detects negative peak signals
by selecting the lowest peak
value for each point from each
bucket. This mode is not
recommended for amplitude
measurement.

Sample Randomly selects a value from
the bucket sample. Useful for
noise signals.

RMS Calculates the RMS average
Average power of all the samples in the
sample bucket.

85
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Auto Detector
Selection Method

Below is a flow chart diagram showing the
Detector selection for the Auto mode.

Detector
(Auto mode)
y
| Are any windows | v,
set to Topographic?

N
\

l Is Phase Jitter Y
measurement on?

-

-

N
A
Is (trace) Average Is Average Type
on? set to Power?
N
A
Are any traces set | v,
to Max Hold?
N
A
Are any traces set | v
to Min Hold?
N
A
(Normal )

Operation

86

. Press > More[F7]>Detection[F2].

. Select the trace detection mode for the selected

trace:

AutofF1]
Normal[F2]
Peak+[F3]
Peak-[F4]
Sample[F5]

RMS Average[F6]
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3. The display will return to the Trace menu.

Display Icon Normal Peak+ icon

Peak- icon Sample icon

RMS Average
icon

RIS

87
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Trigger

The Trigger function sets the signal conditions upon which the
spectrum analyzer triggers captured waveforms, including
frequency, amplitude, and delay. An external trigger signal, instead
of the default internal signal, may be used as required for special
conditions.

The sections below can be used to skip to the relevant section:

*Free Run Mode — from page 88
+Activate Video Trigger — from page 88
*Activate External Trigger — from page 90
«Selecting Trigger Mode — from page 91
*Set the Trigger Delay Time — page 92

Selecting a Trigger Type

Free Run Mode

Description In free run mode all signals are captured and
the trigger conditions are not used.

Free Run Mode 1. Press (™ )> Free Run[F1] to run in free mode.

Activate Video Trigger

Description Sets the video trigger level for video signals.
When the video signal voltage level exceeds*
the video trigger level, a trigger signal will be
generated.

*for positive video edge

88
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Parameters Video Edge: Determines the polarity of the
video trigger.

Positive: The signal voltage
exceeds the video level at the
trigger frequency.

Negative: The signal voltage is
lower than the video level at

the trigger frequency.
Video Level: The trigger voltage level.
Trigger Sets the frequency to start
Frequency: triggering
Operation 1. Press >Trigger Condition[F2]>Video[F1]

2. Press Video Edge[F1] and choose the edge.
Range: Positive, Negative

3. Press Video Level[F2] and set the video voltage
trigger level.

Trigger level: (-120dBm to +30dBm)
+Ref Level Offset

4. Press Trigger Freq[F3] and choose the frequency
at which the spectrum analyzer will check the
triggering conditions.

Frequency: 0~3GHz+frequency
offset

WIEEER The Video Level trigger icon is displayed
when the Video trigger is activated.

Display Icon
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A Note

Set the trigger back to Free Run to disable the
video trigger.

Activate External Trigger

Description

The external trigger is used when an external
trigger signal is input into the rear panel TRIG
IN port. The external trigger signal can be
configured as positive or negative edge.

Trigger: 3.3V, CMOS

Operation

Display Icon

90

. Press >Trigger Condition[F2]>Ext.Edge[F2]

and select the trigger edge:

Pos: Positive edge
Neg: Negative edge

. Connect the external trigger signal to the rear

panel TRIG IN port.

TRIG IN

Trigger_u_u_ —

GATE IN

. Press Action Now[F5] to activate the external

trigger.

. The system will now wait for the trigger

conditions to be matched before starting a
sweep.
Bl The EXT Trigger icon is displayed when the
CESN external trigger is activated.

EXT
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& The trigger will revert back to the Free Run mode if
Note any parameter settings are changed, such as the
span or amplitude settings.

Selecting the Trigger Mode

Description In free run mode all signals are captured and
the trigger conditions are not used.

Modes Normal: The spectrum analyzer captures
every signal that meets the trigger
conditions.

Single: The spectrum analyzer captures

the first signal that meets the
trigger conditions.

Continuous: The spectrum analyzer captures
the first signal that meets the
trigger conditions then switches to
free run mode thereafter.

Operation 1. Press > Trigger Mode[F3] to toggle the
trigger mode:
Nor.: Normal
Sgl.: Single
Cont.: Continuous

2. Press Action Now[F5] to manually start
triggering.

Display Icons Normal: Single: Continuous:
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Set the Trigger Delay Time

Description Sets the delay time between when the analyzer
triggers and when the analyzer begins to
capture the signal.

Delay time range: 1ns to 1ks

Operation 1. Press >Trigger Delay[F4] and set the
trigger delay time.
Delay range: 0~1000s
92
839145 010-62176775

www . hyxyyq..com



GUWINSTEK BASIC OPERATION

Marker

A Marker shows the frequency and amplitude of a waveform point.
The GSP-9300B can activate up to 6 markers or marker pairs
simultaneously as well as up to 10 peak markers in the marker table.

The marker table helps editing and viewing multiple markers in a
single display.

A delta marker shows the frequency and amplitude difference from
a reference marker.

The GSP-9300B can automatically move a marker to various
locations including the peak signal, center frequency, and
start/stop frequency. Other marker operations regarding signal
peaks are available in the Peak Search function.

*Activating a Marker — from page 94

*Move Marker Manually — from page 95

*Move Marker to Preset Locations — from page 95
*Activate Delta Marker — from page 96

*Move Delta Marker(s)Manually — from page 97
*Marker Functions — from page 98

*Move Marker to Trace— from page 102

+*Show Markers in Table — from page 103

*Peak Search — from page 104

*Peak Configuration — from page 106

+Peak Table — from page 107
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Activating a Marker

There are two basic marker types, normal markers and delta
markers. Normal markers are used to measure the frequency/time
or amplitude of a point on the trace. Delta markers are used to
measure the difference between a reference point and a selected
point on the trace.

Activate a Normal Marker

Operation 1. Press (" )> Select Marker[F1] and select a
marker number.

Marker: 1~6
2. Press [F2] to turn the selected marker on.

3. Press Normal[F3] to set the selected marker to
the Normal type.

4. The display will show the marker on the trace
(centered by default) with the marker

measurement at the top of the display.

Maker ID, Frequency, Amplitude

Marker

tart 8.500MHz 10.000MHz
W 30kHz BW 30kHz a0 3. 000MHz

Fr0q:10.000000 MHz
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Move Marker Manually

Operation 1. Press > Select Marker[F1] and select a
marker number.

2. Use the left/right arrow keys to @)
move the marker one grid division. @%@

3. Use the scroll wheel to move the
marker in fine increments.

4. Alternatively, the numeric keypad
in combination with the F1~ F7
keys can be used to directly enter
the frequency of the marker
position.

Move Marker to Preset Locations

Description The key is used to move the selected
marker to a number of preset positions.

Functions Mkr>Center: Move to center frequency.
Mkr>Start: Move to start frequency.
Mkr>Stop: Move to stop frequency.
Mkr>CF Step:  Move to step frequency.
Mkr>Ref Lvl:  Move to reference level
amplitude.

& Not When the key is used, the span and other
ote

settings may be automatically changed.
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Operation

1. Press > Select Marker[F1] and select a

marker number.

. Press and select a marker position:

Mbkr>Center[FT]
Mhkr>Start [F2]
Mhkr>Stop[F3]
Mkr>CF Step[F4]
Mhkr>Ref Lvi[F5]

Activate Delta Marker

Description

Delta markers are marker pairs that measure
the difference in frequency/time and amplitude
between a reference marker and a delta marker.

When delta markers are activated, the reference
and delta marker appear at the position of the
selected marker, or in the center of the display
if the selected marker has not yet be activated.

The marker measurement is located at the top
of the display, under the “normal marker”
measurement.

Delta Markers

Ref: Reference marker, designated as é.

Delta: Delta marker, designated as Avl.

Operation

926

. Press > Select Marker[F1] and select a

marker number.

. Press [F2] to turn the selected marker on.

. Press Delta[F4]>Delta[F1] to set the selected

marker to the Delta type.
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Move Delta Marker(s)Manually

Move Deltaor 1. Press > Delta[F4]> MoveRef[F2] to move
Reference Marker  the reference marker.

2. Press > Delta[F4]> MoveDelta[F3] to move
the Delta marker.

3. Move the selected marker in the same fashion
as a normal marker, see page 95

Move Both 1. Press either Move Pair Span[F4] or Move Pair
reference and Center[F5] to move both markers at the same
delta marker time.

Move Pair Span: Sets the frequency span

between both markers.
The span can be positive
or negative:

1 Al
<& tspan> ©

Al 1
© &-span—2>©

Move Pair Center: Moves both markers at
the same time, keeping
the span between both
markers even
throughout.

2. Move both markers in the same fashion as a
normal marker, see page 95.
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Marker Functions

Marker Noise

Description The noise marker function calculates the
average noise level over a bandwidth of 1Hz,
referenced from the marker position.

Operation 1. Press (" )> Select Marker[F1] and select a
marker number.

2. Press [F2] to turn the selected marker on.

3. Press Normal[F3] and then position the marker
to the desired location.

4. Press Function[F5]>Marker Noise and turn
Marker Noise on.

5. The display will show the noise level
measurement at the top of the screen in
dBm/Hz.

Marker ID, Frequency, dBm/Hz

Marker

tart 5 000MHz ter 10.000MHz p 15 000MHz
W 3 0kHz BW:3.0kHz  Span:10.000MHz weep 442ms
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Frequency Counter

Description The frequency counter function is used to make
accurate frequency measurements.

Operation 1. Press (" )> Select Marker[F1] and select a

marker number.
2. Press [F2] to turn the selected marker on.

3. Press Normal[F3] and then position the marker
to the desired location.

4. Press Function[F5]>Frequency Counter[F1] and
turn the counter function on.

5. Press Resolution[F2] and set the resolution:

Auto: Automatically chooses
the best resolution.

Man: Allows the resolution to
be manually set.

Man Range: 1Hz, 10Hz, 100Hz, 1kHz

6. The display will show the frequency
measurement at the top of the screen at the
selected resolution.

Frequency

21.57.57 201407,
MKCnt 1 10.000 MHz 7.78 ) JdBm
t 0 48

|
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VSWR

Description

The Voltage Standing Wave Ratio is the voltage
ratio between transmitted and reflected waves,
usually measured in RF electrical transmission
systems. The VSWR function will use the
Tracking Generator of the GSP-9300B as
reference signal. See page 196 for more
information about the Tracking Generator.

Operation

100

. Before starting a VSWR measurement, the

tracking generator must be turned on and
normalized. If the TG has not been turned on
and normalized, the VSWR function will not be
available.

. Connect the TG output directly to the RF input.

. Press >Tmcking Generator[F1]>TG[F1] to

toggle the tracking generator to on.

. Press Normalize[F6]>Exe. Norm[F1] to perform a

normalization.

. Using a Return Loss Bridge (recommended

Goodwill Instek RLB-001), connect the DUT to
the TG output and the RF input of the GSP-
9300B as shown in the below diagram.

GSP

TG RF

OUTPUT INPUT
RLB

DUT
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6. Press > Select Marker[F1] and select a

marker number.
7. Press [F2] to turn the selected marker on.

8. Press Function[F5]>VSWR|[F3] to turn the
VSWR measurement on.

9. The display will show the VSWR measurement
at the top of the screen.

Marker ID, Frequency, VSWR measurement

Marker

250 000MHz p 500.000MHz
cop 283ms

tart OHz ent
W 100kHz ~ VBW 100kHz  Span 500 000MHz

SaveFinish
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Move Marker to Trace

Description

The Marker Trace function moves the selected
marker to any of the currently active traces.

Operation

102

. Press > Select Marker[F1] and select a

marker number.

. Press [F2] to turn the selected marker on.

. Press More[F7]>Marker Trace[F1] and choose a

trace to move the current marker to. Only active
traces can be selected.

AutofF1]

Tracel[FZ]
TraceZ[F3]
Trace3[F4]
Trace4[F5]

. In the example below, marker 1 is set to Tracel

and marker 2 is set to Trace2.

Marker 1, Trace 1

2.07:53  2014:07-06
Mk1 .00 MHz - 43.45 dBm

tart 5.000MHz r10.000MHz 15.000MHz
5w 100kHz  vEw | pokHz  Span:10.000MHz weep 17.9ms

Marker 2, Trace 2
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Show Markers in Table

Description The GSP-9300B has a Marker Table function to
show all the active markers and measurements
at once.

Operation 1. Press (e )> More[F7]>Marker Table[F2] and

turn the marker table on.

2. The display will split into two screens. The
bottom half will show the Marker Table with
the marker ID (normal, reference or delta),
trace, x-axis position (frequency/time) and the
amplitude of the marker.

1:52  2014-07-06 L
8.00 MHz - 91.95 dBm/Hz

Marker Table
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Move Marker to Peak

Description The key is used to find trace peaks.
Operation . Press > Select Marker[F1] and select a

marker number.

. Press >Peak Search[F1]. The marker will

move to the highest signal peak.

. To continually search for the peak on each

sweep, press, >More [F7]>Peak Track[F1]
and set Peak Track to on.

Move Marker and Peak to Center

Description

The Center function moves the marker to the
highest signal peak and moves the center
frequency to that peak. This function can be
used with the Next Peak, Next Peak Right, Next
Peak Left and Min Search peak functions, see the
Search for Peaks section on page 105 for details.

Operation

. Press > Select Marker[F1] and select a

marker number.

2. Press >Mkr>Center[F2].

A Note

The span will not be changed.

104
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Search for Peaks

Description The key can be used to search for a
number of different peaks.

Peak Search Next Peak: Searches for next highest
peak visible on the display.

Next Peak Right: ~ Searches for the next peak to
the right of the marker.

Next Peak Left: Searches for the next peak to
the left of the marker.

Min Search: Searches for the lowest peak.
Operation 1. Press > Select Marker[F1] and select a

marker number.

2. Press and select the type of peak you
wish to find.

Example:
Next Peak

105
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2014-07-06
10.000 MHz 18.68 dBm

Bl PeakSearch

Example:
Next Peak Right

Example:
Next Peak Left

Peak Configuration

Description There are two peak search configuration
options: Peak Excursion and Peak Threshold.

Peak Excursion:  Peak Excursion sets the
minimum value above the
peak threshold for which
peaks will be detected.

106
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Peak Threshold:  Peak threshold sets the
minimum threshold level for
the analyzer to detect peaks.
Any value above the Peak
Threshold + Peak Excursion
will be detected as a peak.

1
Peak
Excursion
2
< Peak
Pk A\ - L excursion
Threshold
A\
Operation 1. Press >More [F7].

2. Press Peak Excursion[F2] to set the excursion
level.

3. Press Peak Threshold[F3] to set the peak

threshold.
Peak Excursion: 0~100dB
Peak Threshold: -120dB~+30dB

Peak Table

Description The Peak Table function will display all peaks
(up to 10) that meet the peak configuration
settings. The amplitude and frequency for each
peak is listed.

Operation 1. Press >More[F7]>Peak Table[F5].
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2. Press Peak Sort[F2] and set the sorting type:

Freq: Sort by frequency in
ascending order.
Amp: Sort by amplitude in

ascending order.
3. Press Peak Table[F1] to turn the peak table on.
4. The display splits in two. The bottom screen
shows the peak table with the peak marker ID,

X-axis position and amplitude.

Peak markers

Peak Table

A Note all that the markers for the Peak Table

Note function are all marked with “P” and are colored
purple so they can be distinguished from the other
markers.

108
839145 010-62176775

www . hyxyyq..com



GUWINSTEK BASIC OPERATION

Display

The Display key configures the basic display settings as well as
setting up the display mode (spectrum, spectrographic,
topographic) and the split screen modes.

Adjusting the LCD Brightness

Description The LCD brightness levels can be adjusted to
three pre-set levels.

Operation 1. Press > LCD Brightness[F2] to toggle the
display brightness:
Hi: High brightness
Mid: Medium brightness
Lo: Low brightness

Turning the LCD Backlight Off

Description The LCD backlight can be turned off to
preserve power or to prolong the lifetime of the
LCD display when not in use.

Operation 1. Press > LCD Backlight[F3] and turn the
LCD backlight off.

2. When the backlight is off, press any function
key to turn the LCD backlight back on.
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Setting a Display Line (Reference Level Line)

Description The Display Line function is used to super-
impose a reference level line over the traces.

Operation 1. Press > Display Line[F4] to turn the
display line on.

2. Set the display line level and unit.

Examp|e' 2327.01  2014-07-06

A1t 37.0048

Display line

tart 5.000MHz 10.000MHz P 15 000MHz
OkHz BV :300Hz pan: 10.000MHz 3

DisplayLine'- 23.00 dBm

Display line set at -50dBm

Using the Video Out Port

Description The GSP-9300B has a dedicated DVI terminal to
output the display to an external monitor. The
video output is always on.

Output resolution 800 x 600 (fixed)

Operation 1. Connect an external monitor to the rear panel
DVI terminal.

DVI-1

00000000 ogo
00000000 S
© 0oooooog i ©
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Setting the Display Mode

Description The GSP-9300B has three different display
modes for viewing: spectrum, spectrograph and
topographic. It is also possible to view the
spectrum with the spectrographic or
topographic views using a split screen.

Spectrum Default display mode.

Spectrogram Useful for viewing
frequency or power in
the time domain.

Topographic Useful for observing the
frequency of events with
a trace.

Operation 1. Press (o= )>Window Setup[F1] and select the

display mode:

Spectrum/[FI]:

Spectrogram(F3J:

Topographic[F4]:

Spectrogram+Spectrum/(F5]:
Topographic+SpectrumfFé6]:

& The same trace is used on the top and bottom for
Note the Spectrogram+Spectrum and
Topographic+Spectrum modes.

1
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Example:
Spectrogram

The Spectrogram view shows signals in both
the frequency and time domain. The X-axis
represents frequency, the Y-axis represents time
and the color of each point represents the
amplitude at a particular frequency & time
(Red = high >dark blue = low).

Each new trace is shown at the bottom of the
display and older traces are pushed up toward
the top of the display until they are removed

112
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13:42:19  2014-05 ILXT] Display

Topographic

0.00dBm At 10.048 Topagr

tart 79, 100MHz ter 79.595MHz top 80 090MHz
W 10kHz W 10kHz pan 990.000kHz v 63 2ms

The topographic view shows the frequency of
events. The topographic view is useful for
observing smaller signals that have been
overpowered by stronger signals or to easily
observe intermittent events. Color is used to
represent the frequency of an event. Red
represents a high frequency of occurrence,
while blue represents events that occur rarely.

04.04.55 2014-03-24

Spectrogram
+Spectrum

10dB/
20.00dBm_Att 10.0dB

1.000GHz top 1.000GHz
pan 100, 000kHz p9.83ms

©

Displays both spectrographic and spectrum
views of the signal.
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13:44.00 2014-05-28

Topographic
+Spectrum

tart 79 100MHz ter 79.595MHz top 80.090MHz
BW 10kHz W 10kHz in 990.000kHz ep 63.2m:

Displays both topographic and spectrum views
of the signal.

Spectrogram and Topographic Markers

Description The Spectrogram and Topographic display
view can also use markers and delta markers to
mark the frequency and amplitude of points of
interest. This function is particularly useful as it
allows you to make delta measurements both in
the frequency and time domain.
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Operation 1. When in the Topographic view (single or split
screen), press Topographic Marker and turn on.

2. When in the Spectrographic view (single or
split screen), press Spectrogram Marker and turn
on.

3. To set the reference marker, press Ref.[F2]>X
Axis[F1] and set x-axis position (frequency).

4. Press Y Axis[F2] and the set the y-axis position
(amplitude).

*The frequency and amplitude information will be
displayed on the remaining function keys:

Frequency[F3] Marker frequency
Amplitude[F4] Marker Amplitude.
Time[F4] Time relative to the start

of the sweep.

5. To set the delta marker, press Return[F7]
>Delta[F3]>X Axis[F1] and set the x-axis
position of the delta marker (frequency).

6. Press Y Axis[F2] to set the y-axis position of the
delta marker (amplitude).

*The frequency and amplitude delta will be
displayed on the remaining function keys:

Afrequency[F3] Position of the delta
marker.
AAmplitudefF4] Amplitude of the delta
marker.
ATime[F4] Time delta
VA Time[F5] Frequency delta
115
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Example

Reference Marker

Ref. marker and Delta marker
positions/measurements

Spectrogram view is shown as an example.

Split Spectrum View

Description The split spectrum view is able to view two
different sweep ranges on the display at the
same time using a split screen view. The top
and bottom view can have independent sweep
ranges, amplitudes, spans and other settings.
However only one split screen (top or bottom)
can be swept each time.

Operation 1. Press (o )>Window Setup[F1]>Split
Spectrum[F2]>Active Win[F1] to activate the
upper split screen.

2. Pressing Active Win.[F1] will toggle the sweep
between the upper and lower screen.

3. Press Alternate Sweep[F2] for the analyzer to
alternate the sweep between the upper and
lower screen at the end of each sweep.
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& No operations can be performed in alternate
Note sweep mode.

After exiting the split spectrum view, the analyzer
will use the settings from the active window. The
settings for the inactive screen will be retained for
the next time that split spectrum view is used.

234430  2014.07-06

Example:

A1t 10.048
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System Settings

System Information

Description The System Information displays the following:
Serial Number Installed Options
Version: Calibration Date:
Software LOI
Firmware RF
File sys TG
RF DNS Hostname
TG MAC Address
DSP LX| Password
Wordlist
Core
Operation . Press >System Information[F1] to bring up

Error Messages

a list of the system information.

Description

You can view error messages that are in the
error queue by message number, description
and time. All errors from the system error
queue are logged when operating the analyzer.
For a list of the error messages, please see the
programming manual.

Operation

118

. Press (3%n)>Error message[F2] to bring up the

error message table.

. Press Prev Page[F2] and Next Page[F3] to

navigate through each page of the error list.

. Press Clear Error Queue[F6] to clear the error
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messages from the list.

Set the System Language

Description The GSP-9300B supports a number of
languages. The system language sets the soft
menu keys to the selected language.

Operation 1. Press >Lunguuge[F3] and choose the
system language.

Set the Date and Time

Operation 1. Press (3==n)>Date/Time[F4].

2. Press Set Date[F1] to set the date:

YearfFi] Sets the year.
Month[FZ] Sets the month.
Day[F3] Sets the day.

3. Press Set Time[F2] to set the system time:

Hour[FT] Sets the hour (24hr).
Minute[F2] Sets the minute.
Second[F3] Sets the second.

4. The system time and date will be shown at the
top of the display.
Time, Date

00.04.50  2014-03-01
370040
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Display the Date and Time on the Screen

Description Enables or disables the date and time on the
screen.
Operation 1. Press (5==n)>Date/Time[F4]>Clock[F4] and turn

the clock display on or off.

Using the Wake-Up Clock

Description The GSP-9300B has a wake-up clock to allow
the spectrum analyzer to automatically turn on
at a set time.

Operation 1. Press >Date/T ime[F4]>Wake-Up Clock[F3]
and set the following parameters:
Select ClockfF1] Choose a wake-up clock
(1~7).
State[F2] Turns the selected clock
on/ off.
Hour[F3] Set the wake-up hour
Minute[F4] Set the wake-up minute.
Repeat Single[F5] Set the wake-up clock to
repeat or single.
& Only single days can be configured for the wake-up
Note clock.
120
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Alarm Output

Description Allows the pass/fail output to be output via the
ALARM OUT port.

Output: Open collector
+V

B
Alarm Out

BNC

Vo

1o

Operation 1. Press >Alarm Output[F6] and toggle the
ALARM OUT port on or off.
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Preset

The Preset function loads either factory default states or the user-
defined states - depending on the Preset configuration settings.

+Using the Preset Key — from page 122
*Save the User Preset Settings— from page 122
*Preset Type Settings— from page 123

*Power on Preset Settings — from page 123

Using the Preset Key

Description The key loads the factory default state or
user-defined preset settings. See the Preset
Type Settings on page 122 to set the type of
preset settings that are loaded.

Factory Preset The factory default settings are listed on page
241.
Operation Press to load the preset settings.

Save the User Preset Settings

Description The user-defined preset settings can be created
by saving the current state as the user-defined
preset settings.

Operation Press >Pwr On/Preset[F5]>Save User
Preset[F3] to save the current state as the User
Preset settings.
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Preset Type Settings

Description Each time the key is pressed, a set of
preset configuration settings are loaded. The
preset configuration settings can be either the
factory default settings or the user-defined
settings.

Operation 1. Press >Pwr Ony/Preset[F5]>Preset Type[2]
and choose the preset type:

User Preset(F1]
Factory Preset(FZ]

Power on Preset Settings

Description When the spectrum analyzer is turned on,
either the preset configuration settings are
loaded (default) or the configuration settings
that were used before the instrument was
turned off.

Operation 1. Press >Pwr On/Preset[F5]>Power On[F1]
and choose the power on settings:

Power On: Last, Preset

& See Preset Type Settings on page 241 for details on
Note the preset conditions.

The last preset conditions cannot be loaded if the
instrument was not powered down correctly the
last time it was used. Please see page 29 for
details.
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AM/EM ADALTSIS corvvrvrieeereirerineieiseseseise e ssseise e ssseise e sssesss s ssesese e sasens

AM Analysis ..c.coceeveeercrnncnnne
AM Pass Fail Testing
FM Analysis.....ccccoocveuverrennee
FM Pass Fail TeStNG......coceuiuriiiriiicieirciii e
AM/TM DemMOAUIAtION evuveveeeeeeeeeeeeeeeeeeeeeee et eeeeeeeeeeeeeeeeereeeseeeeeens
Phase Jitter Measurement
Spectrum Emission Mask OVErvIeW........oviviniciiiiiniiiiiniceeccscsieinnns
Spectrum Emission Mask TeStNZ ...
Third Order Intermodulation Distortion (TOI
CNR/CSO/CTB Measurement .......eeeeeeeeeeenenen.
Carrier to Noise Ratio (CNR)
Composite Second Order (CSO)....oiininiiniieiiieeceeians
Composite Triple Beat (CTB)
Harmonic Measurements.........cceeeeveeeeee
N dB Bandwidth......cccoiiiiiiiiiiccicicc s
P1dB MEaSULemMEnL....uu vt ssss s s ssssssssesssees
P1dB NormaliZation ... sssssssssssees

Limit Line Testing ....cc.coveuviiiiiiiiiiiiniiiiiininniecia
Creating a Limit (Point by PoOint) ...
Creating a Limit (from Trace Data) .
Creating a Limit (from marker data) ..o, 187
Delete Limit LiN€.....ocucueieeecieeicicieeece s 188
Pass Fail TeStNG ....cvivviviiiiiici s 189

SEQUENCE ...ttt 191
Editing @ SEqUENCE ......cuiuiiciiiciciciiie s 191
Running a SEqUENCE ... 195
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Tracking Generator.......ccooeeviviniiiiiiiiiiiniiiiiiinciii e,
Activate Tracking Generator..........ccccccuucnee .
Normalize the Tracking Generator

Power Meter ..., 200
Activating Power Meter Mode......oviiiniciienes 200
Data Logging Power Meter Measurements .......cceeeeeieueiceeienenenns 202
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Measurement

This section describes how to use the automatic measurement
modes. The GSP-9300B includes the following measurements:

*ACPR — from page 128

*OCBW — from page 130

*AM Analysis— from page 133

*FM Analysis — from page 139

*AM/FM Demodulation — from page 144
*Phase Jitter— page 145

*SEM measurement — from page 147

*TOI measurement — from page 165
+*CNR/CSO/CTB measurement — from page 167
*Harmonic Measurement — from page 174
*N dB measurement — from page 176

*P1dB Measurement — from page 178

Channel Analysis Overview

Description Channel analysis measurement includes ACPR
(adjacent channel power) and OCBW (occupied
bandwidth) measurements.

Parameters Channel bandwidth The frequency
bandwidth the target
channel occupies.
Range:

Between 0Hz~3GHz
(OHz excepted)
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Channel Space

Adjacent channel
bandwidth 1 & 2

Adjacent channel offset

1~3

OCBW%

839145

The frequency distance
between each main
channel.

Range:

Between 0Hz~3GHz

The frequency
bandwidth the adjacent
channels occupy.
Range:

Between 0Hz~3GHz
(OHz excepted)

The frequency distance
between the adjacent
channels and main
channel.

Range: 1

Between 0Hz~3GHz
(OHz excepted)

The ratio of occupied
bandwidth to the
amount of power
consumed.

Range: 0% to 100%, 0.1%
resolution.
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ACPR

Description

Adjacent channel power refers to the amount of
power leaked to the adjacent channel from the
main channel. This measurement is a ratio of
the main channel power to power in the
adjacent channel.

Example

AD) ADJ AD)
CH3 CH2 CH1

AD) AD] AD]
CH1 CH2 CH3

Offset 1 k— i
Offset 2k————
Offset 3
Channel spacing

To next main
channel

Operation:
Setting up the
main channel

128

1. Press > Channel Analysis[F1]>ACPR[F2]

and turn ACPR on.

*Any other measurement mode will automatically be
disabled.

2.

The display splits into two screens. The top
screen shows the main channel, adjacent
channels and their corresponding limits. The
bottom screen shows the ACPR measurement
results in real time.
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Main CH

ADJCH1
ADJCH2
ADJCH3

i
jasm

22qps  2||4-03-07
20 0 Ja

Channel power
results

3. Press > Channel Analysis[F1]>ACPR
Setup[F1]> and set the following:

Main CHBW[FI1] Set the bandwidth of the
main channel.

Main CH H LimitfF2]  Set the low limit for the
main channel.

Main CH Limit[F3] Set the high limit for the
main channel

CH SPC[F4] Specify the channel
spacing
Operation: 1. Press ADJCH Setup[F5] to setup the adjacent
Setting up the channels:
adjacent
channel(s) Select AdjCh[FT] Choose an adjacent
channel number: 1, 2, 3
[F2] Toggle the selected
channel on/ off.
ADJCHBW/[F3] Choose the bandwidth of

the selected channel.
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ADJCH OffsetfF4] Set the adjacent channel

offset.

ADJCH HLimit{F5] Set the adjacent channel
high limit.

ADJCH LLimit{F5] Set the adjacent channel
low limit.

Repeat the above steps for the other adjacent
channels, if needed.

Move Channels
Up/Down

1.

Press > Channel Analysis[F1] and press

the following to move to another channel:

Channel Move Up[F5] Next main channel.
Channel Move Previous main channel.
Down[F6]

A Note

The channel space (CH SPC) parameter
determines where the next main channel is
located.

Remove
Definitions Help

1.

Press > Channel Analysis[F1]>ACPR
Setup[F1]>Def. Help to toggle the Definitions
Help on or off.

OCBW

Description Occupied bandwidth measurements are used to
measure the power of the occupied channel as a
percentage to the power of the channel.

130
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Example
\QCBW
i 1:VAN
Operation: 1. Press > Channel Analysis[F1]>OCBW][F4]
SetFing up the and turn OCBW on.
main channel *Any other measurement mode will automatically be

disabled.

2. The display splits into two screens. The top
shows the channel bandwidth. The bottom
screen shows the OCBW measurement results
in real time.

CH BW

015949 2| }4-03-08

76 000MHz
REW 1 0kHz

Channel power and total
power results
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3. Press OCBW Setup[F3] to enter the OCBW

setup:

CHBWJFI1] Set the channel
bandwidth.

CH SPCIFZ] Set the channel space
between main channels.

OCBW%[F3] Set the % of the OCBW
to CHBW.

Move Channels 1. Press (M )> Channel Analysis[F1] and select:

Up/Down

Channel Move Up[F5] Next main channel.
Channel Move Previous main channel.
Down(F6]

A Note

132

The channel space (CH SPC) parameter
determines where the next main channel is
located.

The CH SPC parameters from the ACPR and
OCBW setups are independent.
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AM/FM Analysis

AM Analysis

Description When amplitude modulation is turned on, the
input signal is centered on the center frequency
and the span is automatically set to zero-span.

Measurement AM Depth: Current, Min, Cent, Max

items Mod. Rate: Current, Min, Cent, Max
Carrier Pwr: Current, Min, Cent, Max
Carrier Freq Offset: Current, Min, Cent, Max
SINAD: Current, Min, Cent, Max

Operation: 1. Set the center frequency to the carrier frequency

configuration (page 41).

2. Press > Demod[F2]>AM Analysis[F1]>AM
Analysis[F1] and turn AM analysis on.
*Any other measurement mode will automatically be
disabled.

3. The display splits into two screens. The top
shows the AM waveform in the time domain.
The bottom screen shows the AM
measurement.
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AM waveform

Wer 315 000MHZ

AM modulation
measurements

4. Press Setup[F2]>IF Bandwidth[F1] and set the
Intermediate frequency bandwidth.
+Set with adequate bandwidth to accommodate
spectrum contained in the carrier.

5. Press LPF[F2] to set the low pass filter
frequency, alternatively the frequency can be
set to bypass:

AM Signal Frequency (Hz)

Selectable bandwidth of LPF (Hz)
>78,125 156,250 78,125 52,083 39,063 31,250
>39,063 78,125 39,063 26,042 19,531 15,625
>19,53139,063 19,531 13,021 9,766 7,813
>7,813 15,625 7,813 5208 3,906 3,125
>3906 7,813 3,906 2,604 1,953 1,563
>1,953 3,906 1,953 1,302 977 781
>781 1,563 781 521 391 313
>391 781 391 260 195 156
>195 391 195 130 98 78
>78 156 78 52 39 31
>39 78 39 26 20 16
>20 39 20 13 10 8

>8 16 8 5 4 3

134
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6. Press Time Axis [F3] to set horizontal axis

parameters:

Ref Value[F1] Sets the starting time on
the time axis.

Ref. Pos[F2] Shifts the waveform X
number of grid
subdivisions.

Scale/DivfF3] Sets the grid division
scale when Auto Scale is
Off.

Auto Scale[F4] Toggles auto-scaling
on/ off.

7. Press Depth Axis[F4] to set depth (vertical)
parameters:

Ref Value[F1] Offsets the reference

position as a percentage
of the vertical scale/div.
Ref. Pos[F2] Sets the reference
position of the waveform
on a vertical grid
subdivision (1:10).

Scale/Div[F3] Sets the vertical grid
division scale when
Auto Scale is Off.

Auto Scale[F4] Toggles auto-scaling
execution.

8. Press Squelch[F6] to set carrier squelch level.
The squelch setting will suppress unwanted
noise of a certain level.
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Operation: 9. Press AF Trigger[F5]>Trigger Setup[F2] to set the
trigger triggering conditions:
configuration
Edge Slope[Fi] Sets the trigger to rising
or falling edge.
Trigger Mode[F2] Sets the triggering mode:

Nor.: Normal trigger
Sgl.: Single trigger
Cont.: Continuously
trigger

Trigger Level[F3] Sets the trigger level as a
percentage of the depth.
(The displayed level will
only remain for a few
moments)

Trigger Delay[F4] Sets the trigger delay
time:
0 to 1ks

10. Press Return[F7] to return to the AF Trigger
menu and to set the remaining trigger options:

FreeRun[Fi] Disables the trigger, this
is the default setting.
Start Time[F3] Sets the start time for the

x-axis for the AM
waveform in the top-half
of the screen.

Stop Time[F4] Sets the stop time for the
x-axis for the AM
waveform in the top-half
of the screen.

Action NowfF5] Turns FreeRun mode off
and uses the user-
defined trigger settings.
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& The MAX and MIN measurements are held until
Note higher or lower values are found. To reset the MAX

and MIN measurements, press >

Demod[F2]>AM Analysis[F1]>Min/Max Reset[F3].

AM Pass Fail Testing

Description The Limit Edit function puts a pass limit on the
AM depth, carrier offset and carrier power.

Measurement AM Depth: 5% ~95%
Range Carr. Offset: 1Hz ~ 400kHz

Carrier Power: -120dBm ~ 30dBm

Operation: 1. Press > Demod[F2]>AM Analysis[F1]>
configuration Limit Edit[F5] and set the limits.

AM Depth[F1] If the measured depth is
above this limit, it will be
judged as Fail.

Carr. Offset{F2] If the measured carrier
offset is above this limit,
it will be judged as Fail.

Carr. PowerfF3] If the measured carrier
power is above this limit,
it will be judged as Fail.

2. Press Pass/Fail Test and turn Pass/Fail on.
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3. The AM Measurement area in the bottom half
of the screen will now include Pass/Fail
indicators for the AM depth, carrier offset and
carrier power.

Pass: @ Fail: ﬁ

102346 2016-01-14

Example

Pass/Fail
judgments
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FM Analysis

Description When frequency modulation is turned on, the
input signal is centered on the carrier frequency
and the span is automatically set to zero-span.

Measurement Freq. Deviation: Current, Min, Cent, Max

items Mod. Rate: Current, Min, Cent, Max
Carrier Pwr: Current, Min, Cent, Max
Carrier Freq Offset: Current, Min, Cent, Max
SINAD: Current, Min, Cent, Max

Operation: 1. Set the center frequency to the carrier frequency

configuration (page 41).

2. Press (M5)> Demod[F2]>FM Analysis[F2]>FM
Analysis[F1] and turn FM analysis on.

*Any other measurement mode will automatically be
disabled.

3. The display splits into two screens. The top
shows the FM waveform in the time domain.
The bottom screen shows the FM measurement.

FM waveform

315 000MHz

FM modulation
measurements

139
839145 010-62176775 www . hyxyyq..com



GYINSTEK

GSP-9300B User Manual

4. Press Setup[F2]>IF Bandwidth[F1] and set the
Intermediate frequency bandwidth. (10kHz,
30kHz, 100kHz, 300kHz, 1IMHz, )

+Set with adequate bandwidth to accommodate

spectrum contained in the carrier.

5. Press LPF[F2] to set the low pass filter
frequency, alternatively the frequency can be

set to bypass:

FM Signal Frequency (Hz)

>78,125 156,250
>39,063 78,125
>19,531 39,063
>7,813 (15,625

>3,906 7,813
>1,953 3,906
>781 1,563
>391 781
>195 391
>78 156
>39 78
>20 39

>8 16

78,125
39,063
19,531
7,813
3,906
1,953
781
391
195

78

39

20

8

Selectable bandwidth of LPF (Hz)

52,083 39,063 31,250
26,042 19,531 15,625
13,021 9,766 7,813
5208 3,906 3,125
2,604 1,953 1,563
1,302 977 781
521 391 313
260 195 156
130 98 78

52 39 31

26 20 16

13 10 8

5 4 3

6. Press Time Axis[F3] to set horizontal axis

parameters:
Ref. Value[F1]

Ref. Pos[F2]

Scale/DivfF3]

140
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Sets the starting time on
the time axis.

Shifts the waveform X
number of grid
subdivisions.

Sets the grid division
scale when Auto Scale is
Off.
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Auto Scale[F4] Toggles auto-scaling
on/ off.

7. Press Deviation Axis[F4] to set deviation
(vertical) parameters:

Ref-Value[F1] Offsets the reference
position (in frequency).
Ref-Pos[FZ] Sets the reference

position of the waveform
on a vertical grid
subdivision (1:10).

Scale/Div[F3] Sets the vertical grid
division scale.
Auto Scale[F4] Toggles auto-scaling
execution.
Operation: 8. Press AF Trigger[F5]>Trigger Setup[F2] to set the
trigger triggering conditions:
configuration Edge Slope[F1]
Sets the trigger to rising
or falling edge.
Trigger Mode[F2] Sets the triggering mode:

Norm.: Normal trigger
Sgl.: Single trigger
Cont.: Continuously
trigger

Trigger Level[F3] Sets the trigger level as a
frequency. (The
displayed level will only
remain for a few
moments)

Trigger Delay[F4] Sets the trigger delay
time:
0 to 1ks

9. Press Return[F7] to return to the AF Trigger
menu and set the remaining triggering options:
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Start Time[F3]

Stop Time[F4]

Action Now[F5]

GSP-9300B User Manual

Disables the trigger, this
is the default setting.
Sets the start time for the
x-axis for the FM
waveform in the top-half
of the screen.

Sets the stop time for the
x-axis for the FM
waveform in the top-half
of the screen.

Turns FreeRun mode off
and uses the user-
defined trigger settings.

A Note

The MAX and MIN measurements are held until
higher or lower values are found. To reset the MAX

and MIN measurements, press >

Demod[F2]>FM Analysis[F1]>Min/Max Reset[F3].

FM Pass Fail Testing

Description The Limit Edit function puts a pass limit on the

FM deviation, carrier offset and carrier power.
Measurement Frequency Deviation:  40Hz ~400kHz, 1Hz
Range measurable

Carr. Offset: 1Hz ~ 400kHz

Carrier Power: -120dBm ~ 30dBm
Operation: . Press > Demod[F2]>FM

configuration

142

Analysis[F2]>Limit Edit[F5] and set the limits.

FM Deviation[F1]

839145

If the measured
deviation is above this
limit, it will be judged as
Fail.
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Carr. Offset{F2] If the measured carrier
offset is above this limit,
it will be judged as Fail.

Carr. PowerfF3] If the measured carrier
power is above this limit,
it will be judged as Fail.

2. Press Pass/Fail Test[F6] and turn Pass/Fail on.

3. The FM Measurement area in the bottom half of
the screen will now include Pass/Fail indicators
for the FM deviaton, carrier offset and carrier
power.

Pass: @' Fail: ﬁ

10:23:34  2016-01-14

Example

5 18KkHz Al 10.008

Pass/Fail
judgments
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AM/FM Demodulation

Description

The GSP-9300B has a convenient AM/FM
demodulation function to tune into AM or FM
broadcast signals and listen to the demodulated
baseband signals using the ear phone out
socket.

Operation:
Setup

. Set the center frequency to the desired FM/AM

carrier frequency. See page 41 for details.

. Set the span to zero. See page 46 for details.
. Set the Preamp to Auto. See page 61.

. Connect an antenna to the RF input.

Connection

Connect headphones or a speaker
to the phone output port.

Operation

144

. Press > Demod[F2]>Sound[F3]>Ear Phone

Out[F1] and turn the ear phone out on.

. Press Volume[F2] to set the volume output:

Volume: 0~15, default 7

. Press Digital Gain Control[F3] to change the

gain:

Gain: 0~18dB, 6dB step

. Press Demod Type[F4] to choose AM or FM

demodulation.

839145 010-62176775
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Phase )itter Measurement

Description Phase Jitter refers to the amount of phase
fluctuation and can be used to evaluate stability
of a signal in the time domain.

Parameters Start Offset: The start frequency with
respect to the center
frequency.

Stop Offset: The stop frequency with
respect to the center
frequency.

Measurement Carrier Power: dBm

items Jitter in phase: rad

Jitter in time: ns

Example

Start Offset>
Stop Offset&———>

Operation: 1. Press > Phase Jitter[F4]>Phase [itter[F1]

Setting up the and turn Phase Jitter on.

main channel *Any other measurement mode will automatically be

disabled.

2. The display splits into two screens. The top
shows the trace with the start and stop offsets.
The bottom screen shows the phase jitter
measurements.
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Start Stop
offset offset

Phase jitter measurements

3. Press Start Offset[F2] to set the start offset:
Offset: (OHz ~ %2 span freq)
4. Press Stop Offset[F3] to set the stop offset:

Offset: (OHz ~ %2 span freq)

A The phase jitter measurements are strongly tied to
Note the RBW and VBW.
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Spectrum Emission Mask Overview

Description SEM measurements are used to measure the
out-of-channel emissions relative to the in-
channel power. SEM measurements are usually
calculated for specified power bands at a
number of different offsets to the carrier
frequency. SEM measurements are often carried
out for a number of different wireless
standards.

For 3GPP, the GSP-9300B supports BS (base
station) and UE (user equipment) testing
standards for both FDD (frequency-division
duplexing) and TDD (time-division duplexing)
modes.

The GSP-9300B also supports SEM testing for
802.11b, 802.11g, 802.11n and 802.16 as well as
user defined emission mask testing

Example e

Relative mask-j:’/_/ I ot TR
Absolute mask Chan Jj I

an

Channel integrated BW
Offset1 — &
Offset 2 - &
Offset 3 — K

Parameters ChanlintegBW: Channel Integration
Bandwidth. The
ChanIntegBW is used to
measure the in-channel
power.
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Chan Span:

Used to define the span of
the main channel when
measuring the channel
power.

RBW:

Sets the resolution
bandwidth for the main
channel when measuring the
in-channel power.

Total Pwr Ref:

The total power of the carrier
that is used as the reference
for calculating the offset
power.

PSD Ref:

The mean power spectral
density of the carrier that is
used as the reference for
calculating the offset power.

Select Offset:

Selects the offset pairs (1 ~ 5)
used for configuration.

Start Freq:

Sets the start frequency offset
for the selected offset
number.

Stop Freq:

Sets the stop frequency offset
for the selected offset
number.

RBW:

Sets the resolution
bandwidth of the selected
offset number.

Abs Start:

Sets the absolute level limit
at the Start Freq for selected
offset number.

Abs Stop:

Sets the absolute level limit
at the Stop Freq for the
selected offset number. The
Abs Stop level limit can be
set to Couple or Man. Man
allows Abs Stop to be user-
defined, while Couple will
lock Abs Stop to the Abs
Start level limit.

839145
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Rel Start:

Sets the relative level limit at
the Start Freq for the selected
offset number.

Rel Stop:

Sets the relative level limit at
the Stop Freq for the selected
offset number. Rel Stop can
be set to Couple or Man.
Man allows Rel Stop to be
user-defined, while Couple
will lock Rel Stop to the Rel
Start level limit.

Fail Mask:

Sets the fail conditions for
measurement with regards to
the level limits: Absolute,
Relative, Absolute &
Relative, Absolute or
Relative.

Main Channel
Bandwidth:

Measurement
items

Unit: Hz

Total Power:

Unit: dBm

PSD (Power
Spectral Density):

Unit: dBm/Hz

Offset 1~5:

Lower dBm, Upper dBm

3GPP Operating Bands*

Operating UL Frequencies

DL Frequencies

Band UE transmit, Node B receive  UE receive, Node B transmit

| 1920~1980MHz 2110~2170MHz

I 1850~1910MHz 1930~1990 MHz

I 1710~1785MHz 1805~1880MHz

v 1710~1755MHz 2110~2155MHz

\ 824~-849MHz 869~894MHz

Vi 830~840MHz 875~885MHz

VII 2500~2570MHz 2620~2690MHz

VI 880~915MHz 925~960MHz
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Xl
\Y%
XV
XVI
XVII
XVIII
XIX
XX
XXI
XXV

GSP-9300B User Manual

1749.9~1784.9MHz
1710~1770MHz
1427.9~1452.9MHz
698~716MHz
777~787MHz
788~796MHz
Reserved

Reserved

Reserved

Reserved
830~845MHz
832~862MHz
1447.9~1462.9MHz
1850~1915MHz

1844.9~1879.9MHz
2110~2170MHz
1475.9~1500.9MHz
728~746MHz
746~756MHz
758~768MHz
Reserved

Reserved

Reserved

Reserved
875~890MHz
791~821TMHz
1495.9~1510.9MHz
1930~1995MHz

*for FDD, referenced from ETSI:

3GPP TS 25.101 version 10.2.0 Release 10
3GPP TS 25.104 version 10.2.0 Release 10
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3GPP-FDD BS

For the FDD configuration, different limits can by
chosen based on the total channel power, P.

The default value for Afmax is 12.5MHz. Afmax can be

user-defined.

The channel span is set to 5SMHz.

Note: A, B, C, D, E denote offsets 1 to 5, respectively.

Unit: MHz Absl] RBW
P>43

2.5 <A<2.7 -14dBm 30kHz

2.7<B<3.5 -14 ~ -26dBm 30kHz

3.5<C<Afmax -13dBm 1MHz

Unit: MHz Absl1] RBW
39<pP<43

2.5 <A<2.7 -15dBm 30kHz

2.7<B<3.5 -14 ~ -26dBm 30kHz

3.5<C<7.5 -13dBm TMHz

7.5<D<Afmax P-56dB TMHz

Unit: MHz Absl] RBW
31<P<39

2.5 <A<2.7 P-53dB 30kHz

2.7<B<3.5 P-53dB~ 30kHz

P-56dB

3.5<C<7.5 P-52dB TMHz

7.5<D<Afmax P-56dB 1MHz

Unit: MHz Absl] RBW
P<31

2.5 <A<2.7 -22dBm 30kHz

2.7<B<3.5 -22 ~-34dBm 30kHz

3.5<C<7.5 -21dBM TMHz

7.5<D<Afmax -25dBm TMHz
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For P<31, two additional power limits (shown below)
can be selected via the Additional Max Out. Pwr
option for Home BS applications:

(The default value for Afmax is 14.5 MHz. Afmax can
be user-defined)

Unit: MHz Absll RBW
6<P<20

12.5 <E< Afmax P- 56dB 1TMHz

Unit: MHz Absll RBW
P<6

12.5 <E< Afmax -50dBm 1TMHz

3GPP-FDD BS
Additional
Requirements

For operation in bands 11, IV, V, X, XII, XIIl, XIV and
XXV, additional requirements (listed below) apply in
addition to the minimum requirements listed above.

Unit: MHz Additionall! RBW
Bands:

3.5<B<Afmax -13dBm TMHz

Unit: MHz Additionall! RBW
Bands: V

2.5 <A<3.5 -15dBm 30kHz

3.5<B<Afmax -13dBm 100kHz

Unit: MHz AdditionalPl RBW
Bands:

3.5<B<Afmax -13dBm 100kHz

3GPP-FDD UE

152

The channel span is set to 5SMHz.

Note: A, B, C, D, E denote offsets 1 to 5, respectively.

Rel Absl RBW
Unit: MHz
2.5<A<3.5 -35~-50dBc -71.1dBm 30kHz
3.5<B<7.5 -35~-39dBc -55.8dBm TMHz
7.5<C<8.5 -39~-49dBc -55.8dBm TMHz
8.5 <D<12.5 -49~-49dBc -55.8dBm TMHz
839145 010-62176775
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3GPP-FDD UE
Additional
Requirements

Additional requirements for 3GPP-FDD UE.

Unit: MHz AdditionalPl RBW
Bands

3.5<B<12.5 -15dBm 1MHz

Unit: MHz AdditionalPl RBW
Band V

2.5 <A<3.5 -15dBm 30kHz

3.5<B<12.5 -13dBm 100kHz

Unit: MHz Additional! RBW
Bands

3.5<B<12.5 -13dBm 100kHz

3GPP-TDD BS
3.84Mcps*

For the TDD configuration, different limits can by
chosen based on the total channel power,

The channel span:
3.84Mcps: 5MHz.

Note: A, B, C, D, E denote offsets 1 to 5, respectively.

Unit: MHz Absl] RBW
pP>43

2.5 <A<2.7 -14dBm 30kHz

2.7<B<3.5 -14 ~-26dBm 30kHz

3.5<C<12 -13dBm 1MHz

Unit: MHz Absl] RBW
39<P<43

2.5 <A<2.7 -14dBm 30kHz

2.7<B<3.5 -14 ~-26dBm 30kHz

3.5<C<7.5 -13dBm 1MHz

7.5<D<12 P-56dB TMHz
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Unit: MHz Absll RBW
31<P<39
2.5 <A<2.7 P-53dBm 30kHz
2.7<B<3.5 P-53~P-65dBm 30kHz
3.5<C<7.5 P-52dBm TMHz
7.5<C<12 P-56dBm TMHz
Unit: MHz Absl] RBW
P<31
2.5 <A<2.7 -22dBm 30kHz
2.7<B<3.5 -22 ~-34dBm 30kHz
3.5<C<7.5 -21dBm TMHz
7.5<D<12 -25dBm TMHz
*referenced from ETSI:
3GPP TS 25.102 version 10.2.0 Release 10
3GPP TS 25.105 version 10.3.0 Release 10
3GPP-TDD BS  The channel span:
1.28Mcps 1.28Mcps: 1.6MHz.
Unit: MHz Absll RBW
P>34
0.8 <A<1 -20dBm 30kHz
1<B<1.8 -20 ~-28dBm 30kHz
1.8<C<3.5 -13dBm TMHz
Unit: MHz Absl RBW
26<P<34
0.8 <A<1 P-54dB 30kHz
1<B<1.8 P-54~P-62dB  30kHz
1.8<C<3.5 P-47dB TMHz
Unit: MHz Absl RBW
P<26
0.8 <A<1 -28dBm 30kHz
1<B<1.8 -28~-36dBm  30kHz
1.8<C<3.5 -21dBm TMHz
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3GPP-TDD BS  The channel span:
7.68 Mcps 7.68Mcps: TOMHz.
Unit: MHz Absll] RBW
pP>43
5<A<5.2 -17dBm 30kHz
5.2<B<6 -17 ~-29dBm 30kHz
6<C<24.5 -16dBm TMHz
Unit: MHz Absl'] RBW
39<P<43
5<A<5.2 -17dBm 30kHz
5.2<B<6 -17 ~-29dBm 30kHz
6<C<15 -16dBm TMHz
15<D<24.5 P-59dB TMHz
Unit: MHz Absl] RBW
31<P<39
5<A<5.2 P-56dB 30kHz
5.2<B<6 P-56~P-68dB  30kHz
6<C<15 P-55dB TMHz
15<D<24.5 P-59dB TMHz
Unit: MHz Absl] RBW
P<31
5<A<5.2 -25dBm 30kHz
5.2<B<6 -25~-37dBm  30kHz
6<C<15 -24dBm TMHz
15<D<24.5 -28dBm TMHz
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3GPP-TDD UE  The channel span:

3.84Mcps: 5SMHz.

1.28Mcps: 1.6MHz.

7.68Mcps: T0OMHz.

Note: A, B, C, D, E denote offsets 1 to 5, respectively.
Unit: MHz Rell? RBW

3.84Mcps
2.5<A<3.5 -35~-50dBc 30kHz
3.5<B<7.5 -35~-39dBc  TMHz
7.5<C<8.5 -39~-49dBc  1MHz
8.5<D<12.5 -49dBc TMHz
Unit: MHz Rell? RBW

1.28Mcps
0.8 <A<1.8 -35~-49dBc 30kHz
1.8<B<2.4 -49~-59.2dBc  30kHz
2.4<C<4 -44dBc TMHz
Unit: MHz Rell? RBW

7.68Mcps
5 <A<5.75 -38~-46dBc 30kHz
5.75<B<7 -46 ~ -53dBc  30kHz
7<C<15 -38~-42dBc 1MHz
15<D<17 -42~-52dBc TMHz
17<E<25 -53dBc 1MHz

802.11b* The channel span: 22MHz

Note: A, B denotes offsets 1 and offset 2.
Here the default value of “f” is 24MHz. This can be

user-defined.

Unit: MHz Rell RBW
11<A<22 -30dBc 100kHz
22<B<f -50dBc 100kHz

*reference: |IEEE Std 802.11b-1999
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802.11¢g The channel span:
ERP-OFDM/DSSS-OFDM : 18MHz
ERP-DSSS/ERP-PBCC/ERP-CCK: 22MHz

Note: A, B, C, D denote offsets 1 to 4, respectively.
Here the default value of “f” is 40MHz (ERP-OFDM/
DSSS-OFDM) or 25MHz (ERP-DSSS/ ERP-PBCC/
ERP-CCK). This can be user-defined.

Unit: MHz Rell?] RBW
ERP-OFDM/
DSSS' 9 SA<‘| -l 'O~'20d BC 100kHZ
OFDM 11<B<20 -20~-28dBc 100kHz
20<C<30 -28~-40dBc 100kHz
30<D<f -40dBc 100kHz
Unit: MHz RellZ RBW
ERP-DSSS/
ERP-CCK 22<B<f -50dBc 100kHz

*reference: |IEEE Std 802.11a-1999

802.11n The channel span:
CH BW 20MHz: 18MHz
CH BW 40MHz: 38MHz

Note: A, B, C, D denote offsets 1 to 4, respectively.
Here the default value of “f” is 40MHz(CHBW
20MHz) or 70MHz(CHBW 40MHz). This can be user-

defined.
Unit: MHz Rell RBW

CH BW

20M Hz 9 SA<‘| 1 'O~'20d BC '|00kHZ
11<B<20 -20~-28dBc 100kHz
20<C<30 -28~-45dBc 100kHz
30<D«<f -45dBc 100kHz
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Unit: MHz Rell? RBW
CH BW

21<B<40 -20~-28dBc 100kHz

40<C<60 -28~-45dBc 100kHz

60<D<f -45dBc 100kHz

*reference: IEEE Std 802.1n-2009

802.16* The channel span:
CH BW 20MHz: T9MHz
CH BW 10MHz: 9.5MHz

Note: A, B, C, D denote offsets 1 to 4, respectively.
Here the default value of “f” is 16.75MHz(CHBW
20MHz) or 31.5MHz(CHBW 10MHz). This can be

user-defined.

Unit: MHz Rell RBW
CH BW
10.9<B<19.5 -25~-32dBc 100kHz
19.5<C<29.5 -32~-50dBc 100kHz
29.5<D<f -50dBc 100kHz
Unit: MHz Rell RBW
CH BW
JOMHz ~ 475SA<5.45 0--25dBc  100kHz
5.45<B<9.75 -25~-32dBc 100kHz
9.75<C<14.75 -32~-50dBc 100kHz
14.75<D<f -50dBc 100kHz
*reference: IEEE Std 802.16-2009
A 1 Abs: Absolute limit
Note

2] Rel: Relative limit(to the total power or the

power spectral density, depending on the

compliance of the main channel)
B3] Additional: Additional absolute limit

Pass Fail Criteria:

Case 1: When both Abs and Rel are used, the
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highest value (Abs or Rel) is used as the
Pass/Fail judgment. The trace points under
the limit indicate a pass.

Case2: If the additional limit is used, the
higher value from casel is compared to the
additional limit. The lowest one is used as the
pass/fail judgment.

Spectrum Emission Mask Testing

Description For spectrum emission mask testing, the GSP-
9300B has pre-defined testing parameters for
3GPP, 802.11x and 802.16. The GSP-9300B also
allows you to perform user-defined SEM
testing.

Operation: 1. Press (M )> SEM[F5]>SEM[F2] and turn SEM
on.

*Any other measurement mode will automatically be
disabled.

2. The display splits into two screens. The top
shows the trace with the absolute and or
relative masks. The bottom screen shows the
SEM measurement results.
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Absolute
limit line

Froq Offsetis 0 now!

SEM measurements

User Defined 1. Press Setup[F1]>User Define[F6]to set SEM
Parameters measurement to user defined parameters.

2. Press Meas Type[F1] choose between
TotalPwrRef[F1] or PSDRef[F2].

3. Press Ref. Channel[F2] and set the following;:

ChanlintegBW[FI1] Sets the channel

integration bandwidth.
Chan Span[F2] Sets the channel span
RBWJF3] Sets the resolution
bandwidth.
TotalPwrRef]F4]/ Sets the total
PSDRef]F4] power/PSD reference
level.

4. Press Return[F7] to return to the previous
menu.
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5. Press Offset/Limit[F3] to set the offset

parameters:
SelectOffsetfF1]
[F2]
Startfreg[F3]
StopFreqg[F4]

RBWJFS5]

Select which offset to
edit.

Toggles the selected
offset on/ off.

Sets the start frequency
of the selected offset.
Sets the Stop Frequency
of the selected offset.
Sets the RBW of the
selected offset.

6. Press More 1/2[F6] to set absolute and relative
level limits and conditions:

Abs StartfF2]

Abs Stop[F3]

Rel Start{F4]

839145

Sets the absolute start
level limit for the
selected offset.

Sets the absolute stop
level limit for the
selected offset.

Man: Allows a user-
defined Abs Stop level
Couple: Sets the Abs
Stop level to the Abs
Start level.

Sets the relative start
level limit for the
selected offset.
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Rel Stop[F5] Sets the relative stop
level for the selected
offset.

Man: Allows a user-
defined Abs Stop level.
Couple: Sets the Rel Stop
level to the Rel Start
level.

. Press Fail Mask[F6] to set the Fail Mask

conditions:

Absolute[FT] Sets the fail condition to
the Absolute level limit.

Relative[F2] Sets the fail condition to
the relative level limit.

Abs AND Rel[F3] Sets the fail condition as
both the absolute and
relative level limits.

Abs OR Rel[F4] Sets the fail condition to

either the absolute or
relative level limits.

. Press Select Offset[F1] and repeat the above

steps for any other offsets.

Offset: 1~5

Pre-Set Test
Parameters:
3GPP

162

For details on 3GPP SEM test parameters,
please see the SEM overview on page 147.

. Press Setup[F1]>3GPP[F1] to choose 3GPP

measurement.

. Press Ref. Channel[F2] and set the following:

RBWJF3] Sets the resolution
bandwidth.

. All other reference channel settings are pre-
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defined.

4. Press Return[F7] to return the previous menu.

5. Press Offset/Limit[F3]>Duplexing Mode[F1] and
choose FDD or TDD duplexing;:

6. For FDD, press FDD Setup[F2] set the FDD
parameters, for TDD, press TDD Setup[F3]:

Transmission{FT]

Chip Rate[F2]

Max Out Pwr[F2/F3]

Add.limits[F4]

839145

Toggles between BS and
UE testing

Selects the bandwidth of
the RRC filter that is
used to measure the in-
channel power for TDD
duplexing:

3.84MHz, 1.28MHz,
7.68MHz

Sets the maximum
output power for BS
tests:

P>=43

39<=P<=43

31<=P<=39

P<31

Selects the operating
bands for FDD
duplexing:

None

BandlII

BandIV

BandV

BandX

BandX11

BandXIII

BandXIV
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MinOffset/ Allows you to view the

Limit Value[F5] parameters of each of the
offsets, including
start/stop frequency,
RBW, Abs Start/Stop
and Rel Start/Stop.

Pre-Set Test
Parameters:
802.XX

164

For details on 802.11x and 802.16 SEM test
parameters, please see the SEM overview on
page 147

. Press Setup[F1]>and choose a 802.XX test:

802.11b[F2]
802.11g[F3]
802.11n[F4]
802.16[F5]

. Press Ref. Channel[F2] to view the predefined

settings for channel integrated bandwidth,
channel span, RBW and PSD ref.

. Press Offset/Limit[F3] to view the parameter

values of each of the offsets, including Start and
Stop Frequency, RBW, Rel Start and Stop
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Third Order Intermodulation Distortion (TOI)

Description Third order intermodulation distortion
measurement is used to calculate the TOI
products caused by two signals that are close
together in frequency in a non-linear system.
Both the upper and lower third order intercept
points (IP3) are calculated. Markers are placed
at the frequencies of the TOI products and their
respective base signals.

Limits can be placed on the upper and lower
TOI products for limit testing.

Parameters Reference Lower  Sets the reference level to
lowest base signal
Reference Upper  Set the reference level to the

highest base signal
Limit Sets the limit in dBm for
pass/fail testing
Pass/Fail Test Enables/disables pass/fail
testing.
Measurement Base Upper Frequency, dBm, dBc
items Base Lower Frequency, dBm, dBc

3rd Order Lower  Frequency, dBm, dBc, limit,
Intercept point

3rd Order Upper  Frequency, dBm, dBc, limit,
Intercept point

Of Frequency
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Example Af,

Limit 5 ,V‘ .

34 Order Upper |
Base Lower i
Base Upper
3" Order Lower

Operation: 1. Press (M )> TOI[F6]>TOI[F1] and turn TOI
on.

*Any other measurement mode will automatically be
disabled.

2. The display splits into two screens. The top
shows the trace with markers in the upper and
lower base frequencies and the upper and
lower 3td order intermodulation products. The
bottom screen shows the TOI measurements
and pass/fail results.

34 Order Lowerand 3™ Order
lower upper base upper
marker marker

-4s

TOI measurement and results
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3. Press Reference[F2] to set the reference to the
upper or lower base frequencies.

The (B icon will be displayed next to the

selected upper or lower reference.

4. Press Limit[F3] and set the limit for the upper
and lower 3t order intermodulation product
amplitude.

5. Press Pass/Fail Test[F4] to toggle pass/fail
testing on/ off.

The & pass or € fail icon will be displayed
depending on the limit set above.

CNR/CSO/CTB Measurement

Carrier to Noise Ratio (CNR)

Description Carrier to noise ratio calculates the difference in
amplitude between the carrier signal and the
noise level present in the transmission. CNR
measurements are used for both analog and

digital CATV.

Parameters Noise Marking Sets the position of the delta
marker (A1) using two
options:

MIN:

The delta marker will search
for the minimum between
the carrier frequency and the
carrier frequency + 4MHz.
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AMarker:
User defined delta marker
position.
Measurement Visual Carrier frequency, amplitude
items CNR amplitude difference
Of frequency difference between
visual carrier and noise
marker.
Example 1
__________________ © Visual carrier marker
O H
z ;
a Noise . .,'-,‘
W < marker A
Af Color subcarrier,
aural carrier
Channel
spacing To next main channel
Operation: 1. Press (Mwr)>More[F7]>CNR/CSO/CTB[F1]>
Setup[F1]> CNR[F1] to choose CNR
measurement.

2. Press Noise

Marking[F1] and toggle the noise

marker type between Min and AMarker.

3. If Min was

selected, press Return[F7] to return

to the previous menu.

4. If AMarker was selected, press >
Delta[F4]>Delta[F1] and set the delta marker

position.

+See page 95 for details on moving markers.

Press > CNR/CSO/CTB[F7] to return to

the previous menu.
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5. Press CNR[F2] and turn CNR on.
+Any other measurement mode will automatically be
disabled.

xEnsure the aural and color subcarriers are disabled
before CNR is turned on.

6. The display splits into two screens. The top
shows the trace with the visual carrier marker
and the noise marker. The bottom screen shows
the CNR measurements.

Visual carrier Noise
marker marker

305, 000MHz ntar 315 000MHZ top 325 000MHzZ
100kHz AW 100kHz Sweep 35.9ms

CNR measurements

7. Press CNR CH SP[F2] to set the channel space.

Range: 0~3GHz

8. Press Channel Move Down[F4] or Channel Move
Up [F5] to move to the next or previous
channel.

& Ensure the aural and color subcarriers are turned
Note off when making CNR measurements.
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Composite Second Order (CSO)

Description

Composite Second Order measurement
calculates the difference in amplitude between
the carrier signal and the composite second

order beat.

Parameters

CSO CH SP: The channel space.

Measurement
items

Visual Carrier: frequency, amplitude
Channel Space: frequency
CSO: amplitude difference

Example

1

Q.
o9}

0SsO

—M_J
Af

Channel
spacing

>

CSO Beat marker

< Visual carrier marker

I
A

.=

L

Color subcarrier,
aural carrier

To next main channel

Operation:

170

1. Press (Weswe )> More[F7]>CNR/CSO/CTB[F1]>
Setup[F1]> CSO[F2] and choose CSO.

2. Press CSO[F2] and toggle CSO on.
*Any other measurement mode will automatically be

disabled.

3. The display splits into two screens. The top
shows the trace with the visual carrier marker
and the CSO beat marker. The bottom screen
shows the CSO measurements.
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Visual carrier CSO beat
marker marker

Starl 52 260MHz e
3 26kHz 3V 30kHz

CSO measurements

4. Press CSO CH SPC[F3] to set the channel space.
Range: 0~3GHz

5. Press Channel Move Down[F4] or Channel Move
Up [F5] to move to next or previous channel.

Composite Triple Beat (CTB)

Description Composite triple beat measurement calculates
the difference in amplitude between the visual
carrier and the composite triple beat amplitude.

Measurement Visual Carrier: frequency, amplitude
items CTB: amplitude difference from the visual
carrier and the triple beat
Triple Beat: amplitude

17
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Example 1 '
< Visual carrier marker

e :
UJ __________ <\ CTB Beat marker 1%
Channel
ing &
spacing To next main channel
Operation: 1. Press (M )> More[F7]>CNR/CSO/CTB[F1]>

Setup[F1]> CTB[F3]>Return[F7] to choose CTB
measurement and return to the previous menu.

2. Press CTB[F2] and turn CTB on.
*Any other measurement mode will automatically be
disabled.

3. The display splits into two screens. The top
shows the trace with the visual carrier marker.
The bottom screen shows the CTB
measurements.

*This will place a marker (é) on the visual carrier and

record the amplitude.
Visual carrier CTB beat
marker marker

50MHZ Stop 58, 260MHZ
.6.000MHz Sweep 147ms

CTB measurements
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4. Turn off the visual carrier signal from the input

and press the key on the front panel.

5. A second trace will appear to mark the CTB
amplitude.

«This will place a marker (é) on the second trace and
calculate the difference (%—5 .

6. Press CTB CH SP[F2] to set the channel space.
Range: 0~3GHz

7. Press Channel Move Down[F4] or Channel Move
Up [F5] to move to next or previous channel.

& To perform the CTB measurement again, press
Note Setup[F1]>CTB[F3]> Restart/FI].

173
839145 010-62176775 www . hyxyyq..com



GYINSTEK

GSP-9300B User Manual

Harmonic Measurements

Description

The Harmonic function can be used to easily
measure the amplitude of the fundamental
frequency and its harmonic frequencies up to
the 10t harmonic. The function can also
measure the amplitude relative to the
fundamental (dBc) and the total harmonic
distortion (THD).

Measurement
items

Amplitude Amplitude of each harmonic
(dBm).

dBc Amplitude of each harmonic
relative to the fundamental.

THD The square root of the sum of
the amplitude of each
harmonic frequency squared,
divided by the amplitude of
the fundamental frequency.

THD=( V2% + V3. .+ V5°
Vi

Example

Fundamental frequency

.............

st gnd3rdgth L 10th
Harmonic

Operation

174

1. Press >

More[F7]>Harmonic[F2]>Harmonic[F1] and turn
Harmonic on.

*Any other measurement mode will automatically be
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disabled.

2. The display splits into two screens. The top
shows a bar graph with fundamental
measurement (1) and the each of the harmonic
frequencies (2~ 10). The bottom screen shows
the amplitude, dBc and THD results.

Fundamental frequency

Nth order harmonics

p:28:14 20111110

Frag 10.000000 MHz

Harmonic measurement

3. Press Fundamental Freq.[F2] to set the
fundamental frequency.

4. Press Number of Order[F3] to set the number of
harmonic frequencies to measure.
«The number of harmonic frequencies set will affect the
THD measurement.

5. Press RBWJ[F4] and set the RBW to Auto or
Man.
Set the resolution bandwidth and unit for RBW
Man mode.

*The RBW setting will affect the THD measurement.

Mode: Auto, Man
Frequency Range(3dB):  10kHz~1MHz (1-3-10
step)
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N dB Bandwidth

Description N dB bandwidth measurements are used to
measure the frequency bandwidth that covers a
specified amplitude (N dB) from the top of the
peak.

Example

Operation 1. Press (Meswe)> More[F7]>NdB Bandwidth[F3]>
NdB BWJ[F1] and turn N dB BW on.

*Any other measurement mode will automatically be
disabled.

2. The display splits into two screens. The top
shows the trace with markers for NdB and NdB
BW. The bottom screen shows the N dB
measurement results in real time.
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3-23
999 850 MHz - 31 78 dBm
300 kHz - 0.002 dB

N dB BW Measurement

3. Press NdB[F2] to set the NdB amplitude:

Amplitude: 0.1dB ~ 80.0 dB

& The NdB bandwidth measurements are strongly
Note tied to the RBW and VBW.
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P1dB Measurement

Description The P1dB compression point describes the
point at which the gain of an active DUT is 1dB
less than the ideal linear gain (or small signal
gain) relative to the input.

Example &

N L
—~ A

S \V
3| > —bur
5 response
2

o

Ql

5

O]

5

@) S

7

Input power (dBm)

P1dB Connection Connect the DUT to the RF input. Connect the

Setup tracking generator output to the DUT input.
The DC output can be used to power the DUT if
necessary.

GSP

TG DC OUT RF IN
OUTPUT

DUT

Operation 1. Press (Meswe)> More[F7]>P1dB[F4]>P1dB[F1] and
turn P1dB on.
*Any other measurement mode will automatically be
disabled.
«It is not necessary to turn the tracking generator on.

2. The display splits into two screens. After setup
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has been completed (see step 3), the top shows
the trace (yellow) with the ideal response in
red. The P1dB measurement is shown in green.
The bottom screen shows the P1dB
measurement results in real time.

1dB

0404110 2014-03-23

P1dB measurements

The measurement results display a total of 31
points, incremented in 1dB steps from -30dBm
to 0 dBm. In each column the left side shows
the input power and the right side shows the
gain. Gain marked in white is effective gain,
while gain marked in purple is ineffective gain.
The results also list the average gain, the output
power at the P1dB point (Pout, 1dB) and the
input power at the P1dB point.

3. Press P1dB Setup[F2] to set the P1dB settings.
4. Press Center Freq[F1] to set the center frequency:
Frequency: 0 ~3GHz

5. Press Gain Offset[F2] to set the gain offset of the
ideal linear response.

Gain: -99.00dB ~ 99.00 dB
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. To help smooth the actual frequency response

and measure the P1dB compression point more
accurately, press Average[F3] to set the average
number. This is especially useful if Start is set
around -50dB.

Average number: 1~200

. Press Start[F4] to set the “starting” output

power for the P1dB measurement.

Start: -50dB ~ -5dB

. Press Reset[F5] to restart the P1dB measurement

function.

A\X/arning

If the equivalent gain exceeds 30dBm the gridicule
area will be bordered in red to indicate that the
input exceeds specified levels.

01:54:26  2011-10-01

m  Att 40.00 4B

A Note

The maximum power the DC output can provide is
7volts/500mA.
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P1dB Normalization

Description The normalize function is used to compensate
for any loss from a long cable that may cause
inaccurate measurements.

This function relies on the DUT being directly
connected to either the TG or the RF input. The
position of the long cable in relation to the DUT
(input or output) will affect the P1dB
measurement.

If the cable is at the DUT input, then the line
loss of the cable will reduce the output of the
TG before it is input to the DUT. This
configuration (Location = Prev) can affect the
position of the P1dB point if not normalized.

Likewise if the cable is connected to the output
of the DUT, then the gain of the DUT will be
reduced at the RF input by the line loss of the
cable. In this configuration (Location = Post) the
P1dB point will not be affected.

& If a DUT cannot be directly connected to the TG

Note output or the RG input, try to use the shortest
cable possible to reduce the effect of cable loss.
The line loss from short cables cannot be
measured when using the Normalize function.
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Example 1 Location = Prev
W Normalized
N __— DUT response
/ 18
E DUT response with
el /l\ = < line loss before
5 52 DUT input
2 ° £ T
3] S m 33
1 2F sl
5 S o 2
@) S
Input power (dBm 4
putp
Example 2 Location = Post
Normalized
W DUT response
A 1dB ///44/, é@\
= \
&
el . .
| DUT response with line
g loss after DUT output
&l
5
a
=
O] S
7

Input power (dBm)

A Note

This function can only be used when the P1dB is
turned on.

Operation

182

. Connect the cable that is to be connected to the

DUT between the TG and the other cable to the
RF input.

¢ GSP
OUTPUT RF IN

| T
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2. Press > More[F7]>P1dB[F4]
>Normalize[F3].

3. Press Execute Norm[F3]. This will normalize the
cable loss. The cable loss will be shown in the
Execute Norm icon.

03:40.20  2011-10-01

4. Next connect the DUT either directly to the TG
or directly to the RF input. The location of the
DUT will determine whether the cable loss is
normalized before or after the DUT.

Connect the RF cable from the DUT to the
either the TG or RF input, depending on where
the DUT was connected.

Location = Prev Location = Post
TG Gsp TG Gsp
OUTPUT RF IN OUTPUT RF IN
Cable to be Cable to be

compensated compensated

5. Set Location[F2] to either PREV or POST,
depending on the location of the DUT, as
shown above.

6. Turn Norm.[F3] on.

7. The cable loss will now be normalized, based
on where the DUT is located.
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Limit Line Testing

The limit line is used to set the upper or lower amplitude limits
over the entire frequency range. The limit lines can be used to
detect whether the input signal is above, below or within the limit
lines.

The limit lines can be manually or automatically created. The limit
lines can be manually edited by frequency or from the trace data or
marker points.

*Creating a Limit (Point by Point) — from page 184.
*Creating a Limit (from Trace Data) — from page 186.
*Creating a Limit (from marker data) — from page 187.
*Creating a Limit (from marker data) — from page 187
+Delete Limit Line — from page 188

*Pass Fail Testing — from page 189

Creating a Limit (Point by Point)

Description Create a limit manually, point by point. A
maximum of ten points can be used.

Operation 1. Press (_tm )> Edit Select Limit[F1]>Limit Line
[F1] and choose a limit line.

Limit line: 1~5
2. Press Point by Point[F2].
The GSP-9300B is split into two screens. The top

screen shows the trace and limit lines and the
bottom screen shows the limit line table.
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Spectrum display

77T 6 000MHzZ
W 1 0kHz

Limit Line Table

3. Press Point Num[F1] and choose a point number
to edit with the number pad (must start at #1).

4. Press Frequency[F2] and set the frequency of the
point.

5. Press Limit[F3] and set the amplitude level of
the point.

All the points will be displayed in a limit line
table at the bottom of the display.

6. Repeat steps 3-5 for the remaining points
(maximum of 10points. Points can only be
created in numerical order).

7. To delete the selected point, press Delete
Point[F6].

8. Press Return[F7]>Save Limit Line[F5] to save the
currently selected limit line.

& Note that the limit lines are automatically sorted by
Note frequency (low — high).
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Creating a Limit (from Trace Data)

Description

Trace data can be used to create limit lines. A
10 point limit line is created from the trace data
at each grid division as well as the start and
stop frequencies.

Operation

186

. Press > Edit Select Limit[F1]>Limit Line

[F1] and choose a limit line.

Limit line: 1~5

. Press Trace Data to Limit Line[F3].

The GSP-9300B is split into two screens. The top
screen shows the trace and limit lines and the
bottom screen shows the limit line table.

Spectrum display

76.000MHz i 714 000MHz
v p 6178

W 1 0kHz

Limit Line Table

3. Press Limit Offset[F2] and set an offset level.

4. Press Create Limit Line Now[F1].
*A limit line will automatically be created based on the
trace and offset level.
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*A limit line can be created any number of times.

5. Press Return[F7]>Save Limit Line[F5] to save the
currently selected limit line.

Creating a Limit (from marker data)

Description Marker data can be used to create limit lines.
Please see the marker chapter on page 93 for
details on markers. A maximum of 10 points
can be created.

Operation 1. Press (_im )> Edit Select Limit[F1]>Limit Line
[F1] and choose a limit line.

Limit line: 1~5
2. Press Mkr Data to Limit Line[F4].

The GSP-9300B is split into two screens. The top
screen shows the trace and limit lines and the
bottom screen shows the limit line table.

Spectrum display

]

3-09
10.00MHz 8.17 dBm

Limit Line Table

3. Press Point Num[F1] and choose a point number
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A Note

Delete Limit Line

to edit (must start at #1).

4. Press Limit Offset[F3] and set the offset level for

the point.

«This will only create an offset for the currently selected
point, not all the points.

5.

Press Mkr Data to Point[F2].This adds the
currently active marker’s position to the
selected point.

The marker position can be moved at this point
using the scroll wheel. Press the Enter key to set
the position.

Repeat steps 3-6 for any other points (max 10).

Press Return[F7]>Save Limit Line[F5] to save the
currently selected limit line.

Using this function will also change the position of
marker 1 outside of the limit function.

Description Any one of the 5 limit lines can be deleted.
Activate 1. Press (_m )> Edit Select Limit[F1]>Limit
Correction Line[F1] and choose a limit line (limit line 1~5)
to delete.
2. Press Delete Limit Line[F6]. The data from the
chosen limit line will be deleted.
188
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Pass Fail Testing

Description Before pass/fail testing can begin, limit lines for
the upper and lower limits must first be saved.
See page 184, 186 & 187 to save limit lines.

Operation 1. Press (_tm )>Pass/Fail Test.
2. To set a high limit, press High Limit[F1] and
choose one of the limit lines as the upper (high)
limit.

3. To set the low limit, press Low Limit[F2] and
select one of the limit lines as the lower limit.

4. Press Pass Criterion[F3] and select the pass
criteria.

Criteria: All-In, Max-In, Min-In
5. Press Pass/Fail Mode[F5] to select what the GSP-
9300B will do on a fail judgment. Single will
stop testing after a single fail. Continue will
continue testing after each fail judgment.
Pass/Fail Mode: Single, Continue
6. Press Pass/Fail Test[F4] and turn the testing on.
7. The test result appears in the bottom of the

display, and the high and low limit lines (if
enabled) appear on the display.

Pass: , with green grid border.
Fail: , with red grid border.
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Display Icon ”‘*‘;M The alarm icon is shown at the bottom of
U the display whenever testing is turned on.

Example Limit line

03\\46  2014.03-08

Stop 14 000MHz
sweep 6.178

Pass/Fail inidicator

& At least one limit line (high or low) must be turned
Note on to enable testing.

If the high limit or low limit is turned off, the
maximum or minimum* display level is set
automatically as the high or low limit, respectively.

* +30dBm-+Ref level offset or -150dBm+Ref level
offset
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Sequence

The Sequence function records and plays back user-defined macros.
There are up to 5 sequences available in repeat or single running
mode, with up to 20 steps each. Delays and pauses can also be
introduced into a sequence to view measurement results during a
sequence. Sequences can also call other sequences to create longer
sequences.

The sections below can be used to skip to the relevant section:

+Edit Sequence — from page 191

*Run Sequence — from page 195

Editing a Sequence

Edita Sequence 1. Press (Sewere)> Sequence[F1] and choose a
sequence to edit/create.

Sequence: 1~5

2. Press Edit[F2]>Start Edit[F1] to start editing the
selected sequence.

3. The display splits into two screens. The top
screen shows the main screen. The bottom
screen shows the Sequence Editor with the
sequence steps.

«The IEBEIGTSMENN icon appears in the sequence
editor window.
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Start Edit/ Sequence

Main display  Stop Edit icon function
menu
N
Sequence Editor window
Add a Step Up to 20 steps can be added to each sequence.

Each panel operation is recorded as a step.
After each panel operation is performed, press

the key to record the step (in some cases
this is not necessary - check if the operation
appears in the sequence editor window).

In the following example the center frequency
and span are added as steps to a sequence:

1. Press >Center Freq[F1]>20MHz> .
2. Press >Zero Sp,m[p3]>'

3. The two operations are added to the Sequence
Editor.

CenterFreq: 20.000MHz

ZeroSpan

4. Press the key again to return to the

sequence function menu.
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& The arrow keys can be used to move the cursor to
Note the desired step when in the Sequence menu.

Add Delay to The delay function adds a delay between steps.
Sequence

1. Press Delay Time[F2]> and enter the delay time.

Range: 100ms ~ 10s

2. Press to add the delay time to the
sequence editor.
«The delay time will be inserted as a step.

CenterFreq: 20.000MHz
ZeroSpan

Delay Time: 500ms

& The arrow keys can be used to move the cursor to
Note the desired step.

Pause Sequence The Wait to Go function is used to pause a
sequence until Continue[F1] is pressed. This is
useful for observing measurements before
moving onto the next step.

1. Press Wait to Go[F3]>.

«Wait to Go will be inserted as a step.

CenterFreq: 20.000MHz
ZeroSpan

Waittogo

2. When a sequence is running, Press Continue[F1]
to resume running the sequence.
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Insert Sequence Inserts another sequence into the current
sequence.

1. Press Do Sequence[F4]> and select a sequence to
insert into the current sequence.
«The selected sequence will be inserted as a step.

CenterFreq: 20.000MHz
Sequence: 2
ZeroSpan
A The current sequence cannot be inserted into
Note itself.
Delete Step Any step in the Sequence Editor can be deleted.

1. Use the arrow keys on the front @
panel to highlight the step you @%@
wish to delete.

CenterFreq: 20.000MHz

Span: 10.000MHz
ReflLevel: 0.00dBm

2. Press Delete Step[F5] > to delete the step.
+The selected step will be removed from the Sequence

editor.
CenterFreq: 20.000MHz
ReflLevel: 0.00dBm

Stop Editing 1. Press Stop Edit[F6].

2. The E=1E] g Edit icon turns off.
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Save Current After a sequence has been edited (and stopped)
Sequence it can be saved.

1. Press >Save Sequence[F4] > to save the
sequence.

2. The selected sequence will be saved.

Delete Current 1. Press >Delete Sequence [F5] > to delete
Sequence the current sequence.

Running a Sequence

Run Mode 1. Press > Sequence[F1] and choose a
sequence.

2. Press Run Mode[F6] and toggle the run mode:

Single Runs the sequence once only.

Cont. Runs the sequence continually until
Stop Running Sequence[F7] is
pressed (Note: the Stop Running
Sequence[F7] option only appears
when the sequence is running)

Run Sequence 3. Press Run Now[F7] to start running the selected
sequence.

4. Press Stop Running Sequence[F7] to stop the
sequence.
In single mode the sequence will stop running when all
steps have finished.
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Tracking Generator

The tracking generator is a factory installed option that generates a
sweep signal with its sweep time and frequency range matching
the GSP-9300B. The amplitude is maintained at a constant value
over the entire frequency range. This is useful for testing the
frequency response of a DUT.

*Activate the Tracking Generator — from page 196

*Normalize the Tracking Generator — from page 197

Activate Tracking Generator

Operation 1. Press >Tmcking Generator[F1]>TG[F1] and
toggle the tracking generator on.
«*The TG OUTPUT will be activated.

2. Press TG Level[F2] to set the output level of the
tracking generator.

Range: -50 to 0dBm
3. Press TG Lul Offset[F3] to set the offset level of

the tracking generator to compensate for
system gain/loss.

Range: 0dB to 50dB

4. Press TG Lvl Step[F4] to set the step resolution
of the TG level.
Range: Auto, Man; 0.5 to 50dB,

0.5dB step

5. Press Power Sweep[F5] to vary the output
power of the TG to the rate of the sweep. At the
beginning of the sweep, the output power is at
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the set TG Level and increases/decreases
linearly to the set Power Sweep level at the end
of the sweep.

Range: -5dB to +5dB

Normalize the Tracking Generator

Background The normalize function subtracts the trace after
each sweep with a reference trace. The resultant
trace is added to a normalized reference level.

Connection When normalizing the TG output, connect the
TG output directly to the RF input.

After normalization, connect the DUT to the
tracking generator and connect the output of

the DUT to the RF input.
GSP
TG RF
OUTPUT INPUT

Ly DUT |-

Normalization

Operation 1. Press >Tracking Generator[F1]>TG[F1] and
toggle the tracking generator on.

2. Press Normalize[F6] to enter the Normalization
menu.

3. Press Norm. Ref. Level[F2] to set the vertical level
of the normalized reference.

Range: -100dB~100dB
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4. Press Norm. Ref. Position[F3] offsets the
normalized trace on the screen.

Range: 10~0 grid divisions.
(top to bottom)

5. Press Norm.[F4] to toggle the normalized data
on/ off.

Alternatively, press Exe. Norm.[F1] to perform
the normalization again.
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normalization

=)

3

" it

Normalize>

Start BOO.D0OMHz or Stop : Return
REW- 1MHz VBW z = 5

06:00:24  2014.03-15

o 10dBI
el 0.0d8 At 10.0d8

Trace with
normalization
onand the

" reference’
position set to
the 5 grid.

B00.000MHz nter
1hiHz R

06:04:24  201403-15

Att 10.0 68

Response of =
the DUT

3
it
Start BOO.D0OMHz or Stop : Return
REW 1MHz \ z s o =
a

MNormalize>

& The normalized data will be turned off
Note automatically if any X-axis related parameters are
changed or if the TG output level is changed.

The warning message, “Execute Normalization
again!” will appear under these circumstances.
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Power Meter

When using the optional power meter, the GSP can measure and
log the average signal power level of a DUT from -32dBm ~
+20dBm over an operating frequency range of IMHz to 6.2GHz.

*Activating Power Meter Mode — from page 200

*Data Logging Power Meter Measurements — from page 202

Activating Power Meter Mode

Connection Connect the power sensor to the front panel
USB A port on the GSP-9300B.

Connect the RF source to the power meter.

GSP

USB A
PORT

Power Sensor «— RF SOURCE

Opti

Operation 1. Press (ctwa )> Power Meter[F2]>Power Meter[F1]
and toggle the power meter on.

& The power meter option will not be available if the
Note power meter is not connected properly.

2. The display splits into two screens. The top
screen shows the power measurement in dBm
or W. The bottom screen shows a graph of the
measurements.
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Power meter bar
Power meter measurement

0.5N\g  2014-05-2,

T 0
S HE
‘ + 4D "

Data log of power measurements

3. Press Power Unit[F2] and choose the unit:
Unit dBm, W

4. Press Frequency[F3] choose measurement
frequency (use the number pad):

Frequency 1IMHz~6200MHz
Resolution: 1MHz

5. Press Sensor Mode[F4] to choose measurement
speed (and thus accuracy) of the power meter:

Low Noise: 100ms/sample, typical
Fast: 30ms/sample, typical

6. To create pass fail tests, press Pass/Fail Test[F5]
and set the following parameters:

High Limit[FT} -30dBm~20dBm
Low Limit{F2}. -30dBm~20dBm
Pass/Fail Test[F3]: On, Off

Pass Icon: PASS
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Fail Icon:

7. Press More[F6]>Trigger[F1] to toggle between a
free run (internal) trigger and an external
trigger.

Trigger: Free, Ext
Ext trigger input: 33VCMOSs  ™en

GATE IN

8. Press More[F6]> MAX/MIN HOLD|[F2?] to toggle
the MAX/MIN hold measurements on/ off in
the power meter bar.

*The MIN/MAX measurements will be displayed in the

power bar meter in the center of the screen.

MIN HOLD MIN HOLD
measurement measurement

A Note

The return to the normal Spectrum Mode, turn the

power meter off by pressing > Power
Meter[F2]>Power Meter[F1] and toggle the power
meter off.

Data Logging Power Meter Measurements

Description

Operation

202

When in Power Meter mode, the spectrum
analyzer is able to log the power meter
measurements over a user-defined time period
at user-defined intervals.

1. Press to enter the save menu.

2. Press Type[F2] and select Power Meter[F7].
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3. Data Source[F3] will automatically be set to
Power State.

4. Press PMET Record Option[F4] and set the
recording options:

Record Stop[FI]: Sets the recording time for
automatic data logging:
00 :00 :00 (continuous) or
00:00:01 ~23:59: 59
Record Step[F2]: 20msec ~ 999sec

5. Press Save To[F1] and select a destination

source:
Local Internal memory
SD Card: External micro SD card
& The micro SD card option will only be available
Note when a micro SD card is inserted into the front
panel port.

6. After a destination has been selected, recording
options appear.

7. To name the log file, press
Name[F1]. Name the selected file
using the F1~F7 keys, as shown
below or use the numeric keypad
to enter numbers.

OOOO
WOOO

OOOO

Limitations:
*No spaces
*Only 1~9, A~Z, a~z characters allowed
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A Note

N

aa

C

D

)
e ]

Y N
o D
AN

Lowercas

Return e
Return
N
)

/A —
o
A A___N

[ Name>

M

. The filename appears on the bottom of the

screen as it is created.

Filename

Press to confirm setting the filename.

If the file name is not user-defined, a file name will
be automatically created in the following format:

File name: type_data source_file number.file
extension

The file number parameter is incremented each
time the same file type is created.

. To start recording power meter measurements,

press Record NowfF3].

A message “SaveFinish!!” will be displayed at the
bottom of the screen when the recording has
finished.
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Stop Recording To manually stop the recording, press Record
Stop[F2].
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FILE

File Overview

The File function is used for basic file related operations including
navigation, sorting copying and deleting. The GSP-9300B has a
number of different file formats for trace data, limit lines,
amplitude correction, sequences and other panel operations. File
source and destination locations (local, USB or micro SD) can also
be chosen with the file function.

+File Type Overview — from page 207
+File Types — from page 207

*Using the File Explorer — from page 209
*Copy Files — from page 211

*Move Files — from page 212

*Delete Files — from page 212

*Rename Files— from page 213

«Save Files — from page 215

*Recall Files — from page 218

*Quick Save — from page 220
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File Type Overview

Local The GSP-9300B has 16MB of local memory to
save data to.

USB The GSP-9300B can save to an external USB
flash memory drive.

USB Type: 1.1/2.0 (FAT32 and
NTFS formatted)
Micro SD The GSP-9300B can save to a micro SD card.
Format: SDSC, SDHC (FAT32
formatted)
File Types
Overview The file types are listed in order as shown in the
File menu.
State State data contains the state of the each of the
panel operations:
«Frequency «Limit Line
*Span *Sequence
*Amplitude «Trigger
*BW/AVG «Marker
*Sweep *Marker P
«Trace *Peak Search
«Display *Preset
*Measure *System
Trace Trace data contains the trace data in comma

separated values.
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«Center frequency

*Span

*Resolution Bandwidth

#Video Bandwidth

*Reference Level

*Sweep Time

*Point number (trace data points)

Screen

Contains the JPEG file of the display (800X600)

Limit Line

The limit line data contains the following in
comma separated values:

«Point number

+Frequency value of point

*Magnitude of point

*Magnitude unit

Correction

Correction data contains the following
correction (line) data:

*Point number

+Frequency value of point

+Gain offset of point

«Unit

Sequence

The sequence files contain the sequence number
and step operations for that sequence. This data
is not designed to be user editable.

Tracking
Generator

The TG data contains:
«TG level
+TG level offset
*TG level step
*Power sweep state and value
*Normalized reference level
*Normalized reference position
*Normalized state

208
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Power Meter The power meter data contains:
*Date
«Time
«Power in dBm
«Start time/end time
«Step time

Using the File Explorer

Connect External To view files on a USB flash drive or micro SD
Memory card, insert the appropriate device into the front
panel port.

Selecting files 1. Press >Fi1e Explorer.

2. Select memory location:

Local[F1]: Internal memory

USBIF2): Front panel USB
memory.

SD Card]F3]: Micro SD card.

3. The up/down arrow keys or the
scroll wheel can be used to move
up/down the file list.

4. The left/right arrow keys can be =)
used to move to the next/previous @%@
page of files in the file list.

& The USB and micro SD card options will only be
Note available when a flash drive/SD card is inserted
into the front panel ports.
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View Files by Type

The file explorer can be configured to only view
files of a certain type. For details on file types,
please see page 207.

. Press Type[F2] and select a file type to view:

All All file types can be viewed
State View state files only

Trace View trace files only

Screen View screen shots only
Limit Line View limit lines only
Correction View correction data only
Sequence View sequence files only

Power Meter  View power meter files only

After selecting a file type, only those types of
files will be listed by the file explorer.

Sort Files

Files can be sorted in ascending order by either
name or by date. By default, files are sorted by
name.

. Press Sort By[F3] and choose the sorting type:

Name: Sort by alphabetical order
Date Sort by file creation date

Preview Image
Files

210

Image files can be previewed on the screen by
enabling the preview function.

. Press More[F7]>Preview[F2] and toggle preview

on or off.
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Example T
o QuickJpg0
O QuickJpgt ipa 192330  2014/09/09 13:29:20
O QuickJpg2 ipa 207841  2014/09/12 94136 -
Used. 642kB
Available 15358kB
& W hen Preview is turned on, other file types will not
Note be viewable.
Copy Files
Description Files from local memory can be copied to
external memory such as a USB flash drive or
micro SD card and vice versa.
Connect External Insert either a USB flash drive or micro SD card
Memory into the front panel ports.

Selecting files 1. Press >File Explorer.

2. Select a file from local or external memory.
3. Press Copy to[F4].

4. Press Media [F1] and select the destination to
copy to (local, USB, SD card).

5. Press Copy Now [F2].

6. The file is copied to the destination directory.
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A Note

Move Files

The USB and micro SD card options will only be
available when a flash drive/SD card is inserted
into the front panel ports.

Description

Files from local memory can be moved to
external memory such as USB or micro SD card
and vice versa.

Connect External
Memory

Insert either a USB flash drive or micro SD card
into the front panel connectors.

Selecting files

. Press >File Explorer.

. Select a file from local or external memory.

. Press More[F7] > Mouve to[F1] .

. Press Media [F1] and select the destination to

move to (local, USB, SD card).

. Press Move Now [F2].

. The file is moved to the destination.

& Note

The USB and micro SD card options will only be
available when a flash drive/SD card is inserted
into the front panel ports.

Delete Files

Description Any files in local memory or external memory
such as USB or micro SD card can be deleted.

212
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Connect External To delete files on a USB flash drive or micro SD
Memory card, insert the appropriate device into the front
panel port.

Delete File 1. Press >Fi1e Explorer.
2. Select a file from local or external memory.
3. Press Delete[F5].
4. Press Delete Now[F1].
5. By default you will be asked to confirm any

files marked for deletion. Choose No[F1] to
cancel or Yes[F2] to confirm the deletion.

Delete Warning 1. To disable the prompt to confirm the deletion of
a file, press Delete Warning[F2] and select an

option:

Don’t Ask The user won’t be prompted
to confirm when a file is
deleted.

Ask Will prompt for the user to
confirm whether to delete the
file or not.

& The USB and micro SD card options will only be
Note

available when a flash drive/SD card is inserted
into the front panel ports.

Rename Files

Description Any files in local memory or external memory
such as USB or micro SD card can be renamed.
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Connect External To rename files on a USB flash drive or micro
Memory SD card, insert the appropriate device into the
front panel ports.

Rename File 1. Press >File Explorer.

2. Select a file from local or external memory.

3. Press Rename[F6].

4. Rename the selected file using the () (») ()
F1~F7 keys, as shown below or use |(©) () (&)
the numeric keypad to enter OO0
numbers: 0JOIO)
Limitations:

*No spaces

*Only 1~9, A~Z, a~z characters allowed

N

aa

(2
-

Lowercase

Return e
S
!

Cancel renaming the file

[Rename>

A ——

5. The filename appears in the list as it is
renamed.
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Filename

. Press to confirm the renaming of the file.

& Note

Save Files

The USB and micro SD card options will only be
available when a flash drive/SD card is inserted
into the front panel ports.

Description

Any function settings or configurations that
have been applied to the spectrum analyzer can

be saved using the key.

Connect External
Memory

To save files on a USB flash drive or micro SD
card, insert the appropriate device into the front
panel ports.

& Note

To save power meter data (data logging) please see
page 202. Saving power meter data will not be
described in this chapter.

Save File

. Press to enter the Save menu.

. Press Type[F2] and select a file type to save. See

page 207 for details on file types:

State: State data
Trace: Trace data
Screen: Screen shots
Limit Line: Limit line data
Correction: Correction data
Sequence: Sequence files
215
839145 010-62176775

www . hyxyyq..com



GYINSTEK

216

GSP-9300B User Manual

Power meter Power meter data*
*see page 202 for details.

3. Press Data Source[F3] to select a data source for

the file type if possible:

For state data: Local state data (fixed, not
selectable)

For trace data: Tracel~4

For screen shots: Normal: Screen shot is saved
as is
Save Toner: inverts the image
file color to reduce ink when

printing.
For limit line: Limit line 1~5
For correction:  Correction data 1~5
For sequence: ~ Sequence 1~5

For power meter: Power state*
*see page 202 for details.

. For trace data, press Format[F4] to select the

format type to save:

Trace: Save trace data only
Trace+State: Save trace and state data

. Press Save To[F1] and select a destination

source:

Register 1~6: Internal memory registers,
these internal registers are not
part of local memory

Local: Internal memory

USB: External memory

SD Card: External micro SD card

. After a destination has been selected, the file

can be named or saved immediately.
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7. To name the selected file, press
Name[F5]. Name the selected file
using the F1~F7 keys, as shown
below or use the numeric keypad
to enter numbers.:

Limitations:
*No spaces
«*Only 1~9, A~Z, a~z characters allowed

r[ ABCDE )—“{

FGHI)

PQRST

[ Fena )
[KLMNO}
[ o)

[ Name>

Cancel naming the file

8. The filename appears on the bottom of the
screen as it is created.

P 30.000MHz
P 348ms

FILENAME

Filename

9. Press to confirm the naming of the file.

& If the file name is not user-defined, a default
Note naming scheme will be used. See the note below
for details.
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10. To save the selected file type, press Save
Now|[F7].

A message “SaveFinish!l” will be displayed at
the bottom of the screen when the save is

successful.
A If the file name is not user-defined, a file name will
Note be automatically created in the following format for
data files:

File name: Type_data source_XX.file extension

The image file names will be automatically created
in the following format:

File name: Quick]pgX.jpg

The X parameter is incremented each time the
same file type is created.

& The USB and micro SD card options will only be
Note available when a flash drive/SD card is inserted
into the front panel ports.

*The power meter option will only be available if
the power meter option is plugged in. See the
Power Meter section on page 200 for power meter

details.

Recall Files

Description Most files that have previously saved a setting
or state can be recalled using the key.
The exception to this are the data logging
settings, see page 200.
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Connect External To recall files from a USB flash drive or micro
Memory SD card, insert the appropriate device into the
front panel ports.

1. Press to enter the Recall menu.

2. Press Type[F2] and select a file type to recall.
See page 207 for details on file types:

State: State data
Trace: Trace data
Limit Line: Limit line data
Correction: Correction data
Sequence: Sequence files

3. Press Destination[F3] to select the destination for
the file type if possible:

For State data: ~ Local state data (fixed, not
selectable)

For Trace data:  Tracel~4

For Limit Lines: Limit line 1~5

For Correction:  Correction data 1~5

For Sequence: ~ Sequence 1~5

Recall File 1. Press Recall From[F1] and select a source
location:
Register 1~6: Internal memory registers,

these internal registers are not
part of local memory

Local: Internal memory
UsB External USB memory
SD Card: External micro SD card

2. To Recall the selected file type, press Recall
Now|[F4].
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3.

A message “Finish!!” will be displayed at the
bottom of the screen when the recall is
successful.

A Note

Quick Save

The USB and micro SD card options will only be
available when a flash drive/SD card is inserted
into the front panel ports.

Description

The key is a hot key to save files with a
single press.

The type of file that is saved is pre-configured

with the key.

By default, the the key will save screen
shots to the local memory or to an external flash
drive (if inserted).

Supported File
Types

Screen, trace, state, limit line, correction,
sequence, power meter®.

*power meter accessory must first be installed
before it can be saved.

Connect External
Memory

To save files to a USB flash drive or micro SD
card, insert the appropriate device into the front
panel ports.

Quick Save Setup 1.

Press the key and configure the file Type,
Data Source and Format. See page 215 for

details.

Using the Quick 1.
Save key

220

Press at any time to save the selected file
type using the settings above.
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2. A ”Save Finish!l” message will be shown at the
bottom of the screen when the save has been
completed.

& The file name will be automatically created in the
Note following format for data files:

File name: Type_data source_XXfile extension

The image file names will be automatically created
in the following format:

File name: Quick)pg_XX.jpg

The XX parameter is incremented each time the
same file type is created.

& The USB and micro SD card options will only be
Note available when a flash drive/SD card is inserted
into the front panel ports.
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REMOTE CONTROL

This chapter describes basic configuration of
IEEE488.2 based remote control. For a command
list, refer to the programming manual,
downloadable from the GW Instek website,
www.gwinstek.com

Interface Configuration ...........cceueevriiiiiiiieiiiiiiineeiiieeees

Configure to USB Remote Interface ..o
Configure GPIB Interface
Configure the LAN and LXI Interface
Configure the WLAN Interface
Configure RS232C ...
RS232C Remote Control Function Check ......ooviveiveeveieiceeeeeceeeeeeeevene
XTI Browser Interface and Function Check
GPIB/LLAN/USB Control Function Check
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Interface Configuration

Configure to USB Remote Interface

USB PC side Type A, host

configuration connector
GSP side Rear panel Type B, slave
connector
Speed 1.1/2.0 (full speed/high speed)
USB Class USB TMC (USB T&M class)

Panel operation 1. Connect the USB cable to the rear =
panel USB B port.

2. Press >More[F7]>RmtInte1face
Config[F1]>USB Mode and toggle the USB mode

to Device.

& It may take a few moments to switch USB modes.
Note

Configure GPIB Interface
To use GPIB, the optional GPIB port must be installed.

Configure GPIB 3. Ensure the spectrum anlayzer is off before
proceeding.

4. Connect a GPIB cable from a
GPIB controller to the GPIB port
on the spectrum analyzer.

5. Turn the spectrum analyzer on.
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6. Press >More[F7]>RmtInterface
Config[F1]>GPIB Addr[F1] and set the GPIB
address.

GPIB address 0~30

GPIB constraints *Maximum 15 devices altogether, 20m cable length, 2m
between each device
+Unique address assigned to each device
+At least 2/3 of the devices turned On
*No loop or parallel connection

Configure the LAN and LXI Interface

The GSP-9300B is a class C LXI compliant instrument. The LXI
specification allows instrumentation to be configured for remote
control or monitoring over a LAN or WLAN. The GSP-9300B also
supports HiSlip. HiSlip (High-Speed LAN Instrument Protocol) is
an advanced LAN based standard for 488.2 communications.

For details on the LXI specification, compliance classes and HiSLIP,
please see the LXI website @ http:/ /www.Ixistandard.org.

Background The LAN interface is used for remote control
over a network. The spectrum analyzer
supports DHCP connections so the instrument
can be automatically connected to an existing
network. Alternatively, network settings can
also be manually configured.

LAN IP Address Default Gateway
conflguratlon Subnet Mask DNS Server
Settings
DHCP on/off
Connection Connect an Ethernet cable from L
the network to the rear panel LAN B
port.
224
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Settings 1. Press >M0re[F7]>RmtInterface[F1]>
LAN[F2]>LAN Config[F1] to set the LAN
settings:

/P Address[F1]  Sets the IP address.

Subnet MaskfF2] Sets the subnet mask.

Default

Gateway/[F3] Sets the default gateway.

DNS Server[F4] Sets the DNS server address

LAN ConfigfF5] Toggles the LAN
configuration between DHCP
and manual settings.

Hint: Use dotted decimal notation when entering
/P addresses, ie., 172.16.20.8

2. Press Apply[F6] to confirm the LAN
configuration settings.

Display Icon The LXI icon turns green when connected
to a LAN and will flash if the
“Identification” setting is on, see page 232.

Set Password The password on the LXI webpage can be set
from the spectrum analyzer. The password is
shown in the system information.

By default the password is set to: IiWNpwd

1. Press >M0re[F7]>RmtInterface
Config[F1]>LAN[F2]>LXIPassword[F3] to set
the password.

2. Enter the password using the
F1~F7 keys, as shown below, or
use the numeric keypad to enter
numbers:

Limitations:
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*No spaces
«*Only 1~9, A~Z, a~z characters allowed

~

JICneEess

Y A
o D
AN

Lowercas

—
o
A

ABCDE )75
)
)
)

S ———

Return

[Rename>)—<

Return

I —
|II ’
AN

Cancel password

Menu tree to enter the password

3. The password appears on the bottom of the
screen as it is created.

1 OHz
PASSWORD

Password

4. Press to confirm setting the password.

Hi SLIP Port 1. Press >More[F7]>RmtInterface
Config[F1]>LAN[F2] >HiSLIPPort to see the Hi
Slip Port number.
HiSlip port 4880
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Reset LAN It may be necessary to reset the LAN
configuration settings before the LAN can be
used.

1. Press >M0re[F7]>RmtInterface
Config[F1]>LAN Reset[F3] to reset the LAN.

2. It may take a few moments before the LAN is
reset.

& Each time the LAN is reset, the default
Note password is restored.

Default password: IxiWNpwd

Configure the WLAN Interface

The WLAN settings operate using any standard 3G USB modem.
For remote locations, using a 3G modem allows you to access the
GSP-9300B web server or to control the GSP-9300B via remote
control commands.

Background To use the GSP-9300B as a server using a 3G
modem, you must first obtain a fixed IP address
from a network provider. Each provider will
assign different fixed IP addresses.

WLAN IP Address Default Gateway
conﬁguratlon Subnet Mask DNS Server
Settings
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Connection

Connect the 3G USB modem to the front panel
USB A port.

The 3G status icon . will appear when the 3G
USB adapter is connected. When it is first
connected it will be grayed-out to indicate that
it is connected but not activated.

GSP

USB A
PORT

3G USB Adapter

Settings

228

. Insert the 3G USB modem into the front panel

USB A port and wait for the 3G USB . icon to
appear.

. Press >More[F 7]>RmtInterface[F1]>

LAN[F2]>WLAN Config[F2]>Apply[F6] and wait
for the 3G USB modem to establish the WLAN
settings.

“Finish!l”, is shown when the configuration is
complete.

. The network settings will be displayed in the

System menu icons.
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WLAN settings

------

Display Icon The 3G USB icon turns green when a
successful connection has been made.
Set Password The password on the LXI webpage can be set

from the spectrum analyzer. The password is
shown in the system information.

By default the password is set to: IitWNpwd

4. Press >M0re[F7]>RmtInterface
Config[F1]>LAN[F2]>LXIPassword[F3] to set
the password.

5. Enter the password using the
F1~F7 keys, as shown below, or
use the numeric keypad to enter
numbers:

OOOO
OOOO
WOOO

Limitations:
*No spaces
*Only 1~9, A~Z, a~z characters allowed
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N

aa

Lowercas

]
= ]
%
Return [ e }
=
J

Cancel password

ABCDE )—ﬁ
)
)
)

[ ———

[Rename>)—<

Menu tree to enter the password

The password appears on the bottom of the
screen as it is created.

PASSWORD

Password

Press to confirm setting the password.

Hi SLIP Port 8.

Press >M0re[F7]>RmtInterface
Config[F1]>LAN[F2] >HiSLIPPort to see the Hi
Slip Port number.

HiSlip port 4880

Reset LAN

It may be necessary to reset the LAN
configuration settings before the LAN can be
used.

Press >M0re[F7]>RmtInterface
Config[F1]>LAN Reset[F3] to reset the LAN.

10. It may take a few moments before the LAN is

230
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& Each time the LAN is reset, the default
Note password is restored.

Default password: IxiWNpwd

Configure RS232C

Background The RS232C interface is used for remote control
with a PC.
RS232C Baud Rate Stop bit: 1 (fixed)
Conﬁguratlon Parity: none (fixed) Data bit: 8 (fixed)
settings
Connection Connect an RS232C cable from Reze
the PC to the rear panel RS5232

port.

1. Press >More[F7]>RmtInterface
Config[F1]>RS232 BaudRate[F4] to set the baud

rate.

300 600 1200
2400 4800 9600
19200 38400 57600
115200

RS232C Remote Control Function Check

Functionality Invoke a terminal application such as Realterm.
check
To check the COM port No, see the Device
Manager in the PC. For WinXP; Control panel
— System — Hardware tab.

Run this query command via the terminal after
the instrument has been configured for RS5232
remote control (page 231).
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*dn?

This should return the Manufacturer, Model

number, Serial number, and Firmware version

in the following format.
*GWINSTEK,GSP9300B, XXXXXXXX,V3.X.X.X

Manufacturer: GWINSTEK

Model number : GSP9300B

Serial number : XXXXXXXX

Firmware version : V3.X.X.X

A For further details, please see the programming
Note manual, available on the GW Instek web site @
www.gwinstek.com.

LXI| Browser Interface and Function Check

Functionality Enter the IP address of the spectrum analyzer in

check a web browser after the instrument has been
configured and connected to the LAN (page
224) or WLAN (page 227).

http:// XXX XXX XXX XXX

The web browser interface appears:
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Welcome Page

The Welcome Page lists all the LXI and
LAN/WLAN configuration settings as well as
the instrument identification. The instrument
identification can be disabled from this page.

LX)
Identification ON ® OFF

LXI Device Model GSP9300B

Manufacturer GWINSTEK

Serial Number KL730819

Description ‘GWINSTEK-GSP9300B-819

LXI Extended Functions  LXI HiSLIP
LXI Version 1.4 LXI Core 2011
Firmware Revision V3003

DNS hostname

mDNS hostname (GSP9300B-819.local

MAC Address 00:22:24:00:0A:BC

TCP/IP Address 172.1622.238

It AN TCPIP:172 inst0- INSTR

TCPIP:172. hislip0, 4880: INSTR

& Note

EXI  The LXI icon on the GSP-9300B display will
flash when the Identification setting is
turned on.

233
839145 010-62176775 www . hyxyyq..com



GYINSTEK

GSP-9300B User Manual

View & Modify
Configuration

The View & Modify Configuration allows you
to modify the LAN settings from the browser.

Press the Modify Configuration button to modify
any of the configuration files.

A password must be entered to alter the
settings.

Default password: IxiWNpwd
[Note: password is case sensitive.]

e . ctrum anal
Apply | Undo Change | Factory Detauits

® Automatic(DHCP)
TCP/IP Configuration Mode
Manual

IP Address
Subnet Mask
Gateway

DNS Server

DNS hostname

Description NSTEK-GSPI3008-
HiSLIP Port

Password Change Password
(Enter Old Password)

(Enter New Password)

(Confirm New Password)

& Note

If the “Factory Defaults” option is chosen, the
password will be reset back to the default
password

It will also be necessary to manually reset the
spectrum analyzer when a message prompts you
to do so on the web browser.
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SCPI Command The SCPI Command page allows you to enter
SCPI commands directly from the browser for
full remote control. Please see the programming
manual for details. A password must be
entered before remote commands can be used.

Default password: IxiWNpwd

[Note: password is case sensitive.]

SYSTERR?

Get Image The Get Image page allows the browser to
remotely capture a screenshot of the GSP-9300B
display.

& For further details, please see the programming
Note manual, available on the GW Instek web site @
www.gwinstek.com.
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GPIB/LAN/USB Control Function Check

Functionality Please use the National Instruments
check Measurement & Automation Controller
software to confirm GPIB/LAN functionality.

See the National Instrument website,
http:/ /www.ni.com for details.

A For further details, please see the programming
Note manual, available on the GW Instek web site @
www.gwinstek.com.
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FaQ

| connected the signal but it does not appear on screen.

| want to see which optional items are installed.

The performance does not match the specification

| connected the signal but it does not appear on screen.

Run Autoset and let the GSP-9300B find the best display scale for
your target signal. Press the Autoset key, then press Autoset[F1].
For details, see page 63.

| want to see which optional items are installed.

Check the optional items in the system information window. Press
the System key — System Information[F1]. For details, see page 118.

The performance does not match the specification.

Make sure the device is powered On for at least 45 minutes, within
+20°C~+30°C. This is necessary to stabilize the unit to match the
specification.

For more information, contact your local dealer or GWInstek at
www.gwinstek.com / marketing@goodwill.com.

237
839145 010-62176775 www . hyxyyq..com



GUYINSTEK GSP-9300B User Manual

APPEN DIX

Replace the Clock Battery

Background The system clock and wake-up clock keep time
using a button battery.
Battery type: CR2032, 3V, 210mAh
Connection 1. Turn off the GSP-9300B and

remove the battery cover and
battery (if connected).

2. Replace the battery with the same type and
specification.
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Glossary of Acronyms

Acronym Definition

3GPP 3" Generation Partnership Project

ACPR Adjacent Channel Power Ratio

BS Base Station

CF Center Frequency

CH BW Channel Bandwidth

CH SPC Channel Space

CISPR International Special
Committee on Radio Interference

CNR Carrier to Noise Ratio

CsO Composite Second Order

CTB Composite Triple Beat

DANL Displayed Average Noise Level

Def. Default

DL Down Link

DSSS-OFDM Direct Sequence Spread Spectrum- Orthogonal
Frequency Division Multiplexing

EMC Electromagnetic Compatibility

EMI Electromagnetic Interference

EMS Electromagnetic Susceptibility

ERP-CCK Extended Rate Physical layer- Complimentary Code
Keying

ERP-DSSS Extended Rate Physical layer- Direct Sequence
Spread Spectrum

ERP-OFDM Extended Rate Physical layer- Orthogonal Frequency
Division Multiplexing

ERP-PBCC Extended Rate Physical layer- Packet Binary
Convolutional Code

ETSI European Telecommunications Standards Institute

FDD Frequency-Division Duplexing

IF Intermediate Frequency

HiSLIP High Speed LAN Instrument Protocol

LOI Local Oscillator

LPF Low Pass Filter

LXI LAN eXtensions for Instrumentation

OCBW Occupied Channel Bandwidth

PSD Power Spectral Density
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P1dB
RBW
REF
SEM
SINAD
TDD
TG
TOlI
UE
up
VBW

240

One-dB compression point
Resolution Bandwidth
Reference

Spectrum Emission Mask
Signal to Noise and Distortion Ratio
Time-Division Duplexing
Tracking Generator

Third Order Intercept

User Equipment

Up Link

Video Bandwidth
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GSP-9300B Default Settings

The following default settings are the factory configuration settings
for the spectrum analyzer (Function settings/ Test settings).

Frequency
Center Frequency: 1.5GHz Start Frequency: OHz
Stop Frequency: 3GHz CF Step: Auto
Frequency Offset: OHz
Span
Span: 3GHz
Amplitude
Reference level: 0.00dBm Attenuation: Auto
Scale Div: 10 Scale: Off
Y Axis: dBm Scale Type: Log
Reference level offset: Correction: Off
0.00dBm
Input Z: 50Q Input Z calibration: 6.000dB
Preamp: Bypass
Autoset
Amp.Floor: Auto Span: Auto
BW/AVG
RBW: Auto VBW: Auto
VBW/RBW: N/A Average: Off
Average Power: Log Power  EMI Filter: Off
Sweep
Sweep Time: Auto Sweep: Continuous
Gated Sweep Mode: Off Gate Delay: 50ms
Gate Length: 540ms Sweep Control: Norm
Trace
Activated traces: trace 1 Trace Type: Clear and Write
Trace Math: Off Detection: Auto, Normal
Display

Window Setup: Spectrum
LCD Backlight: On

839145

LCD Brightness: Hi
Display Line, -50.0dBm, Off
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Meas

All measurement functions: Off

EMC Pretest

All EMC test functions: Off

Limit Line
Limit lines: Off Pass/Fail Test: Off
Trigger
Free Run Trigger Condition: Video
Trigger Mode: Norm. Trigger Delay: 50ms
File
Type: All Sort by: Name
Quick Save
Type: Screen Data Source:Normal
Save
Type: Screen Data Source:Normal
Recall
Type: State Destination: Local State
Marker
Marker: Off Data Source:Normal
Marker»
N/A
Peak Search
Peak Track: Off Peak Excursion: 3dB
Peak Threshold: -50dBm Peak Table: Off
Mode
Mode: Spectrum
Sequence
Sequence Off
Option Control
Tracking Generator: Off Power Meter: Off
System
Language: region dependent Power On: Preset
Preset Type: Factory Preset ~ Alarm Output: Off
Remote Interface Config
GPIB Address: 3
LAN: DHCP
LXI Password: IxiWNpwd
HiSPIP Port:4880
RS232 BaudRate: 115200
USB Mode: Host
242
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Menu Tree
Amplitude
Amplitude
Ref Level Y Axis>
30d8 | [ dBm dBm
Attenuation
10dB Log cale Type dBmv
Auto Man Loa
Scale/Div :
10 5 2 1 Correction> |— dBuv
RefLvIOffset
Auto Scale 0.000dB Watts
Scale Preamp
On Off Auto  Bypass Volts
Scale Pos. Return
Left Cent. Right 2/3
More || More
1/3 2/3
T\
Select )
- : Point Num Input Z
Conecnoni Correction 1 15 50 75
Correction ; Frequency Input Z Cal
On Correction 2 1.2345 GHz 0.000dB
N : Gain Offset
> Edit> }— Correction 3 10.00 dB
Correction 4
Save
Correction Correction 5
Delete p
Correction Delete Point
Return
Return Return 3/3
243
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244

Y Axis>
dBm
dBm dBm dBmvV
dBmV -dBm \%
dBuv w mvV
Watts | mw uv
Volts ] uw dBm
nw
pwW
dBuv W \%
\% mw mV
mv uw uv
uv nw dBmV
dBm pw dBuv
dBm dBm
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Frequency, Span, Autoset, BW Avg, Sweep
Frequency Span Autoset
Center Freq Span
1.2345GHz 1.2345GHz Autoset
Amp. Floor
LS fred Full Span -80.00dBm
' Auto Man
Span
Stop Freq Zero S
pan 3.000000MHz
1.2345GHz Auto Man
CF Step
1.00000MHz Last Span
t Man
Freq Offset
0.00Hz
BW/Avg Sweep
RBW Sweep Time
1MHz LOG Power 50.00 ms
Auto Man Auto Man
VBW
1MHz Volt Average Sweep Single
Auto Man
VB\J{VS'SOB% Power Average Sweep Cont
Average Gated Sweep
20 Mode
On Off On Off
Average Type> Gate Delay
Log Power 50.0 ms
EMI Filter Gate Length
On Off 540 ms
Sweep Control
Norm. Fast
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Limit Line
Select LmElc':;t Limit Linei J 9 Point Nunl1 L Limit 1
Pas_?éFS:ﬂ — Point by Point> =i Frequeonﬁ)zl Limit 2
Tt tines 0.00 dBm Limit 3
it tines 1 Limit 4
Save Limit Line Limit 5
Delete Iﬂmg Delete Point
Return Return
L High Lim(i)tf>f Limit 1 % Point NurTl\ Create Limit hic?v?/
Low Limit; | | Limit 2 Mkr Daggi:% Lim&?&)fézeé
Pass Criterion
All-In  Max-In Limit 3 Limit Offset
Min-In
OI;ass/Fail Test Limit 4
Zﬁf;fa” “ég_ﬂff Limit 5
OFF
Return Return Return
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Trigger, Sequence

Trigger

) Video Edge
Free Run Video> Pos Neg
Trigger )
P Ext. Edge Video Level
Condition>
Video Pos Neg 10.00dBm
Trigger Mode Trigger Freq
Norm. Sgl. Cont. 1.12345M Hz
Trigger Delay
50.0 ms
Action Now
Return Return
Only for when “Wait to
go” is used in the
sequence
Sequence; Start Edit Ia Sequence 1 Continue
Edit> DelalyO(T)irl;nqg Sequence 2
Wait to Go Sequence 3
Save Sequence Do Sequencei I Sequence 4
Delete Sequence Delete Step Sequence 5
Run Mode ;
Single  Cont. Stop Edit
Stop Running
Run Now Return Sequence
839145 010-62176775
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Trace

|

Select Trace> TR1>

1 Trace Math> Trace 2 Trace 1
Detection>
Clear & Write Normal t— Trl?ezz Trace 2
Auto Man

Max Hold Power Diff
-130.0dBm TR1-TR2 Trace 3

Log Diff
Min Hold -50.00dBm Trace 4

TR1-TR2+Ref

Log Offset

View 0.00dB

TR1 + Offset

Blank OFF

More

12 — Return Return

D Auto

Normal

Peak +

Peak -

Sample

RMS Average
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Display
Display
Window Setup> Spectrum U thivf_mg}
LCD Brightness ! Alternate
Hi  Mid Lo Split Spectrum> Sweep
O_LnCD Backli%hf% — Spectrogram
Display Line
-50.00dBm Topographic =
On Off
Spectrogram
+
Spectrum
Topographic
+
Spectrum
Return Return
T\
Spectrogram Topographic ; :
Marker Marker | |5 XA><>;'§ —) XA;;')S(
Qn Off On Off
Ref.> [i= Ref.> f— YA;;}; YAy);i;
Delta> |— Delta> t—
Restart
Return Return
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Marker
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Select Marker> L
1 T Marker 1 Delta
on off Marker 2 Move Ref
Normal Marker 3 Move Delta
Delta> Marker 4 MoveS;P)girl;
Function> H Marker 5 Mo‘é:ee':g?
All Off Marker 6
More
12 I Return
Marker Trace>
Trace 1 Auto Freq Counter> oy, Ted Counter
Auto Man =
; Resolution
Marker Table Marker Noise
On off Trace 1 on kHz
Auto Man
VSWR
Trace 2 on Off
Trace 3
Trace 4
Return 2/2 Return Return
839145 010-62176775
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Peak Search, Marker »

Peak
Search

peak Search e on Peak Tract):f_kf 9 on Peak Tagl;af
Peak Excursion Peak Sort
Mkr>Center 10.00dB Ereq Amp
Peak Threshold
Next Peak -50.00dBm
On
Next Peak Right
Next Peak Left Peak Table> |~
Min Search
More Return
12 2/2 Return

Mkr>Center

Mkr>Start

Mkr>Stop

Mkr>CF Step

Mkr>RefLvl
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System
System Show Error Power On
Information message Last Preset User Preset
Error message> ] Prev Page Preset Type> Factory Preset
Language> Save User
English Next Page Preset
Date/Time> =M\
Pwr On/preset>
Alarm Output Clear Error
On Off queue
M?_;g - Return Return

Rmt Interface Year Hour
I; Config> | 3} Set Date> 2011 | [} 5
Upgrade Set Time> (= Monltg M|nu1ti
: Wake-Up Clock Day Second
Service> Edit> 5 52

Clock

On Off

Return

212 Return Return Return
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From: System>
Language

English

fiifA s

4T

Pycckuin

HAGE

Return

From: System>Date/
Time>Wake-Up Clock Edit>

Select Clock>
1 Clock1 | Monday
State
on Off Clock 2 Tuesday
Hour Clock dnesd
13 ock 3 Wednesday
Minute Clock 4 Thursday
08
Rept. Single Clock 5 Friday
Select Date>
Monday Clock 6 Saturday
Return Clock 7 Sunday
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From: System>More 1/2>

Rmt Interface Config>

l

GSP-9300B User Manual

GPIB Addr , IP Address
2| B LAN Config> —) 0000
: Subnet Mask
LAN> WLAN Config> = 0.0.0.0
Default
LAN Reset = LXIPassword> Gateway
0.0.0.0
RS232 Hi SLIP Port
_| Baud Rate> DNS Server
115200 4880
USB Mode LAN Config
Host  Device DHCP Manual
Apply
Return Return Return
300 | 19200 | Ly oK IP Address
600 38400 Cancel Subnet Mask
1200 57600 Gateway
2400 115200 DNS Server
4800
9600
More 1/2 Return
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From: System>More 1/2> Rmt
Interface Config>LAN>LXIPassword
ABCDE Al a
FGHIJ B b
KLMNO C c
PQRST D d
UVWXY E e
z Lowercase {—
Return Return Return
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Option
Control

Tracking TG
Generator> Oon off Exe. Norm.
Norm.
Power Meter> |— g%é—c?é’ﬁ‘: Ref. Lovel
) 0.000dB
Norm.
TG Lvl Offset o

0.000dB Ref. Position

TG Lvl Step
0.000dB on NOCf)Tf

Auto Man =

Power Sweep

0.000dB

On Off

Normalize>
Return Return
Power Meter High Limit
On -10 dBm
Power Unit Low Limit
dBm mV -10 dBm
Frequency Pass Fail Test

3 MHz On

Sensor Mode
LowNoise Fast

Pass/Fail

Test> [

More
1/2

Return

Return

839145
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File
File Explorer> Media> J Media>
Local Local 9 Local Local
Typiﬂ Copy Now Move Now UsSB
Sort by
Name Date SD Card
Copy to>
Delete>
Rename>
Move to> Return Return
257
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.sta

tra

Jpg

.cor

258

From: File>Type

GSP-9300B User Manual

From: File>Delete

l

All = Sequence Delete Now No
State pmet Power Meter B%lgﬁeA\glf"Rgg Yes
Trace Delete All
Screen
Limit Line
Correction
More 1/2 {4 Return 2/2 Return
From: File>Rename
l
ABCDE — A a
FGHIJ B b
KLMNO C c
PQRST D d
UVWXY E e
z Lowercase |-
Return Return Return
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Save
(Mode = Power Meter)
See: Save>Save To
Save To> Record Stop Hour
Local K State 00: 00: 00 06
Type> A Record Step Minute
State | b 1s 07
Data Source> A Second
Local State | M Screen 08
PMET
Record Option>
Name>
Record Stop
Record Now Power Meter Return Return
See: File>Rename é—
According to type:
L Power '\é?;g D Local State Normal
Save Toner
259
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From: Save>Save To

l

Register> Register 1
Local Register 2
USB Register 3

SD Card Register 4
Register 5

Register 6

Return Return

260
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(Mode = Spectrum)

> See: Save>Save To

5

Savelz_ (')I'é); \9 State Trace
'%l;iz Trace Trace + State
Data S_lgrL;Lceez | Screen
FOYTfpg\éz -, N Line Line
Name> |—M— Correction
Sequence
Save Now

—> See: File>Rename

)

L

L

)

L

Local State Trace 1 Normal Limit 1| [ Correction 1| | Sequence 1
Trace 2 | | Save Toner Limit 2 | |Correction 2 | |Sequence 2
Trace 3 Limit 3 | |Correction 3 | |Sequence 3
Trace 4 Limit 4 | [Correction 4 | [Sequence 4
Limit5 | |Correction 5 | |Sequence 5
839145 010-62176775
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(Mode = Power Meter)

.sta

262

839145

Recall F[%r(r:]; Register> Register 1
Tg?:,; — Local Register 2
DEzstination> —— usB Register 3
ocal State

Recall Now SD Card Register 4
Register 5
Register 6
Return Return

According to type:

L State | L Local State

010-62176775
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(Mode = Spectrum)
Recall Flr_%rgg J st State L Register> Register 1
Type> .
Tyrzce ra Trace Local Register 2
Destination> .
Trace 1 [ uUsB Register 3
Recall Now imt Line Line SD Card Register 4
m
Correction Register 5
.cor
Sequence Register 6
.seq
Return Return
Local State Trace 1 Limit 1| | Correction 1| | Sequence 1
Trace 2 Limit 2 | |Correction 2 | [Sequence 2
Trace 3 Limit 3 | |Correction 3 | [Sequence 3
Trace 4 Limit 4 | |Correction 4 | [Sequence 4
Limit5 | |Correction 5 | [Sequence 5
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Measure

See: Meas>Demod

Channel Main CHBW
Analysis> ACPR Setup> 2.000000MHz 9 CNR/CSO/CTB>
Main CH
Demod> on ACPO§ HLimit Harmonic>
= 0.00dBm
Main CH
L NdB
OCBW Setup> (= LLimit :
0.00dBm Bandwidth>
; ocBW CH SPC
Phase Jitter> = on Off 2.000000MHz P1dB>
Channel ADJCH
SEM> Move Up Setup> []
Channel Def. Help
Tor> Move Down Oon Off
More Return
1/2 Return Return 212
I /] 7T\ /M
Phase Jitter CHBW Select Adj Ch> .
on off 2.000000MHz I AdjChl
Start Offset CH SPC :
OHz 2.000000MHz on off AdjCh2
Stop Offset OCBW % ADJ CHBW :
OHz 90.0% 2.000000MHz AdjCh3
ADJ CH Offset
2.000000MHz
ADJ CH
H Limit
0.00dBm
ADJ CH
L Limit
0.00dBm
Return Return Return
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From: Measure>Demod

From: Measure>TOlI

l

APPENDIX

From: Measure>More>

NdB Bandwidth

: Earphone Out TOI NdB B
AM Analysis> on off Oon Off Oon Off
. Volume Reference N dB
FM Analysis> 10 Lower  Upper 0.000dB
Digital Gain -
Limit
Sound> Control
0.000dB -30.00dBm
Demod Type Pass/Fail Test
AM FM On
Return Return Return Return
From: Measure>More>CNR/CSO/CTB
Setup> Noise Marking
CNR CNR> Min _ AMarker Restart
CNR
on off CSO
CNR
CH SPC CTB>
6.000 MHz
Channel
Move Down
Channel
Move Up
Return Return Return Return
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From: Measure>Demod>AM

GSP-9300B User Manual

Analysis
AM Analysis IF Bandwidth
on o 300kHzZ Bypass
LPF>
Setup> | Bypass 1.6MHz
Min/Max Reset Time Axis> 781kHz
) Decimation
Depth Axis> 521kHz frequency*
Limit Edit> AF Trigger> 391kHz
Pass/Fail Test Squelch Level
on ~130.0dBm 313kHz
Return Return
Ref. Value Ref. Value Free Run Edge Slope
0.0ns 0.0 % Rising Falling
Ref. Pos Ref. Pos - Trigger Mode
5 5 Trigger Setup> Norm. Sgl. Cont.
Scale/Div Scale/Div Start Time Trigger Level
10.00ms 10 % 0.00 ns 10 %
Auto Scale Stop Time Trigger Delay
on Auto Scale 20.0 ms 0 ms
Action Now
Return Return Return Return

* see page 134 for the selectable LPF filter bandwidths.

266

839145

010-62176775

www . hyxyyq..com



GYINSTEK APPENDIX
From: Measure>Demod>FM
Analysis
FM Analysis IF Bandwidth
on off 300kHz Bypass
LPF>
Setup> Bypass 16kHz
Min/Max Reset Time Axis> 7.8kHz
o ' Decimation
—t Deviation Axis> 5.2kHz frequency*
Limit Edit> AF Trigger> 3.9kHz
Pass/Fail Test 3.1kHz
On
Return Return
Ref. Value Ref. Value Edge Slope
0.0ns 9 30Hz Free Run Rising Falling
Ref. Pos Ref. Pos ; Trigger Mode
5 5 Trigger Setup> Norm. Sgl. Cont.
Scale/Div Scale/Div Start Time Trigger Level
10.00ms 10 Hz 0.00 ns 10 Hz
Auto Scale Stop Time Trigger Delay
on Auto Scale 20.0 ns 0ms
Action Now
Return Return Return Return
* see page 140 for the selectable LPF filter bandwidths.
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From: Measure>Demod>AM Analysis>Limit Edit

)

AM Depth
100.0%

Carr.Offset
200.000kHz

Carr.Power
0.00dBm

Return

From: Measure>Demod>FM Analysis>Limit Edit

)

Freq. Deviation
200.000kHz

Carr.Offset
200.000kHz

Carr.Power
0.00dBm

Return
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From: Measure>SEM
SEM Setup> 3GPP> Meas Type> Meas Type>
3GPP Total pwr Ref PSD Ref
on SEm 802.11b> | | Ref. Channel> | =Y Ref. Channel>
on Def. Help 802.11g> Offset/Limit> Offset/Limit>
802.11n>
802.16>
User Define>
Return Return Return Return
From: Measure>SEM>3GPP> From: Measure>SEM>3GPP>
REF. Channel Offset/Limit
Chan Integ BW Duplexing Mode
3.84 MHz EDD TDD
Chan Span
3.96 MHz FDD Setup>
RBW
10kHz TDD Setup>
Auto Man
Total Pwr Ref
-74.3dBm
Auto Man
Return Return
839145 010-62176775
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From: Measure>SEM>3GPP>
Offset/Limit>FDD Setup

Transmission _ L
BS Mode | BS UE P>=43 None
Max Out Pwr> _ —Pe—
P>=43 39<=P<43 6<=P<=20
Additional Max
Out Pwr> 31<=P<39 P<6
None
Add. Limits
None [} P<3l
Min Offset/Limit | _
Value>
Return
Offset Offset
123 45 ) 123 45 None | ~) Band XIlI
Abs Start
On Off 22 dBm Band I Band XIV
Start Freq Abs Stop
27 MHz -22dBm Band IV
Stop Freq
27MHz Band v
RBW Band X
More 1/2 (= Band XII
Return
Return 2/2 More 1/2 j=
270
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From: Measure>SEM>3GPP>
Offset/Limit>FDD Setup

Transmission
UE Mode | BS ve| None | =) Band XIIl
Band Il Band XIV
Band IV
Add. Limits
None Band V
Min Offset/Limit
Value> Band X
Band XII
Return More 1/2
Offset Offset
1 2 3 45 1 2 3 45
Abs Start
-22 dBm
Start Freq Abs Stop
27 MHz -22dBm
Stop Freq Rel Start
27MHz -35dBc
Rel Stop
RBW -50dBc
More
1/2
Return Return
839145 010-62176775

APPENDIX

2N

www . hyxyyq . com



GYINSTEK

From: Measure>SEM>3GPP>
Offset/Limit>TDD Setup

GSP-9300B User Manual

Chip Rate = 3.84/7.68M

Transmission Offset Offset
BS P>=43
Mode | BS UE 123 45 123 45
Chip Rate
3.84M  1.28M on off Abs Start 39<=P<43
7.68M
Max Out Pwr> Start Freq Abs Stop _
P>=43 2.7MHz -22dBm 81<=P<39
Min Offset/Limit Stop Freq
Value> 2.7MHz P<3l
RBW
3MHz
More
12—
Return Return Return
From: Measure>SEM>3GPP>
Chip Rate = 1.28M Offset/Limit>TDD Setup
_ Transmission Offset Offset
p>=34 UE| e Pl2 2 3 45 123 465
Chip Rate
26<=P<34 3.84M 1.28M On Off
7.68M
Start Freq
p<26 2.7MHz
Min Offset/Limit | Stop Freq Rel Start
Value> 2.7MHz -22dBm
RBW Rel Stop
3MHz -22dBm
More
1/2
Return Return Return
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From: Measure>SEM>

802.11b/g/n/

802.16>Ref. Channel

From:
Measure>SEM>
802.11g>Offset/
Limit

APPENDIX

From:
Measure>SEM>
802.11n>Offset/
Limit

Chan Integ BW Modulation> ERP-OFDM/ CH BW
3.84MHz DSSS-OFDM DSSS-OFDM 20M 40M
Chan Span Min Offset/Limit ERP-DSSS! Min Offset/Limit
3.96MHz Value> ERP-CCK Value>
RBW
10kHz
PSD Ref
-74.3dBm/Hz
Return Return Return
From: From: From: Measure>SEM>
Measure>SEM> Measure>SEM> 802.11n/802.16>0ffset/Limit>
802.16>0ffset/Limit 802.11b>Offset/Limit  Min Offset/Limit
Channelization Offset Offset
10M 20M 1 2 1 2 3 4
Min Offset/Limit Start Freq Start Freq
Value> 2.7MHz 2.7MHz
Stop Freq Stop Freq
2.7MHz 2.7MHz
RBW RBW
3MHz 3MHz
Rel Start Rel Start
-22dBc -22dBc
Rel Stop Rel Stop
-22dBc -22dBc
Return Return Return
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From: Measure>SEM>802.11g>
Offset/Limit>Min Offset/Limit

802.11g modulation=DSSS

Offset Offset

1 2 ) 1 2
On Off
Start Freq
2.7MHz

Stop Freq Rel Start

2.7MHz -22dBc

Rel Start

RBW -22dBc

More | |

1/2

Return Return

From: Measure>SEM>802.11g>
Offset/Limit>Min Offset/Limit

802.11g modulation=OFDM

Offset 9 Offset
1 2 3 4 1 2 3 4
On Off
Start Freq
2.7MHz
Stop Freq Rel Start
2.7TMHz -22dBc
Rel Start
RBW -22dBc
More [ |
1/2
Return Return
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From: Measure>SEM>
User Define>

Meas Type> L Chan Integ BW
Total Pwr Ref Total Pwr Ref 3.84MHz
Chan Span
Ref. Channel> PSD Ref 3.96MHz
RBW
— Offset/Limit> 10kHz
Auto Man
Total Pwr Ref
-74.3dBm
Auto Man
Return Return
Offset Offset
%l2345 912345 ) Absolute
Abs Start ;
On Off 22dBm Relative
Start Freq Abs Stop
2.7MHz -22dBm Abs AND Rel
Stop Freq Rel Start
2.7MHz 222dBc Abs OR Rel
RBW Rel Stop
10kHz -22dBc
Auto Man Couple Man
More | | Fail Mask> | |
1/2 Absolute
Return Return
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From: Measure>More From: Measure>
From: Measure>TOl >Harmonic More>NdB Bandwidth

TOI Harmonic NdB BW

on off on off On off

Reference Fundamgntal NdB

req. 3.000dB
Lower  Upper 1.000000MHz
Limit Number of Order
0.00dBm 5
f RBW
OPnass/Fall T(ce)sf} 10kHz
= Auto Man

Return Return Return

From: Measure>More>P1dB

l

P1dB Center Freq Exec. Norm
On Off % 100.000MHz % 0dB
P1dB [ | Gain Offset Location
Setup > 0.000dB Prev Post
: Average Nomr.
Normalize > = 1 ON OFF
Start
-30.00dB
Reset
Return Return Return
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GSP-9300B Specifications

The specifications apply when the GSP is powered on for 45
minutes* to warm-up to a temperature of 20°C to 30°C, unless

specified otherwise.

* 45 minutes typical, 90 minutes maximum.

Frequency
Frequency
Range 9 kHz to 3 GHz
Resolution 1 Hz
Frequency Reference
Accuracy +(period since last adjustment X aging rate) +
stability over temperature + supply voltage
stability
Aging Rate 1 ppm max. 1 year after last
adjustment
Frequency +0.025 ppm 0to 50 °C
Stability over
Temperature
Supply Voltage ~ +0.02 ppm
Stability
Frequency Readout Accuracy
Start, Stop, +(marker frequency indication X frequency

Center, Marker

reference accuracy + 10% x RBW + frequency
resolution’)

Trace points

Max 601 points, min 6 points

Marker Frequency Counter

Resolution 1 Hz, 10 Hz, 100 Hz, 1 kHz

Accuracy +(marker frequency RBW/Span >=0.02 ;
indication X frequency Mkr level to DNL>30
reference accuracy + dB
counter resolution)

Frequency Span

Range 0 Hz (zero span), 100 Hz
to 3 GHz

Resolution 1 Hz

Accuracy + frequency resolution' ~ RBW: Auto;
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Phase Noise
Offset from Fc =1 GHz; RBW =1
Carrier kHz, VBW =10 Hz;
Average > 40
10 kHz <-88 dBc/Hz Typical
100 kHz <-95 dBc/Hz Typical
1 MHz <-113 dBc/Hz Typical

Resolution Bandwidth (RBW) Filter

Filter Bandwidth

1 Hzto1 MHzin 1-3-10
sequence

-3dB bandwidth

200 Hz, 9 kHz, 120 kHz,
TMHz

-6dB bandwidth

Accuracy

+ 8%, RBW = 1MHz

Nominal?

+ 5%, RBW < TMHz

Nominal

Shape Factor

Video Bandwidth (VBW) Filter

<4.5:1

Nominal ; Normal
Bandwidth ratio: -
60dB:-3dB

Filter Bandwidth

1Hzto1 MHzin 1-3-10
sequence

-3dB bandwidth

[1] Frequency Resolution = Span/(Trace points - 1)
[2] Typical specifications in this datasheet mean that the performance can be
exhibited in 80% of the units with a 95% confidence level over the temperature
range 20 to 30 °C. They are not covered by the product warranty.

[3] Nominal values indicate expected performance. They are not covered by the

product warranty.

Amplitude

Amplitude Range

Measurement

Range

Attenuator

100 kHz to 1 MHz

Displayed Average
Noise Level (DANL)
to 18 dBm

1 MHz to 10 MHz

DANL to 21 dBm

10 MHz to 3 GHz

DANL to 30 dBm

Input Attenuator

Range

Maximum Safe Input Level

0to 50 dB, in 1 dB step

Auto or manual
setup

Average Total <+33dBm Input attenuator
Power >10dB
DC Voltage £50V
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1 dB Gain Compression
Total Power at 1st >0 dBm TypicakFc >50 MHz;
Mixer preamp. off
Total Power at the >-22 dBm TypicakFc >50 MHz;
Preamp preamp. on

Displayed Average Noise Level (

mixer power level (dBm)=input power (dBm)-
attenuation (dB)
DANL)*

Preamp off

0 dB attenuation; RF Input is terminated with a
50Q load. RBW 10 Hz; VBW 10 Hz; span 500 Hz;
reference level = -60dBm,; trace average > 40

9 kHz to 100 kHz

<-93 dBm

100 kHz to 1 <-90 dBm - 3 x (f/100

MHz kHz) dB Nominal
1 MHz to 2.7 <-122 dBm

GHz

2.7 GHz to 3 GHz <-116 dBm

Preamp on 0 dB attenuation; RF Input is terminated with a
50Q load ; RBW 10 Hz; VBW 10Hz; span 500 Hz;
reference level = -60dBm; trace average > 40

100 kHz to 1 <-108 dBm - 3 x (f/100

MHz kHz) dB

1 MHz to 10 MHz <-142 dBm Nominal

10 MHz to 3 GHz <-142 dBm + 3 x (f/1

GHz) dB

[4] DANL spec excludes spurious response.

Level Display Range

Scales Log, Linear
Units dBm, dBmV, dBuV, V, W
Marker Level 0.01dB Log scale
Readout
0.01 % of reference level  Linear scale
Level Display Trace, Topographic, Single / split
Modes Spectrogram Windows
Number of Traces 4
Detector Positive-peak, negative- ~ Can be setup for each
peak, sample, normal, trace separately
RMS (not Video)

Trace Functions

Clear & Write, Max/Min
Hold, View, Blank, Average

279
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Absolute Amplitude Accuracy

Absolute Point

Center=160 MHz ; RBW 10 kHz; VBW 1 kHz;
span 100 kHz; log scale; 1 dB/div; peak
detector; 23°C+1°C; Signal at Reference Level

Preamp off +0.3dB Ref level 0 dBm;
10 dB RF attenuation
Preamp on +0.4 dB Ref level -30 dBm;

Frequency Response

0 dB RF attenuation

Preamp off Attenuation: 10 dB; Reference: 160 MHz; 20 to
30°C

100 kHz to 2.0 +0.5dB

GHz

2GHzto3GHz +0.7dB

Preamp on Attenuation: 0 dB; Reference: 160 MHz; 20 to
30°C

1 MHzto2GHz +0.6dB

2GHzto3GHz +0.8dB

Attenuation Switching Uncertainty

Attenuator setting

0to 50dBin 1 dB step

Uncertainty

RBW Filter Switching Uncertainty

+0.25 dB reference: 160 MHz,
10dB attenuation

1 Hzto1 MHz

Level Measurement Uncertainty

+0.25dB reference : 10 kHz
RBW

Overall Amplitude
Accuracy

280

+1.5dB 20 to 30°C; frequency > 1 MHz;
Signal input 0 to -50 dBm;
Reference level 0to -50 dBm;
Input attenuation 10 dB;
RBW 1 kHz; VBW 1 kHz; after cal;
Preamp Off

+0.5dB Typical
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Spurious Response

Second Harmonic

Preamp off; signal input -30dBm; 0

Intercept dB attenuation
+35dBm  Typical 10 MHz < fc < 775 MHz
+60 dBm  Typical 775 MHz < fc < 1.625 GHz
Third-order Preamp off; signal input -30dBm; 0
Intercept dB attenuation
>1dBm 300 MHz to 3 GHz
Input Related <-60dBc Inputsignal level -30 dBm, Att.
Spurious Mode, Att=0dB; 20-30°C
Residual <-90 dBm  Input terminated; 0 dB attenuation;
Response Preamp off
(inherent)
Sweep
Sweep Time
Range 204 us to 1000 s Span >0 Hz
50 us to 1000 s Span =0 Hz; Min
Resolution = 10 us
Sweep Mode Continuous; Single
Trigger Source Free run; Video; External
Trigger Slope Positive or negative edge

RF Preamplifier

Frequency Range 1 MHzto 3 GHz

Gain 18 dB Nominal
(installed as
standard)
Front Panel Input/Output
RF Input
Connector Type  N-type female
Impedance 50 ohm Nominal
VSWR <1.6:1 300 kHz to 3 GHz; Input
attenuator > 10 dB
281
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Power for Option

Connector Type ~ SMB male
Voltage/Current  DC +7V / 500 mA max With short-circuit
protection
USB Host
Connector Type A plug
Protocol Version 2.0 Supports
Full/High/Low speed
MicroSD Socket
Protocol SD 1.1

Supported Cards

Rear Panel Input/Output

microSD, microSDHC Up to 32GB capacity

Reference Output

Connector Type  BNC female
Output Frequency 10 MHz Nominal
Output 3.3V CMOS
Amplitude
Output 50 ohm
Impedance
Reference Input
Connector Type  BNC female
Input Reference 10 MHz
Frequency

Input Amplitude

-5 dBm to +10 dBm

Frequency Lock

Within + 5 ppm of the

Range input reference frequency
Alarm Output
Connector Type  BNC female Open-collector
Trigger Input/ Gated Sweep Input
Connector Type  BNC female
Input Amplitude 3.3V CMOS
Switch Auto selection by function
LAN TCP/IP Interface
Connector Type  RJ-45
Base 10Base-T; 100Base-Tx; Auto-MDIX
USB Device
Connector Type B plug For remote control only;
supports USB TMC
Protocol Version 2.0 Supports Full/High/Low
speed
2832
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IF Output

Connector Type  SMA female

Impedance 50 ohm Nominal

IF Frequency 886 MHz Nominal

Output level -25 dBm 10 dB attenuation; RF

Earphone Output

input: 0 dBm @ 1 GHz

Connector Type
Video Output

3.5mm stereo jack, wired for mono operation

Connector Type

RS232 Interface

DVI-I (integrated analog and digital) , Single
Link. Compatible with VGA or HDMI standard
through adapter

Connector Type
GPIB Interface (Optional)

D-sub 9-pin female Tx,Rx,RTS,CTS

Connector Type
AC Power Input

IEEE-488 bus connector

Power Source

Battery Pack (Optional)

AC 100V to 240V, 50 / 60 Hz
Auto range selection

Battery pack 6 cells, Li-lon With UN38.3
rechargeable, 352P Certification
Voltage DC11.1V
Capacity 5200 mAh / 56Wh
General

Internal Data 16 MB nominal

storage

Power <82 W

Consumption

Warm-up Time

< 45 minutes

Temperature Range +5 °Cto +45 °C Operating
-20°Cto +70°C Storage
Weight 4.5 kg (9.9 Ib) Inc. all options

(Basic+TG+GPIB+Battery)

Dimensions

210x350x 100 (mm) Approximately

8.3 x 13.8x3.9 (in)
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Tracking Generator® (Optional)

Frequency Range 100 kHz to 3 GHz

Output Power -50 dBm to 0 dBm in 0.5 dB steps

Absolute Accuracy +0.5dB @160 MHz, -10 dBm,
Source attenuation 10 dB,
20 to 30°C

Output Flatness Referenced to 160 MHz, -10 dBm
100 kHz to 2 GHz +1.5dB

2 GHz to 3 GHz +2dB
Output Level +0.8dB Referenced to -10 dBm
Switching
Uncertainty
Harmonics <-30dBc Typical, output level =-10
dBm
Reverse Power +30 dBm max.
Connector type N-type female
Impedance 50 ohm Nominal
Output VSWR <1.6:1 300 kHz to 3 GHz, source

attenuation > 12 dB
[5] The minimum RBW filter is 10kHz when the TG output is ON.
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Declaration of Conformity

We

GOOD WILL INSTRUMENT CO., LTD.

declare that the below mentioned product

Type of Product: Spectrum Analyzer

Model Number: GSP-9300B

is herewith confirmed to comply with the requirements set out in the
Council Directive on the Approximation of the Laws of the Member States
relating to the EMC: 2014/30/EU, LVD: 2014/35/EU, WEEE: 2012/19/EU
and RoHS: 2011/65/EU.

For the evaluation regarding the Electromagnetic Compatibility and Low
Voltage Directive, the following standards were applied:

© EMC

EN 61326-1: . Electrical equipment for measurement, control and
EN 61326-2-1: laboratory use -- EMC requirements (2013)
EN 61326-2-2: Y d

Conducted & Radiated Emission Electrical Fast Transients

EN 55011: 2009+A1: 2010 EN 61000-4-4: 2012

Current Harmonics Surge Immunity

EN 61000-3-2: 2014 EN 61000-4-5: 2014

Voltage Fluctuations Conducted Susceptibility

EN 61000-3-3: 2013 EN 61000-4-6: 2014

Electrostatic Discharge Power Frequency Magnetic Field
EN 61000-4-2: 2009 EN 61000-4-8: 2010

Radiated Immunity Voltage Dip/ Interruption

EN 61000-4-3: 2006+A1: 2008+A2: 2010 | EN 61000-4-11: 2004

Low Voltage Equipment Directive 2014/35/EU

Safety Requirements EN 61010-1: 2010 (Third Edition)
EN 61010-2-030: 2010 (First Edition)

GOOD WILL INSTRUMENT CO., LTD.

No. 7-1, Jhongsing Road, Tucheng Dist., New Taipei City 236, Taiwan

Tel: +886-2-2268-0389 Fax: +866-2-2268-0639

Web: www.gwinstek.com Email: marketing@goodwill.com.tw

GOOD WILL INSTRUMENT (SUZHOU) CO., LTD.

No. 521, Zhujiang Road, Snd, Suzhou Jiangsu 215011, China

Tel: +86-512-6661-7177 Fax: +86-512-6661-7277

Web: www.instek.com.cn Email: marketing@instek.com.cn

GOOD WILL INSTRUMENT EURO B.V.

De Run 5427 A, 5504DG Veldhoven, The Netherlands

Tel: +31(0)40-2557790 Fax: +31(0)40-2541194
Email: sales@gw-instek.eu
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